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Introduction

that an amazing time to get to know the Mac. For years these elegantly
designed computers have been a model of simplicity and virus-

free stability. Now Macs are undergoing stunning changes that make these
machines even harder to resist.

Apple’s seismic embrace of Intel means you, Mr. or Ms. Computer Buyer, can
have your cake and eat it too. (I love a good cliché when you need it.) You
can benefit from what remains the best marriage in personal computing (the
blessed union between Mac hardware and Mac software). But you no longer
have to ditch the Microsoft Windows-based software you currently use out of
habit, business obligations, or because you don’t know any better.

Indeed, this book is partially targeted at Windows vets who are at least think-
ing about defecting to the Mac. It is also squarely aimed at people who are
new to computers — and the Internet — period.

And though this is primarily a book for beginners, I trust people who have
already dabbled with computers in general and Macs in particular will also
find it useful.

About This Book

A word about the For Dummies franchise 'm now proud to be a part of. These
books are built around the idea that all of us feel like dopes whenever we
tackle something new, especially when the subject at hand (technology)
reeks of a jargon-y stench.

[ happen to know you don’t have a dummy bone in your body, and the pub-

lishers at Wiley know it too. Au contraire. (How dumb can you be if you speak
French?) If anything, you've already demonstrated smarts by purchasing this
book. You're ready to plunge into the best computing environment [ know of.

Because you’re so intelligent, you're probably wondering “who is this guy
asking me for 400 pages or so of my time?” Go ahead and read my bio, which
appears just before the Table of Contents.
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What you won’t find there is this: I'm a relative latecomer to the Mac. I grew
up on MS-DOS computing and then migrated like most of the rest of the world
into Windows. I still use Windows machines every day.

But I've since become a devoted Mac convert and [ use my various Apples
every day too. (No snide remarks, please; I find time for other pursuits.)

When writing this book, I vowed to keep the geek-speak to a minimum. I
couldn’t eliminate it entirely and, to be honest, wouldn’t want to. Here’s why:

»* You may come across some of these absurdly complicated terms in
advertisements and on the Web. So it’s helpful to have at least a passing
familiarity with some of them.

v+ Nothing says we can’t poke a little fun now and then at the nerds who
drummed up this stuff.

Conventions Used in This Book

Anyone who has skimmed the pages of this or other For Dummies books
knows they’re not exactly War and Peace. Come to think of it, it’s too bad
Tolstoy got to that name first. Would have made a great title when the defini-
tive account of the Apple-Intel alliance is written.

Macs For Dummies makes generous use of numbered and bulleted lists, and
screen grabs captured, by the way, using a handy little freebie Mac utility
(invaluable to writers of books like this) called Grab. See, you haven’t even
escaped the introduction, and I threw in your first Mac lesson, just like that.

You'll also note several sidebars in the book, containing material that’s not
part of the required syllabus (well, nothing is really required). | hope you’ll
read them anyhow. Some sidebars are technical in nature, and some provide
a little historical perspective.

How This Book Is Organized

The beauty of the For Dummies format is that you can jump around and read
any section you want. You are not obliged to follow a linear structure. Need
to solve a problem? Head straight to the troubleshooting section (Chapter 20)
and do not pass Go. Want to start putting a coffee table photo book together?
Meet me in Chapter 15. You bring the coffee.
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An organizing principle is at work here. This edition of Macs For Dummies is
split into a half-dozen parts. If you're new to computing, you might want to
digest this book from start to finish.

Part I: Freshman Vear at
Drag-and-Drop Tech

In Part I, [ lay out the groundwork for your Mac education: from turning the
machine on to navigating the Mac desktop. You are introduced to ports and
connectors, the dock, freebie programs, and the various Macs models.

Part 1I: Mac Daily Dealings

If Part I was mainly for seminars and lectures, Part Il is where you get to do
lab work. You find out how to process words and print and how to start taming
the Tiger operating system.

Part I1I: Rocketing into Cyberspace

Part Il covers all things Internet. You find out how to get connected, conduct
online research, shop, and send e-mail. I also introduce .Mac, Apple’s fee-based
online club.

Part JU: Getting an iLife

In Part IV you really move into the fun stuff, the programs that may have
driven you to purchase a Mac in the first place: iTunes, iPhoto, iMovie HD,
iDVD, GarageBand, and iWeb.

Part U: The Creepy Geeky Section

Part V is the part of this computer book that you might imagine is most, well,
like a computer book. Don’t worry, you can read the chapters in this section
without being branded a nerd. In any event, it’s chock-full of practical infor-
mation on networking and diagnosing problems.

3
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Part Ul: The Part of Tens

Listmania is a For Dummies trademark. Check out Part VI for ten Mac-flavored
Web sites, ten dashboard widgets, plus ten more nifty things a Mac can do,
from playing chess to telling a joke.

Icons Used in This Book

Sprinkled through the margins of these pages are round little pictures, or icons.
I could have easily mentioned icons in the “Conventions Used in This Book”
section, because icons are For Dummies conventions too, not to mention essen-
tial ingredients in today’s computers. I use four of them throughout this book.

\\3
[ present the tip icon when a shortcut or recommendation might make the
task at hand faster or simpler.
QNING/
R This icon is my way of saying pay heed to this passage and proceed gingerly,

lest you wreak the kind of havoc that can cause real and possibly permanent
damage to your computer and (by extension) your wallet.

Some percentage of For Dummies readers will get so hooked on computing they
will become the geeks of tomorrow. These are the people who will welcome the
presence of these pointy-faced little icons. Others among you would rather
swallow turpentine than read an overly technical passage. You can safely
ignore this material. (Still, won’t you be the least bit curious about what it is
you might be missing?)

A remember icon means a point of emphasis is here. So along with remember-
ing where you put the house keys and your spouse’s birthday, you might
want to retain some of this stuff.

Where to Go from Here

I've made every effort to get things right and present them in a coherent
manner. But if I've erred in any way, confused you, made you mad, whatever,
drop me an e-mail at baigdummies@aol . com. I truly welcome your comments
and suggestions, and I'll do my best to respond to reasonable queries in a
timely fashion. Mac people aren’t shy about voicing their opinions. Oh, and
since all writers have fragile egos, feel free to send nice e-mails my way too.

Above all, I hope you have fun reading the book and, more importantly, a
grand ole time with your Mac. Thanks for buying the book.
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In this part . . .

Even at a party school, you have to enroll in a few
academic classes. In these early chapters, the course-

work provides you with your first glimpse at the tools and
programs that make Macs so appealing. Plus, the home-
work is light.

You've chosen an excellent major.




Chapter 1
Adventuring into the Mac World

In This Chapter

Discovering why your computer is special
Conversing with your computer
Introducing the iLife

Going outside the box

Computing safely

F)rgive me for getting too personal right off the bat, but next to your
spouse or significant other, is there anyone or anything you touch more
often than a computer keyboard? Or gaze at more intensely than a monitor?

If this is your initial dalliance with a Macintosh, you are probably already
smitten. And quite possibly at the start of a lifelong affair.

Despite its good looks, the Mac is much more than a trophy computer. You
can admire the machine for flaunting intelligent design, versatility, and tough-
ness. A Mac can take care of itself. As of this writing, the Mac has avoided the
scourge of viruses that plague PCs based on Microsoft Windows. Apple’s dar-
lings are a lot more stable too, so they crash and burn less often.

Mac-Spectacular Computing

You shouldn’t be alarmed that far fewer people own Macs compared with
PCs. That’s like saying more people drive Chevy’s than Ferraris. By my way
of thinking, strength in numbers is overrated.

Besides, as a new member of the Mac community consider the company
you are about to keep. Mac owners tend to belong to the cool crowd: artists,
designers, performers, and (can’t resist this one) writers.
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For sure, these same people can be smug at times. I've had Mac mavens go
ballistic on me for penning positive reviews that were not flattering enough.
Or for even daring to suggest that Macs aren’t always perfect.

The machines come pretty darn close, though, so if you’re new to the Mac
you're in for a treat. It has been suggested that most Windows users go to
their computers to complete the task at hand and be done with it. The Mac
owner also gets things done, of course. The difference is that machines
branded with the Apple logo tend to be a labor of love. Moreover, now that
Intel is inside newer Macs, Apple’s computer can double as a pretty darn
effective Windows machine.

Oh, and you will always remember the first time.

Checking out shapes and sizes

When people speak of the Mac, they may refer to both the physical machine
or hardware and the operating system software that makes it all tick. One is
worthless without the other. On a Mac, the operating system is called OS X
(pronounced oh-S-ten). The latest version also carries a ferocious moniker,
Tiger (see Chapter 6 for more on the operating system), with Leopard poised
to follow.

Apple Computer has a tremendous advantage over the companies promoting
Windows PCs because it is the single entity responsible for producing not
only the computer itself but also the important software that choreographs
the way the system behaves. Everything is simpatico.

That’s in stark contrast to the way of the PC world. Companies such as Dell
and Hewlett-Packard manufacture hardware. Microsoft produces the Windows
software that fuels the machines. Sure these companies maintain close rela-
tionships. They just don’t share Apple’s blood relationships.

You will find a variety of Macintoshes meant to sit on top of your desk, thus
the term desktop computer. These are discussed in greater detail in Chapter 4.
Just know for now that the main examples of the breed are the iMac, the Mac
Mini, and the Power Mac.

Mac laptops, so named because they rest on your lap and are portable, include
the MacBook and the MacBook Pro. They are sometimes referred to as note-
book computers or just plain notebooks. As with spiral notebooks, they can fit
into a briefcase.
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Seeing what they do best

Like any computer that’s been around since the Middle Ages (or at least the
latter stages of the twentieth century), the Mac is adept at handling mundane
tasks, from crunching numbers to processing words. Where Apples truly
shine, though, is in making your pictures, music, and videos come alive.

You need not run out to purchase a lot of excess software, either (though
there’s plenty of dandy programs to be had). That’s because you can do so
much with the software already on hand.

Matching a Mac to your needs

Haven'’t settled on which Mac to buy? This book provides assistance. Cheap
advice: If you can eyeball the computers in person, by all means do so. Apple
operates more than 100 retail stores in North America, plus outlets in the
United Kingdom and Japan. Trolling through these high-tech candy stores is
a delight. Of course, you can also buy Macs on the Internet or in traditional
“brick and mortar” computer stores.

Just be prepared to part with some loot. Although the gap between the cost
of PCs and Macs is narrowing, you will typically pay more for a Mac versus a
comparable unit on the PC side.

(Uh oh! The Mac diehards are boiling at that remark: I can practically see
their heads exploding as they rant: “There is no such thing as a comparable
Windows machine.”)

Keep in mind that students are often eligible for discounts on computers.
Check with your college or university bookstore. Apple also gives breaks to
faculty, administrators, and K-12 teachers.

Selecting handy pevipherals

As you might imagine, Macs complement the full range of peripherals.
Although much of what you create in bits and bytes, to put it in computer-
speak, stays in that electronic form, at some point you're probably going

to want to print your work. On old-fashioned paper, no less. Fortunately, a
number of excellent printers work with Macs. I provide details in Chapter 8.

9
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You may also choose a scanner, which in some respects is the opposite of a
printer. That’s because you start with an image that’s already in paper form,
and scan, or translate, it into a form your computer can understand and
display.

Some machines combine printing and scanning functions, often with copier
and fax capabilities as well. These are called multifunction or all-in-one
devices.

Hooking Up Is a Snap

Connecting electronics gear is often a frightening experience. For example,
figuring out the cords and cables in a home theater system is a bit like solv-
ing a challenging SAT problem. No wonder so many folks are willing to pay
some brainy technician a small ransom to do the deed for them. Or else
they’re practically begging the nerdy neighbor across the street to lend a
helping hand.

Relax. You won’t need the smarts of a Nobel laureate to hook up a Mac. As
you’ll see in the Chapter 2, even a kid who has barely learned to ride a bike can
do it. Come to think of it, that kid may need this book a lot less than you do.

Communicating with Your Mac

The Mac isn’t at all standoffish like some human objects of affection. It is
friendly and approachable. In this section, I tell you how.

It’s a GU]

Every mainstream computer in operation today employs what’s called a
graphical user interface, or GUI. The Mac’s GUI is arguably the most inviting of
all. It consists of colorful objects or pictures on your screen, plus windows
and menus (Chapter 3). You interact with these (using a computer mouse) to
tell your machine and its various programs how to behave. Sure beats typing
instructions as arcane commands or taking a crash course in programming.

Even though GUI is pronounced “gooey,” there’s nothing remotely yucky
about it.
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With great tools for you

Given its versatility, I've often thought a Mac would make a terrific product to
peddle on one of those late-night infomercials. “It slices, it dices. Why it even
does more than a Ginsu Knife or Popeil Pocket Fisherman!”

Indeed, have you ever paused to consider what a computer is anyhow? Let’s
consider a few of its most primitive (albeit handy) functions. A Mac can

v Tell time

v Display family portraits
v Solve arithmetic

v Play movies

v Let you chat with friends

[ dare say you didn’t surrender a grand or two for a simple clock, photo album,
calculator, DVD player, or telephone. But it’s sure nice having all those capabili-
ties in one place, and as that TV announcer might bark, “that’s not all folks.”

[ can’t possibly rattle off all the nifty things a Mac can do in this one section
(besides, I encourage you to read the rest of the book). But whether you
bought or intend to buy a Mac for work, play, or more likely some combina-
tion of the two, some little birdie tells me the contents of the Mac’s tool chest
will surpass your expectations.

And output, too

I'm quite confident that you will spend many pleasurable hours in front of
your computer. At the end of the day, though, you’re going to want to show
other people how productive and clever you've been. So whether you pro-
duce documents for a legal brief, spiffy newsletters for the PTA, or music CDs
to serve as the soundtrack to your fraternity’s big bash, the Mac will again
make you proud.

Living the iLife

All the latest Macs are loaded with a terrific suite of software programs called
iLife to help you master the digital lifestyle you are about to become accus-
tomed to. (On older systems, you can purchase the upgraded ilLife suite of
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programs.) I dig deeper into the various iLife components throughout Part IV.
Here’s a sneak preview:

v~ iPhoto: The great photographer Ansel Adams would have had a field day
with iPhoto. This software lets you organize and share your best pictures
and place them in calendars and coffee table books.

v iMovie HD: Can an Academy Award be far behind? iMovie is all about
applying cinematic effects to turn your video into a piece of high-
minded art that would make Martin Scorsese proud. (Or maybe the kind
of Hollywood fluff that generates a box-office bonanza.) Who knows,
maybe Apple boss Steve Jobs will find work for you at Disney or Pixar.

v iDVD: Use this program to create DVDs with chapters like the films you
rent at the video store.

v GarageBand: Did somebody mention groupies? GarageBand lets you
make music using “virtual” software instruments. The latest version also
can help you create online radio shows, or podcasts.

v iWeb: The newest member of the iLife troupe is all about helping you
create your own Web site.

Reaching Outside the Box

The modern computing experience extends well beyond the inner workings
of the physical contraption on your desk. Computing is more about what
occurs in the magical kingdom of cyberspace, better known to the public as
the Internet.

Getting online

In Chapter 9, you discover all there is to know about finding your way to
the Internet, and the many paths you can take once you get there. The Mac
comes with the software you need to get started and (depending on your
model) the circuitry required to connect online through fast broadband
methods. Older machines may still dial up the Internet.

Networking with or without wires

Ask a few people to explain what networking is all about and they’ll probably
utter something about trying to meet and cozy up to influential people who
might help them advance their careers or social lives.
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A Mac can help with such things, too, but that’s not the kind of networking I
have in mind. Computer networks are about having two or more machines
communicate with one another to share files, pictures, music and, most
importantly, a connection to various online outposts. Even on a Mac, this net-
working business can get kind of geeky, though Apple does as well as anyone
in helping to simplify the process. You can network by connecting certain
cords and cables. The preferred method is do so without wires. This is all
explained in Chapter 18.

Staying Safe and Trouble-Free

As noted, the Mac has historically been able to avoid the nasty viruses and
other malevolent programs that give Windows owners the heebie-jeebies. In
the nastiest scenarios, those Windows machines (or certain programs) are
shut down, and personal information is surreptitiously lifted.

In this day and age, not even Mac owners should let their guard down. (And
remember, in some instances the Mac can become a Windows machine.)
Chapter 13 offers counsel on avoiding online dangers.

No matter how much care and feeding went into producing these beautiful
computers, when all is said and done we are talking about physical contrap-
tions filled with circuits and silicon. Machines do break, or at the very least
get cranky like your 2-year-old. So drop by Chapter 20 as well, where I outline
common troubleshooting steps you can take to ensure that you and your
computer develop your relationship gracefully. Consider it the high-tech
alternative to couple’s counseling.
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Chapter 2
The Nuts and Bolts of Your Mac

In This Chapter

Turning on the computer and getting set up
Taming the mouse

Keying in on the keyboard

Saving to the hard drive

Mastering memory

Finding common ports and connectors

H ave you taken the plunge and purchased the computer? If so, you've
made a fabulous decision.

I bet you're dying to get started. You may even have gotten going without
reading these initial instructions. Fine with me. No offense taken. The Mac is
intuitive, after all, and the title on this cover notwithstanding, you’re no
dummy. [ know because you had the good sense to buy a Macintosh — and
this book. Besides, what would it say about Apple’s product designers if they
couldn’t make you understand how to turn on the computer?

If you didn’t jump the gun, that’s cool too. That’s why your humble servant,
um, author, is here.

Turning On and Tuning In Your Mac

To borrow a line from a famous musical, “Let’s start at the very beginning, a
very good place to start . ..” In the Do-Re-Mi’s of Macintosh computing, plug-
ging the computer in the wall is a very good place to start. It doesn’t get a
whole lot more complicated from there.
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The on button

Take a second to locate the round on, or power, button (Figure 2-1). Where it
resides depends on the Mac model you purchased, but finding it shouldn’t be
too taxing. I'll even give away the secret on recently issued models. On the
latest iMac, the on button is on the lower-left back panel of the monitor. On
MacBook Pro laptops, the button is to the right of the keyboard.

Go ahead and press it now. Explosive things are about to happen. Not those
kinds of explosives; it’s just that igniting your first session on the Mac makes
you da bomb (translation: college slang for awesome or cool).

To let you know all is peachy (or should I say Apple-y), you hear a musical
chime (see the sidebar) while the Apple logo briefly shows up on the screen
in front of a gray background.

On button

\:' \1) 0l

|

Figure 2-1: @
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button is
where it all
starts.
|

Getting credentials

Powering up a new Mac for the first time may make you feel like you're enter-
ing the United Nations. After the Apple logo disappears, a lengthy interroga-
tion process commences.

You are kindly instructed to pledge allegiance to a particular language. Deutsch
als Standardsprache verwenden and Gebruik Nederlands als hoofdtaal are
among the 15 choices in a drop-down menu. If you don’t know what either of
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these means, you probably ought to make another choice. In any case, choose
your selection by clicking with the mouse (see details later in this chapter) or
pressing Enter or Return on the keyboard.

If you select Use English as the main language (as | did), you're treated to a
short movie welcoming you in several different languages to OS X Tiger, the
Mac’s operating system software. Next, you get to tell your nosy computer
your country or region (United States, Canada, United Kingdom, Australia,
New Zealand, Ireland, and so on). There’s no need to whip out a passport.

At this stage you have the option to hear instructions for setting up your
Mac. To do so, press the Escape key.

If you happen to own another Mac, you can then transfer network settings,
user accounts, documents, applications, files, e-mail, and various preferences
from that other computer to this one. The process involves connecting a
FireWire cable, which you discover more about later in this chapter.

You also are presented with the option to transfer information from another
partition on this Mac. That’s a geeky term we’ll skip for now.

Of course, if this is your maiden voyage on the SS Macintosh, the previous
choices are unimportant. Instead, select the box “Do not transfer my informa-
tion” and click Continue.

As the cross-examination goes on, you get to choose a keyboard layout and
then select any available wireless Internet service to use.

The next step is to enter your Apple ID, assuming you have one. Such creden-
tials let you buy stuff later.

The Fab Four chime?

That musical chord you hear just after pressing
the on button may sound vaguely familiar. For a
long time | thought it was the same chime that
ends the Beatles” A Day In The Life. | was mis-
taken. Former hippies, flower children, baby
boomers, and just about everyone else con-
scious during the 1960s may wish it were so. For
one thing, Macs are sold with iLife software.
Wouldn't it be groovy to make a nexus between
iLife and the Beatle’s Life? Moreover, John,

Paul, George, and Ringo famously recorded on
the Apple record label. (Anyone remember
records?) I've read that's one reason Beatles
fan and Apple cofounder Steve Jobs chose
Eve's forbidden fruit as a name for his upstart
company. Even if the Beatles connection is
bunk, it makes a good story. The sad reality is
that the Beatles” Apple Corps has a history of
suing Apple Computer over trademark issues.
So much for giving peace a chance.

17



1 8 Part I: Freshman Year at Drag-and-Drop Tech

Before completing this drill, you are also asked to reveal your name, address,
phone number, and (again if you have one) e-mail address. You can’t say no,
(though I suppose you can fib).

Distrustful types can click to read Apple’s privacy policy. Best I can tell, no
one will ask for your social security number or driver’s license.

Still, the prying goes on. Apple next wants to know what you do for a living
(“Other” is a safe choice in the drop-down menu) and where you will primar-
ily use the computer. You also get to tell Apple whether to keep you abreast
on company news, software updates, and the latest products and services.
Opting-in is entirely up to you. Just be aware that you have to remove the
check mark in the box to opt-out.

Creating an identity

You're almost ready to begin touring the computer. But not quite. An impor-
tant step remains. You must choose an identity, or user account. This tells the
Mac that you are the Grand Poobah of this particular computer. As this
almighty administrator, you and you alone can subsequently add accounts for
other members of your family or workplace, each with a password that keeps
them from snooping into one another’s computing workspace (Chapter 5).

Type the name of the account holder (for example, Cookie Monster), the short
name (Cookie), the password (chocolatechip or better yet something that’s
harder to guess), and to verify the password (chocolatechip or whatever
again). You are also asked to type a password hint (yummy flavor) as a gentle
reminder should you ever forget your password. Failing to remember things
may not happen to you, but it sure happens to me.

On newer models with a built-in camera you will also be asked at this stage to
choose an account picture. Better not be camera-shy, because this too you
can’t refuse.

Time is on your side

Because it probably already seems like day is turning into night, this is as
appropriate a time as any to, well, select your time zone by clicking near
where you live on the world map that appears. If you're connected to the
Internet, the computer already knows the date and time. If not, you can enter
them now.
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Registering your Mac

When all is said and done, the nice folks at Apple would also like you to regis-
ter the Mac. You can put this off till later or forever. Letting Apple know who
you are gives the company the opportunity to flood you with promotional
e-mail. That too is up to you.

Making acquaintances

The welcome screen lists all the people on the computer with a user account,
each with a personal mug shot or other graphical thumbnail next to their
names. Click the name or picture next to the miniature picture or thumbnail.
You're asked to enter your password (assuming you have one). Type it prop-
erly, and you are transported to the main working area, or desktop.

The desktop I am referring to here is the interface you see on the computer
display, not to be confused with a desktop-type machine.

Shutting down

We began this chapter with a noble discussion of how to turn on the Mac.
(Humor me if you didn’t think the discussion was even remotely noble.) So
even though you barely have your feet wet, 'm going to tell you how to turn
the dang thing off. Don’t you just hate people who not only give away the
ending (it’s the butler) but also tell you to do something and then tell you
why you shouldn’t have done it?

Okay. Ready? Sayonara time.

Using the arrow-shaped cursor, which you control with your mouse, stab the
small & logo found at the upper-left corner of the screen. Click once and a
drop-down menu appears. Move the cursor down until the Shut Down entry
is highlighted. You know a command or entry is highlighted because a blue
strip appears over its name.

Pressing Enter on the keyboard or clicking Shut Down brings up what’s called
a dialog box (see Figure 2-2). I'm no shrink, but it’s obvious based on the
question the computer asks inside this box that it suffers from separation
anxiety. “Are you sure you want to shut down your computer now?”
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|
Figure 2-2:
Are you
sure you
want to shut
down?
|
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Are you sure you want to shut down your
computer now?

If you do nothing, the system will shut down
automatically in 1 minute and 47 seconds.

S

( Cancel ) ( ShutDown )

Do nothing, and the machine will indeed turn itself off in two minutes. If you
want to say so long immediately, click the button labeled Shut Down.

Having second thoughts? Click Cancel.

Giving your Mac a nap

Apart from guilt, why not shut down? The main reason is that you can let the
computer catch a few Zs without turning it off. A sleeping Mac consumes far
less energy than one that’s in a conscious state. Mac’s don’t snore, but you
know they’re alive because of a dim blinking light. As it turns out, your
machine is a light sleeper. You can wake it up right away by pressing any key
on the keyboard. Best of all, whatever you happened to be working on is just
where you left it. You have to begin from scratch when you restart a Mac that
you had completely shut down.

If you're going to leave the Mac on for an extended period of time, make sure
it’s plugged in to a surge protector that can protect the machine from lightning.

You can make a Mac laptop go to sleep immediately by shutting its cover. To
make a desktop machine go to sleep, click the Sleep command on the ®
menu.

Mousing Around the Interface

By now you're catching on to the idea that this computing business requires
a lot more clicking than Dorothy had to do to get back to Kansas. She used
ruby slippers. You get to use a mouse.

A computer mouse is generally less frightening than that other kind of critter.
In keeping with this Wizard of Oz comparison, not even the Cowardly Lion
would be scared of it. And though your high-tech rodent can get finicky at
times, you’re unlikely to set traps to bring about its demise.
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Some mice connect to the computer through cords. Some are wireless. Either
way, they’re called pointing devices because — brace yourself for this
advanced concept — they’re devices that sort of point.

I'll explain. You roll the mouse across a flat surface (typically your desk, per-
haps a specialized mouse pad). As you do so, a cursor, or insertion point, on
the screen miraculously apes the movement of your hand gliding the mouse.
(Note to self: The mixed metaphor police, a.k.a. my editor, must love mention
of a mouse and a monkey in the same breath. Or perhaps not.) If the mouse
loses touch with the surface of your desk, the cursor will no longer move.

When you place the cursor precisely where you want it, you're ready for the
clicking part. Place your index finger on the upper-left portion of the mouse,
press down quickly, and let go. You'll hear a clicking sound, and in some
cases your entire body will tingle with satisfaction. You have indeed mas-
tered the fine art of clicking.

Don’t get too cocky. Now try double-clicking, an action often required to get
something accomplished. You're pretty much repeating the preceding exer-
cise, only now you're clicking twice in rapid succession while keeping the
cursor in the same location. It may take a little practice. But you’ll get it.

Left- and vight-clicking

If you've been using a Windows computer, you're accustomed to working with a
mouse that has two or more buttons. More times than not you click, or double-
click, using the upper-left button. That’s where the remarkably unoriginal name
of left-clicking comes from. Left-clicking usually serves the purpose of selecting
things on the screen. By contrast, the opposite action, right-clicking, brings up a
menu of shortcut commands.

Until recently, the typical Apple mouse had just one button, the functional
equivalent of the left button on a Windows mouse. (Apple’s programmable
Mighty Mouse, included with recent Macs, can behave like a multibutton
mouse.) Having just one button on a Mac is less of a big deal than some think.
That’s because you can effectively right-click, or bring up a shortcut menu,
with a one-button Mac mouse anyway. To accomplish this great feat, press
Control on the keyboard while you click.

Pointing and clicking on a laptop

You can attach a regular mouse to any Mac laptop, but it is not always conve-
nient to use one when you’re on a 747 or working in tight quarters.
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Fortunately, Mac portables have something called a trackpad, a smooth area
just below the keyboard. You glide your finger on the trackpad to choreo-
graph the movement of the cursor. The button just below the trackpad han-
dles clicking chores.

What a drag

The mouse is responsible for at least one other important bit of business:
dragging. Position the cursor on top of the symbol or icon you want to drag.
Then hold down the mouse button and roll the mouse across your desk. As
you do so, the icon moves to a new location on the screen.

Knowing What's Handy about
the Keyboard

As with any computer — or an old-fashioned typewriter for that matter — the
Mac keyboard is laid out QWERTY style, meaning the top row of letters starts
out with Q, W, E, R, T, and Y. But a computer keyboard also contains a bunch
of specialized keys that the inventors of the typewriter wouldn’t have
dreamed of.

Apple sells localized versions of its keyboards for use in different parts of the
world. In North America, the keyboard standard is known as ANSI, in Japan
it’s JIS, and in Europe, ISO.

Finding the major functions

The top row of the Mac keyboard carries a bunch of keys with the letter F fol-
lowed a number. From left to right, you go from F1, F2, F3, all the way out (in
some cases) to F16. These are your loyal function keys, and their particular
marching orders vary among Mac models. Depending on your setup, pressing
certain F keys has no effect at all.

The F9, F10, F11, and F12 may all relate to a Mac feature called Exposé, which
I explain in Chapter 5.

On Mac laptops, the F1 and F2 keys can raise or lower the brightness of your
screen. On other types of Macs, F14 and F15 perform those functions.
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The keys you use every day

Quick quiz? Guess which keys you employ most often? Too easy. The keys
you use every day are the ones representing vowels and letters with low
point values in Scrabble.

Naturally, these aren’t the only keys that work overtime. The space bar,
comma, and period are darn busy. If you're into hyperbole, the exclamation
mark key puts in an honest day’s effort too. Don’t let me shortchange Shift or
Return. And I know you accountants in the crowd spend a lot of time ham-
mering away at all those number keys.

More keys to success

You'll find these other keys extremely useful:

v esc: The great Escape key. The equivalent of clicking Cancel in a dialog box.

po * %) . These lower, raise, or mute the volume of the computer’s
speakers, though in laptops certain function keys perform these duties.

1~ A: No doubt this is James Bond’s favorite key. Press it, and one of two
things is supposed to happen. On most newer Macs, a CD or DVD loaded
inside the guts of the computer spits out of a hidden slot. On other
models, the tray holding the disc slides out.

v Delete, delete: You are not reading double. There are two delete keys on
some Mac keyboards, each with different assignments. Regular delete is
your backspace key. Press it, and it erases the character directly to the
left of the cursor. The second delete key, which sometimes appears as
Del and sometimes as delete accompanied by an x inside a small penta-
gon is the forward delete key. It wipes out the character to right of the
cursor. Confusingly, on some laptops you can purge the letter to the
right of the cursor by pressing fn and delete at the same time.

v Home, End: The jumpiest keys you will come across. Press Home and
you’re instantly vaulted to the top of the document or Web page window
in which you are working. Press End, and the opposite occurs; you
plunge to the bottom.

1 Page Up, Page Down: A mouse alternative for moving up or down one
huge gulp or screenful at a time.

v Option: Pressing Option (labeled Alt Option on some keyboards) at
the same time that you press another specific key generates symbols.
You can’t possibly recall them all, though over time, you’ll learn the key
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combinations for symbols you regularly call upon. For example, press
Option and 2 for ™, Option and V for v, and Option and R for ®. Feel free
to play around with other combinations.

v Control: The Control key and the mouse click make a powerful combina-
tion. Control-clicking yields pop-up contextual menus that only make
sense in the moment. For example, control-clicking a term inside the
Microsoft Word word processing program brings up a menu that lets you
find a synonym for that word, among other options. Because finding a
synonym doesn’t make a lot of sense when you control-click a picture
inside iPhoto (Chapter 15), the action opens up different possibilities,
including editing, rotating, and duplicating an image.

1~ 8: Pressing this cloverleaf key at the same time you press another key-
board character creates keyboard shortcuts, a subject worthy of its own
topic (see the next section).

Taking a shortcut

If you hold the mouse in high regard, you may want to give the little fellow
time off now and then. (Just don’t tell him that you can sometimes move
much faster without him.) That’s the beauty of keyboard shortcuts. When
you simultaneously press 8 and a given key, stuff happens. You just have to
remember which combination of keys to use under which circumstances.

To understand how such shortcuts work, consider the popular act of copying
material from one program and reproducing it in another. You are about to
practice copy-and-paste surgery.

I present two ways to do this. One leaves pretty much everything up to your
mouse. The other, while still using a mouse a little, mainly exploits keyboard
shortcuts.

Using the first option:

1. Use the mouse to highlight, or select, the passage you want to copy.
2. On the menu bar at the top of the screen, choose Edit=>Copy.

3. Move the mouse and click to place your mouse at the point where you
want to paste the text.

4. Choose Edit=>Paste.

The copied material magically appears at its new destination.
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|
Figure 2-3:
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shortcut or
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Here is the keyboard shortcut method:

1. Highlight the text you want to copy.
2. Hold down the & key while you press the C key.
The result is the same as if you clicked Edit and Copy.

3. Move the mouse and click to place the mouse at the point where you
want to paste.

4. Press 38 and the V key.
You just pasted the text.

Many clickable menu items have keyboard equivalents. These shortcuts are
displayed in the various menus to the right of their associated commands, as
shown in Figure 2-3. Notice that some keyboard shortcuts shown in the menu
appear dimmed. That’s because the commands can’t be used at this particular
point.

New Finder Window 38N
New Folder 43N
New Smart Folder 38N
New Burn Folder
Open #0
Close Window ®’W
Get Info |
— Keyboard shortcuts
Find... #®F
Color bel

Storing Stuff on the Hard Drive

You keep lots of things on a computer. Software you’'ve added. Photos, songs,
movies. Your graduate thesis examining Simon Cowell’s grip on young
American divas. What’s more, before you even arrived on the scene, your
friends at Apple left a lot of stuff behind too, mainly the files and programs
that make your Mac special.
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The bottom line: Computers are a lot like houses. The longer you stick
around, the more clutter you accumulate. And despite your best rainy day
intentions, you almost never seem to get rid of the junk.

Besides, you have plenty of treasures worth holding on to, and you need a
place to store them. The great storage closet on your computer is called the
hard drive, and just as with a physical closet, the bigger it is, the better. You
may even choose to eventually add a new closet or second hard drive. (Some
people add a second disk drive when they buy a new computer.) You can
almost always take advantage of the extra storage. Plus, you can use an addi-
tional hard drive to back up, or keep a copy of, your most precious digital
keepsakes. Hard drives can be fragile.

Indeed, this is a point I cannot ram into your heads hard enough: Back up,
back up, back up. I warn you about this again in Chapter 20.

Memory Essentials, or RAM On

Notice my not-so-subtle use of the word ram in the preceding section? That’s
to get you thinking about the other kind of RAM. It stands for Random Access
Memory, or, mercifully, just memory for short. (I can’t help but think that
accessing my own memory is random, which may explain why I can recall
things from the third grade but not yesterday.) Just as you want as capacious
a hard drive as possible, you want to load as much RAM into your system as
you can possibly afford.

Here’s why. The hard drive is the place for your long-term storage require-
ments. RAM is temporary storage, and having lots of RAM on hand helps when
you open several programs at once and work with large documents. You may
be editing videos, listening to music, and crunching numbers, all while paus-
ing your work to defend the planet by deep-sixing evil aliens. Dude, you are
doing some serious high-tech juggling, otherwise known as multitasking.
Multitaskers guzzle up RAM.

Geeks refer to the amount of memory and hard drive space you have in terms
of bits and bytes. The itsy-bitsy bit (short for binary digit) is the tiniest unit of
information handled by a computer. Eight bits make up a byte, and a byte
typically represents a letter, a punctuation mark, or a digit on your screen. I
know. That’s an awful lot to chew, um, byte on.

You'll typically see measurements in kilobytes, or KB (actually 1,024 bytes),
megabytes, or MB (1,048,576 bytes), and gigabytes, or GB (1,073,741,824
bytes). To provide a little perspective, at the time of this writing, the least
expensive iMac model comes with a 160GB hard drive and 512MB of RAM.
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Locating the Common Port
and Connectors

|
Figure 2-4:
Hook me up,
Scotty.
|

Industry standard jacks, holes, and connectors on the back or side of your
Mac (depending on whether you have a desktop or laptop) may look funky.
But you can’t live without (most) of them. They are your bridge to the gaggle
of devices and peripherals that want to have a relationship with your com-
puter (see Figure 2-4).

Modem FireWire 400 Video out port
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Peripherally speaking:
USB versus FireWire

Ralph Kramden presumably never drove a Universal Serial Bus. But you will
take the USB route quite often. That’s because USB (pronounced “you-S-bee”)
connects printers, scanners, digital cameras, webcams, iPods, joysticks,
speakers, keychain disk drives, piano keyboards, and even your mouse and
computer keyboard.

Plugging in a USB device is as simple as, well, plugging it in (though sometimes
you have to load software first). You can often remove USB devices from the
computer without causing harm by merely pulling the cable out of the jack.

Sometimes, however, the Mac prefers that you let it know before pulling out
the cable. To remove an iPod connected by USB, for example, your Mac
wants you to click a tiny little icon in the iTunes software source list, next to
the name you’ve assigned the portable music player. Failure to click the icon
can cause unpleasant consequences. (For complete details on iPods and
iTunes, let me refer you to Chapter 14.)
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USB generally works like a charm. But like most things in life, there are occa-
sional drawbacks. For one, given all the devices that love USB, you may run
out of available ports. In that case, you can buy a USB expansion hub. If you
do so, I recommend a hub that you can plug into an electrical outlet.

Many USB devices don’t require any kind of electrical outlet because they
draw power from the Mac itself. You can recharge an iPod, for example, by
plugging it into a Mac’s USB port. That’s the good news. But some available
USB ports, typically those that reside on the keyboard, are relative weaklings.
They work fine with low-power devices such as your mouse but not with, say,
a power-thirsty digital camera. If you plug a USB device into a port in the key-
board and it doesn’t work, try plugging it into a USB port directly on the back
or side of the computer.

FireWire is the friendly name coined by Apple for a connector that is also
known by the unfortunate descriptor IEEE 1394. (I won’t bore you with an
explanation except to say it’s the reason engineers are engineers and not
marketers.) FireWire is a speedy connector often used with digital cam-
corders. But it also connects iPods and external hard drives.

FireWire comes in two flavors, the older FireWire 400 specification and its
faster cousin, FireWire 800. Only certain Macs can handle the speedier guy.

Two of a kind: The phone jack
and Ethernet

The phone jack on some Macs is identical to the wall outlet where you plug in
a regular phone. You connect a phone line to this jack to take advantage of a
dial-up modem to the Internet (Chapter 9). Now that we’ve entered the
speedy broadband era, dial-up modems are yesterday’s news, which is why
Apple no longer considers them standard issue on newer Macs. That’s unfor-
tunate because you may still encounter situations where dial-up is your only
option. Apple sells optional USB dial-up modems for just that situation.

The end of the cable that plugs into an Ethernet jack looks just like a phone
jack on steroids. In fact, Ethernet and phone cords are easily mistaken.
Ethernet’s main purpose in life is to provide a fast outlet to the Internet or
your office computer network.
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Jacks of all trades

The following connectors are used less often:

v Video output jack: This connects a Mac to an external monitor for, say,
giving classroom presentations.

v+~ External Apple monitor: Apple’s own proprietary jack for connecting
one of its own monitors.

v Lock: Found on laptops, this tiny hole is where you fit in a Kensington
Security lock cable. With one end securely attached to the computer,
you loop a Kensington cable around the leg of a heavy desk or other
immovable object. The hope is that you’ll prevent a thief from walking
off with your notebook. The laptop cable is similar to a bicycle lock and
cable that you wrap around the wheel and a pole to prevent a heist.

1+ Headphones: For playing games or taking in tunes without bothering
your next-door neighbor or cubby mate.

v S-video: A special cable for connecting the computer to a TV, DVD
player, or projector hooks up here. That way, you can watch a DVD in
your Mac on a large screen. You can add an inexpensive S-video adapter
to models that don’t include this connector.

v ExpressCard slot: The slot (for adding memory card readers or TV
tuners) is a relatively new standard that has started to replace the PC
Card slot you find on older Mac notebooks.

Making the right connections on your computer, as in life, can take you a long
way.
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Chapter 3

Getting to the Core of the Apple

In This Chapter

Traveling around the desktop

Introducing the menu bar

Getting to know icons, folders, and windows

Demystifying the dock

Discovering cool software

A Ithough I'm quite positive he never used a personal computer a day in
his life, the wise Chinese philosopher Confucius could have had the Mac
in mind when he said, “If you enjoy what you do, you’ll never work another
day in your life.” People surely enjoy their Macs, even when they are doing
work on the machine. Before you can totally whoop it up, however, it is help-
ful to get down a few more basics. That way you’ll better appreciate why this
particular Apple is so yummy.

Navigating the Mac Desktop

WMBER
“&
&

All roads lead to and depart from the computer’s desktop, a confusing name if
ever there was one. In this context, I do not mean the physical hardware that
might sit on top of, say, a mahogany desktop. I also don’t mean the kind of
desktop you might buy instead of a laptop.

Rather, this is the desktop that takes over the whole of your computer
screen. On a PC, this is known as the Windows desktop. On a Macintosh, it is
the Mac desktop or (as a homage to the machine’s operating system) the
Tiger desktop.

There’s yet another name, Finder, because as Apple’s own marketers put it,
“Everything you need, just a click away.”
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|
Figure 3-1:
The typical
Mac
desktop.

Indeed, the desktop, or Finder, is a launch pad for all that you may do on your
computer. It is the scenic landscape upon which you organize and store things.

Have a peek at Figure 3-1, which shows a typical Mac desktop layout. The
background is blue by default. You can alter that and make other cosmetic
changes (see Chapter 5). The time is displayed near the upper-right corner of
the screen, and there’s a trash can at the bottom right. Look around and
you'll see other funky looking graphical icons on the screen.

Menu bar Desktop Hard drive icon

[
I'@ Finder File Edit View Go Window Help! Z 4) % Fril0:36PM jdnie @

Macintosh HD!

Let me try this comparison. A Major League ballpark always has foul lines,
bases 90 feet apart, and a pitcher’s rubber 60 feet and 6 inches from home
plate. These are standard rules to be followed. But outfield dimensions and

seating capacities vary dramatically. So do dugouts, bullpens, and stadium
architecture.

Certain conventions apply to the Mac desktop too; then you can deviate from
those conventions. So in the end, everyone’s Mac desktop will look different, a
subject treated in Chapter 4. For now, I address some of the main conventions.
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Clicking the Menu Bar

|
Figure 3-2:
Profiling
your Mac
through the
System
Profiler.
|

See the narrow strip extending across the entire top of the desktop screen?
Yes, the one with the little picture of an Apple at the extreme left side, and
words such as File, Edit, and View to its right? This is your menu bar, so-
named because clicking the Apple — or any of the words in the strip —
brings up a menu, or list, of commands. (Sorry, it’s not that kind of menu. You
can’t order cocktails.)

Single-click the Apple, and a menu pops up with some important functions.
Readers of Chapter 2 are already familiar with the Sleep and Shut Down com-
mands. You will also find Software Update, System Preferences, Force Quit,
and other commands I revisit throughout this book. Suffice to say, the Apple
menu is so relevant that it is always available from whichever application
you're working in.

Now click the top item under the [ menu, About This Mac. The window that
appears lets you know the version of the Mac OS X operating system soft-
ware you're running (see Chapter 6), the kind of processor, or main chip, that
the system is operating on, and the amount of memory onboard.

Click More Info in the same window, and the System Profiler appears (Figure
3-2). Among other things, you can find your machine’s serial number, darn
useful information if you are ever captured by the enemy. I trust you already
know your name and rank. (According to the Geneva Conventions, that’s all
you need to reveal to Microsoft.)

Most of the rest of the stuff, frankly, is a lot of technical mumbo-jumbo pre-
sented in list form. However, some information is worth knowing, including a
quick peek at your system power settings.

006 Ed Baig's Computer
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Understanding Icons, Folders,
and Windows

WING/
gg‘

You've already been introduced to icons, the cutesy pictures that miracu-
lously cause things to happen when you double-click them. That you need
not give a moment’s thought to the heavy machinations taking place under
the hood after you click an icon is the beauty of graphical computing.

Try double-clicking the icon labeled Macintosh HD. It stands for hard drive
and appears (by default) near the upper-right corner of the desktop. A
window containing more icons appears. These represent the various software
applications loaded on your hard drive, plus folders stuffed with files and
documents.

Now try this one out for size. Double-click the Users folder. See whether you
can locate your home folder. Giveaway hint: It’s the one with a picture of a
house and your name. Double-click the home folder, and yet another window
jumps to the forefront. It contains subfolders for the documents you have cre-
ated, plus movies, music, and pictures.

You can double-click under Users to see home folders for other people with
user accounts on your system. But the tiny red circles with a white line
through them tell you that the contents of these respective subfolders are
private or restricted. I call the little red circles Back off, Bud symbols. If you
do boldly click a BoB, you will be gently scolded with a note that says “you
do not have sufficient access privileges.”

Windows dressing

The mere mention of windows may make some of you skittish. It might con-
jure up thoughts about a certain vision of computing propagated by that
really rich fellow hanging out in the Seattle outskirts. But I'm not speaking of
Microsoft or Bill Gates. The windows under discussion here start with a low-
ercase “dubya.”

There’s nothing small about these windows’ capabilities. Just as opening win-
dows in your house can let in fresh air, opening and closing Mac windows can
do so too, at least metaphorically.

Of course, the windows on the Mac can do a heck of a lot more than your typ-
ical windows at home, unless you live with Willy Wonka. These windows can
be stretched, dragged to a new locale on the desktop, and laid one on top of
another.
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To help you understand these windows, check out Figure 3-3.

Close — Click the cute red gumdrop button to close the window

Minimize — Click the yellow circle to send the window into hiding

Zoom — Click this green button to make your entire window grow

View — Three buttons to change your perspective to icon, list, or column (left to right)

Action — Click here and a menu of commands pops up

Title bar — Use to drag the window to another place
Search box — Type search terms to find relevant items

Toolbar button — Click to hide
or show the toolbar and sidebar

Applications =
arz=m] = %5~ Q
@ | Name Date Modified i Size i
iDisk
= Acrobat Reader 5.0 Jul 27, 2002, 3:59 AM -
9| Network FAXStf X Aug 27, 2002, 6:24 PM -
= |Macintosh HD OmniGraffle Nov 18, 2002, 1:41 PM =
— OmniQutliner Nov 18, 2002, 3:31 PM -
_ﬁ Untitled Art Directors Toolkit 3 Nov 18, 2002, 3:53 PM —
Installers (from old Mac) Apr 2, 2003, 5:40 PM -
| Desktop AOL Sep 20, 2003, 1:45 AM -~
8 |ecwardbaig Internet Explorer Oct 24, 2003, 5:35 PM -
— | |Windows Media Player Oct 24, 2003, 11:41 PM -
=+ Applications " Ofoto Express Oct 1, 2004, 4:01 PM -
M [oacuments Office 2004 for Mac Test Drive (from old Mac) Dec 6, 2004, 6:47 PM -
U Microsoft AutoUpdate Dec 7, 2004, 9:59 AM -
I g Movies GraphicConverter US Jan 21, 2005, 6:34 PM -
é Music Quicken 2006 Aug 16, 2005, 2:09 PM -
Figure 3_3 e Quicken 2006 (from old Mac) Aug 186, 2005, 2:09 PM -
. " (L|Pictures Work (from old Mac) Aug 20, 2005, 8:22 AM .
Doin illigan Installers Oct 21, 2005, 1:27 AM - -
. g 8 Zinio Oct 21, 2005, 1:29 AM - :
WIndOWS | [untitled folder || 008wt naa. Aes 01 2006 1,23 Al -

Resizer — Drag to make the
window bigger or smaller

Scroll bars — Drag the contents of a window's pane horizontally or vertically

Sidebar — A list of frequently used folders, programs, and other items

Back and forward buttons — Move to the next or previous window

A stunning view

The Mac graciously lets you peek at information from three main perspec-

tives. Open the View menu in the menu bar and choose As icons, As list, or
As columns. Alternatively, click the appropriate button, as shown in Figure
3-4. Let’s zoom in for a close-up of these views.
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|
Figure 3-4:
Anicon
view of the
home folder.
|
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By icon

In the example in Figure 3-4, we explored the home folder window through
what’s known as the icon view because the windows are populated by those
pretty little pictures. You know the Music subfolder by its icon of a musical
note. And you know the Movies subfolder by the small picture of a movie
clapper.

If you are in a playful mood (or have nothing better to do), you can change
the size of the icons by choosing View=>Show View and moving the Icon size
slider from left to right.

By accessing View Options under the View menu, you can alter the position
of an icon label (by clicking the Bottom or Right radio button). You can
change the color of the window background or use one of your own images
as the background. You can also arrange the order of icons by the date they
were modified, the date they were created, size, kind, or label.

By list

Look on the View menu, and note the check mark next to As Icons. Now click the
As List item, and the check mark moves there. The icons shrink dramatically, and



Figure 3-5:
The list
view.
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the subfolders in the home folder appear, well, as a list. Thus, you are living in
List view land, shown in Figure 3-5. A lot more info is displayed in this view,
including the date and time a file was modified, its size, and the type of file (such
as application or folder). And by clicking a column heading, you can sort the list
anyway you see fit, without having to choose Viewr>Arrange By, which is the
method for sorting in Icon view.

Click heading to sort
|

aala edwardbaig [
oz EEm D
y Name Day a
g iDisk MusIC AU LTI Iy AT
{’;i =| Dave_Thompson-Standin_In_The_Ra Jan 12, 2004, 10:35 PM
Network [ iTrip Stations Feb 26, 2004, 4:01 PM
e | Macintosh HD |.* GarageBand Feb 10, 2006, 11:25 AM
f— | iTunes Today, 1:18 PM
= Movies Oct 19, 2005, 6:48 PM
u Desktop "% My Great Movie Dec 11, 2005, 9:16 PM
[% My Great Movie 1 Dec 11, 2005, 9:16 PM
3 Pictures Dec 29, 2005, 11:20 AM
:/A: Applications [ iphoto Library Jan 20, 2006, 3:50 AM
o |.# Photo Booth Mar 21, 2006, 12:02 AM
‘ L‘I Documents »_ Send Registration Jan 20, 2006, 2:04 AM
[ iPhoto Libraryl Jan 20, 2006, 3:46 AM
g Movies Sites Mar 11, 2006, 5:13 PM
s = index.html May 16, 2003, 7:09 PM
é Music [ images Mar 11, 2006, 5:13 PM
_71 Pictures ¥ apache_pb.gif May 16, 2003, 7:09 PM
L # macosxlogo.gif May 16, 2003, 7:09 PM
J"i gilligan ; @ web_share.gif May 16, 2003, 7:09 PM
Al
7

Drag to change the window's size

Suppose you’re looking for a file in your Documents folder. You can’t remem-
ber the name of the file, but you can remember the month and day you
worked on it. Click the Date Modified heading, and subfolders and files are
now listed chronically, oldest or newest first, depending on the direction of
the tiny triangle next to the heading. Click the Date Modified heading again to
change the order from most recent to oldest or vice versa.

If size matters (and doesn’t it always?), click the Size heading to display the
list from the biggest file size to the smallest or smallest to biggest. Again,
clicking the little triangle changes the order.

If you would rather organize the list by type of file (such as text or folder),
click the Kind column heading to clump together like-minded entries.

While in list view, you may notice right-pointing triangles next to some of the
names. This tells you that a particular listing contains subfolders or files. To
see what they are, click the triangle. The little symbol points in a downward
direction, and any subfolders and files associated with the original folder are
now revealed, in some cases with a little triangle of their own.
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Sometimes you can’t see all the headings because the window isn’t large
enough. You have a few options. Drag a column heading to the right or left to
reorder the columns so the one you want to see appears. You can drag the
slider bar at the bottom of the screen to view headings without rearranging
the order. Or grab the handle at the bottom-right corner of the window to
increase the size of the entire window.

By columns

Next, choose Viewr>As Columns. Again, the check mark moves, altering your
perspective. Several vertical panes appear inside one large window. These
smaller windows within windows show a progression. At the far left is a pane
called the sidebar, a regular hangout for your network, hard disk, home
folder, applications, documents, movies, and more. The sidebar appears in
the same place in every Finder window.

Now suppose that the home folder is highlighted in the sidebar. The pane to

its immediate right displays its contents. Highlight an item in that pane, and

the folder to its immediate right reveals its contents. Each time you highlight
an entry in a particular pane, a new pane appears to its right.

Again, you can resize a column pane by dragging the handle at the bottom of
the pane, as shown in Figure 3-6. To resize all the columns simultaneously,
press the Option key while dragging. You can expand the entire window by
dragging its handle at the bottom right.
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What's Up, Dock?

Your eyes can’t help but be drawn to the colorful bar at the bottom of the
screen (see Figure 3-7). This is your dock, and it may comfort those familiar
with Microsoft’s way of designing a computer interface to think of the dock as
a rough cross between the Windows taskbar and the Start menu. In my
humble opinion, it’s more attractive than the Windows taskbar. More fun too.

@ Finder File Edit View Go Window Help % % 4) Sun4:27PM Apple Computer &)
—
= |
-
EVISCITIOSTE! 1]
EW
I
Figure 3-7:
Docking
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To remove anicon, drag it off the dock
A triangle indicates a program is open

Mouse over anicon and its name appears

Try single-clicking an icon in the dock. The little picture bobs up and down
like a school kid desperate to get the teacher’s attention so he can safely
make it to the bathroom.
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What you'll find on the dock

The dock is divided by a thin black line into two parts. To the left of the line
are programs. To the right are any open files and folders, plus the trash can.
Keep in mind that the mere act of single-clicking a dock icon launches a pro-
gram or other activity. In most other places on a Mac, you have to double-
click an icon to make it get off its derriere.

If a tiny up-pointing triangle appears below a dock icon, that means the pro-
gram is open. When you mouse over a dock icon, the title of the appropriate
application appears.

On newer Macs, the following icons appear by default on the left side of the
dock:

v~ Finder: With a goofy face on top of a square, the Finder icon looks like it
belongs in a SpongeBob SquarePants cartoon. Single-clicking here brings
up the main Finder window.

v Dashboard: The round gauge is the front end for clever little applica-
tions called widgets (see Chapters 6 and 21 for more information).

v~ Safari: The Mac’s fine Web browser (Chapter 9).
1 Mail: Yes, Apple has a built-in e-mail program (Chapter 10).

v~ iChat: Part instant messenger, part audio and video chat program
(Chapter 11).

v Address book: The place for phone numbers and e-mail addresses
(more later in the chapter).

v iTunes: Apple’s renowned musical jukebox (Chapter 14).

v+ iPhoto: The shoebox for storing and touching up digital images
(Chapter 15).

v+ iMovie HD: The place to edit videos (Chapter 16).

v iCal: A built-in calendar (more later in this chapter).

v QuickTime Player: Multimedia audio/video player (later in this chapter).
v~ System Preferences: Having it your way (Chapter 5).

v GarageBand: This is where you can launch your musical career
(Chapter 17).

v iWeb: Lets you creating personal Web sites, blogs, and podcasts
(Chapter 12).

v~ iDVD: Burn movies onto a disk (Chapter 16).
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And these appear on the right bank:

v Apple — Mac OS X: Clicking here launches Safari to take you to the OS X
portion of Apple’s Web site.

v Trash: Hey, even computer garbage has to go somewhere (Chapter 7).

Loading up the dock

Adding favorite items to the dock is as simple as dragging and dropping them
there. Of course, the more icons that get dropped in the dock, the more con-
gested the joint gets. Even icons deserve breathing room. To remove items, just
drag them outside the dock. The icon disappears behind a little white cloud.

Here’s another neat stunt:

1. Open the Apple menu.
2. Choose Dock=Turn Magnification On.

Now as your cursor runs over the icons, the little pictures blow up like
bubble gum.

If you're into resizing dock icons, choose Dock>Dock Preferences. Make sure
the Magnification box is selected and drag the Magnification slider from left
(Min) to right (Max) depending upon your fancy. A separate slider lets you
alter the dock size.

Docking the dock

The very first time you notice the dock, it appears at the bottom of your
screen. Apple doesn’t make you keep it there. The dock can move to the left or
right flank of the screen, depending, | suppose, on your political persuasion.

Again, choose the Dock command from the % menu. Choose either Position
on Left or Position on Right. Pardon the pun, but your dock is now dockside.

If you find that the dock is getting in the way no matter where you put it, you
can make it disappear altogether, at least until you need it again. Choose ®>
Docke>Turn Hiding On.

When Hiding is On, drag the cursor to the bottom (or sides) of the screen
where the dock would have otherwise been visible. It magically glides into
view. The dock retreats to its cave when you glide the cursor away. If you find
you miss the dock after all, repeat the earlier steps, but now choose Turn
Hiding Off.
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A minimizing effect

The dock isn’t the only thing you’d like to nudge out of the way from time to
time. Sometimes entire windows take up too much screen real estate or cover
up other windows you want to see. You can close the objectionable window
altogether, but that is sometimes a Draconian maneuver, especially if you
intend to work in the window again a moment or so later.

You can minimize the window instead. Move the mouse to the upper-left
corner of your open window and find the tiny yellow droplet flanked by tiny
red and green droplets. (That is, they are red, yellow, and green by default.)
I'd show you a picture, but this book is in black-and-white. I'd say leave it to
your imagination, but something tells me you're already familiar with this
red, yellow, and green idea. In any case, if you single-click the yellow circle in
the upper-left corner of a window, the entire thing shrivels up and lands
safely on the right side of the dock (assuming you’ve stuck with Minimize
using Genie Effect inside Dock preferences).

To restore the window to its full and (presumably) upright position, single-

click its newly created dock icon.
&“\NG!
S Be careful not to click the tiny red circle instead. That closes the window
instead of minimizing it.

Clicking the green circle maximizes the window to its full potential.

If one of the circles appears with no color, it means that particular function is
currently unavailable.

Ouitting time

It’s 5 p.m. (or in my world, hours later), so it’s quitting time. Here’s how to
punch out of a specific application. Just to the right of the ® menu, you see
the name of the program you’re currently working in. Suppose it’s Safari.
Single-click the Safari name and choose Quit Safari from the drop-down menu.
Or if you had been working in, say, Word, you’d choose Quit Word from the
drop-down menu.

Here’s a quickie keyboard alternative: Press 38+Q and choose the program
you're in from the drop-down menu.
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A Gaggle of Freebie Programs

A major fringe benefit of Mac ownership is all the nifty software you get
gratis. Many of these freebie programs, notably those that are part of iLife,
are such a big deal that they deserve entire chapters onto themselves.

In this section, I discuss programs of smaller stature. I'm not demeaning
them; in fact, a number of these bundled programs are quite handy to have
around.

You'll find some of the programs I am about to mention in the dock. But
another good place to look is the Applications folder, which is accessible in
three ways:

v Click Applications in the sidebar.

v Choose Go=>Applications.
v Press the keyboard shortcut Shift+38+A.

Staying organized

Not all of us have the luxury of hiring a secretary or assistant to keep our life
in some semblance of order or to just provide a jolt of caffeine when we need
it. I sure don’t (sigh).

Regrettably, a Mac still can’t make coffee. (Although [ wouldn’t bet against
the ultrasecretive programmers inside Apple figuring out how to brew a cup
inside the machine.) But it is reassuring that the computer can simplify other
administrative chores. Check out the applications in this section:

Address Book

You just met an attractive stranger on the way to the Apple store? The
Address Book, accessed through the Applications folder or by clicking its
dock icon, is a handy repository for addresses, phone numbers, and e-mail
address. You can also add a picture and note about the person (“awfully cute;
owns a Mac”).

After opening the program, here’s how to add an address book entry:

1. Under the column marked Name, click the + sign (shown if Figure 3-8).

You can alternatively open the Address Book and choose Filem> New
Card.
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2. Type the person’s first and last names, company, phone number, and
other information in their appropriate fields.

Press the tab key to move from one field to the next. You can skip fields
if you don’t have information and add others as need be. For example, to
add space for a new mobile phone number entry, click the + next to the
field name.

3. Close the Address Book.

If someone sends you a virtual address card (known as a vCard), just drag it
into the Address Book window. If you already have an entry for the person,
you’ll have the option to blend the new data with the old.

As you might imagine, Address Book has close ties to a bunch of other Mac
applications that [ discuss later in this book, most notably Mail and iChat.

Creating Smart Groups

Now suppose a whole bunch of people in your Address Book have something
in common. Maybe you all play softball on weekends. (That’s a good thing.
Break away. Have fun. Limber up. Your computer will be waiting for you when
you get back.) A Smart Group is a terrific way to manage information in
Address Book on all your teammates.
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The key is to add a descriptive word that lumps you all together in the Notes
field. Something, like, voila, softball. So whenever a new contact comes along

and you type in the word “softball,” he or she will become part of your Smart
Group.

To create a Smart Group from scratch, follow these steps:

1. Choose File->New Smart Group.

2. In the Smart Group Name field, type a name for your group.
I typed Weekend Athletes.

3. Click the + and specify the group criteria using drop-down menus, as
shown in Figure 3-9.

4. If you want to know when a new slugger has been added to the roster,
make sure the Highlight Group When Updated Option is selected.
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iCal

It’s swell that all your friends want to join the team. But good luck figuring
out a time when everybody can play.

For assistance, consult the Mac’s personal calendar application, iCal. It lets
you share your calendar with people on the same computer or “publish” a
calendar over the Internet to share with others, perhaps by subscribing to
.Mac. (pronounced “dot Mac”), to which I devote Chapter 12.

iCal also lets you subscribe to public calendars over the Internet (sports
teams, movie openings, and so on). As you might imagine, it can also show
the birthday of folks residing in your Address Book.

iSync

Many of you use more than one computer (you should be so lucky if you
have more than one Mac). You probably also have a cell phone, a personal

b5
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digital assistant (PDA), and an iPod. Through iSync, you can keep your calen-
dar, Address Book, and Internet bookmarks synchronized across multiple
devices. If you change an e-mail address on your cell phone, you can connect
the device to the Mac (even wirelessly through technology known as
Bluetooth) and have the number automatically updated in the computer’s
Address Book.

Stickies

Walk around your office and I'll lay odds that at least some of your colleagues
have yellow Post-it notes attached to their computer monitors. You too, huh?
They’re a great way to make your supervisor think you're really busy.

The Mac provides an electronic version called Stickies. Just like the gluey
paper kind, electronic notes let you jot down those quickie shopping lists,
phone numbers, and To-Dos.

But virtual Stickies have it all over their paper counterparts. Consider these
stunts:

» You can resize Stickies by dragging the handle on the note’s lower-right
corner.

» You can import text or graphics, and alter fonts and font sizes.

»* You can check the spelling of words in the note.

» You can create translucent Stickies to see what’s behind them.

» You can delete a note without crumpling it or crossing out its contents.

»* You won't clutter up your good-looking Macintosh computer. (You will
have to concoct another scheme to convince your boss how hard you
are working.)

Creating a new Stickie doesn’t count as work. After opening the app, choose
File>New Note. Then start scribbling, um, typing away.

Tooling around for a reference

Alot of what people do on a computer is look things up, mainly through
Internet search engines (Chapter 9) and other online tools (Chapter 11).
There’s help closer at hand — in the Applications Folder.
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Dictionary

Finding the meaning of words or phrases is as simple as typing them in a
search box. Finding the meaning of life is something else altogether. The Mac
supplies versions of the New Oxford American Dictionary and Oxford American
Writer’s Thesaurus. The computer can even read a dictionary entry out loud.

TextEdit

TextEdit is a freebie word processor. Although it offers nowhere near the flex-
ibility of an industrial-strength word processor such as Microsoft Word
(Chapter 7), it’s no slouch either. You can create tables and lists, and apply a
bunch of formatting tricks. And it can accommodate Word documents (if
someone sends you one). Truth is, most Word users exploit only a narrow
subset of features anyway. I'm not urging you to steer clear of Word. Just
know that you already have a decent little word processor onboard.

Calculator

Hey if all of us could do math in our heads, we wouldn’t need a calculator. In
fact, the Mac supplies three on-screen calculators: Basic, Scientific, and
Programmer. Choose the one you need from the calculator’s View menu.

The Basic calculator is for people like me who find the need to perform
simple arithmetic here and there. You can use the numeric keypad on your
keyboard or use the mouse to click the calculator’s keypad.

The Scientific version adds square root, sin, cos, and other keys whose mere
thought causes me to break out in hives. (Don’t count on seeing me as a
future author of Math For Dummies.)

The Programmer calculator is even more intimidating. It has keys labeled
Hide Binary, Byte Flip, Unicode, RoL, and RoR. You earn extra credit if you
know what all these do.

The Mac calculator is capable of tricks that blow away even the fanciest
pocket calculator, such as going online to fetch the latest currency exchange
rates.

QuickTime in the nick of time

QuickTime, the Mac’s free multimedia player comes to the rescue when you
want to watch a movie (but not a DVD), play sounds, or display pictures.
QuickTime typically pops up as needed.
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If you want to edit movies or have other bold ambitions (that is, full-screen
playback), consider springing for a $30 version of the program called
QuickTime Pro.

Previewing Preview

Preview is a versatile program that lets you view graphics files, faxes, take
screen shots or screen captures, and peek at PDFs. (That’s shorthand for
Adobe’s portable document format.) It typically loads automatically as
needed. For example, if you double-click a PDF file someone sent you,
Preview is probably the program that lets you read it. You can use Preview to
rotate, resize, and crop images in one of the many file types it recognizes.



Chapter 4

Here a Mac, There a Mac,
Everywhere a Mac Mac

In This Chapter

Understanding Intel’s impact

Deciding between a desktop and a laptop

Getting the lowdown on the latest desktop models
Going mobile with a laptop

Using a trackpad

Bolstering your battery

WHCh of the following describes you?

v Based on what you already know (or gleaned from this book), you are on
the righteous path toward purchasing a Macintosh computer. The chal-
lenge now is figuring out which model makes the most sense.

» You already own a Mac and are looking to add a second or even third
machine to your arsenal. The challenge now is figuring out which model
makes the most sense.

»* You received this book as a gift and have no intention of buying any
computer. The challenge now is explaining to the person who gave it to
you why no model makes sense (without hurting his or her feelings).

Regrettably, I can’t help anyone in the third group. Feel free to tag along
anyway. Hey, you might want to hear about how all these Macs are getting
brain transplants.



50 Part I: Freshman Year at Drag-and-Drop Tech

Intel’s Inside?

The computer industry creates strange bedfellows sometimes, maybe none
stranger than the apparently blissful union between Apple and Intel. To vet-
eran Mac diehards, placing Intel processors (or chips) inside their beloved
computers is a scandal analogous to an intimate liaison between George
Jetson and Wilma Flintstone.

Intel was the enemy, after all. Its processors belonged inside Windows com-
puters, not Apple’s, hence the derided (from a Mac point of view) moniker
Win-tel. Suffice to say, Apple’s head honcho Steve Jobs blew a few minds
when he broke the news that the company was jilting long-fancied PowerPC
G4 and G5 processors produced by IBM and going with chips made by Intel.

Apple announced it would overhaul its entire hardware lineup with Intel
chips throughout 2006, a process well underway as this book went to press.

So what is a processor anyway? Put simply, it is the brains behind your
computer.

Two chips are better than one

Most Macs reborn with Intel processors actually have two chips engineered
on a single slab of silicon. These Core Duo chips, as they are known, boast
twice the computational horsepower of a more traditional single chip design.
The idea is that the two chips can team up and share resources as needed
but also conserve power if one of the Cores is not needed for a particular
function.

But are you giving up something
to get something?

The burning issue for Mac loyalists is whether the presence of Intel would
somehow mess things up. For the most part, the answer is a resounding no.
Intel-based machines still look like Macs, quack like Macs and behave like
Macs. I explain the exceptions in the “Leave it to Rosetta” sidebar.
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Leave it to Rosetta

To help you deal with the Mac's brain transplant,
Apple and its industry pals started designing so-
called Universal software applications. These
programs are meant to run natively on both
G4/G5 machines and Intel-based Macs. In other
words, they rock either place. You know you've
bought a Universal application because the box
carries the logo shown here. Not surprisingly, the
iLife software already loaded on your computer
also receives the Universal seal of approval.

Universal

But what about older software you may have
lying around? Will those programs make nice
with Intel? Most will, thanks to behind-the-
scenes technology known as Rosetta. (I will
resist a joke about Apple leaving no stone
unturned.) You don’t have to actively mouse
around to wake up Rosetta. Quietly and invisi-
bly, it does its thing, which basically involves
translating software code to ensure that (for
now) non-Universal programs such as
Microsoft Office and Adobe Photoshop will
work, if not up to their maximum potential.

Ancient programs won't work at all on “Mac-
tel” machines. These include the Classic apps
that predate 0S X.
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Big Mac or Little Mac? The Laptop
versus Desktop Decision

Desktop? Laptop? Or notebook? Okay, that was a bit of a trick question
because people use notebook and laptop to refer to the same thing. So it’s
really desktop versus laptop/notebook.

The choice comes down to lifestyle, economics, and what you do for a living.
If you burn lots of frequent-flier miles, chances are you'll gravitate to a laptop.
If you tend to be home- or office-bound, a desktop might be more suitable.

Because you're getting a Mac whichever way you go, take solace in the fact
that the system comes preloaded with the OS X Tiger operating system and
other software goodies I expound on in other chapters.

Let’s give each side their due. The typical trade-offs follow. Here are the rea-
sons for buying a Mac desktop:

» You generally get more computing bang for the buck.

v Larger hard drives.
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v Bigger displays.

v Extra jacks and connectors.

v Easier to upgrade.

»* You won't slow anyone down checking in at airport security.

v+ The machine looks cool in your home or office.
And here’s why you would want to buy a Mac laptop:

v~ Light and portable.
v Appealing if you work or live in cramped quarters.
v Runs off battery or AC power.

v You can impress your seatmate on an airplane.

It a Desktop Is Your Poison

In most instances, buying an Apple desktop computer does not mean you
have to start rearranging or buying new furniture. Sure Mac desktops gener-
ally take up more space than Mac notebooks. But the machines are no larger
than they have to be, and in some cases are so good-looking you want to
show them off anyway.

iMac

As shown in Figure 4-1, the iMac is the most elegantly designed desktop com-
puter on the planet.

Now that I've said that, let me mention a proviso: The iMac is the most ele-
gantly designed desktop computer on the day that I write this. Apple wouldn’t
be Apple without surprises. By the time this book gets to you, the gang inside
the company’s Cupertino, California, headquarters may well have one-upped
themselves. (I'm not ready to predict that anybody outside Cupertino will
come up with a bolder design than Jobs & Co.)

Now that that lawyerly comment is out of the way, back to the captivating
charmer at hand. The innards of the system — Intel Core Duo processor,
memory, hard drive, CD/DVD player, and more — are concealed inside a
2-inch-thin flat-screen monitor. You can’t help wonder where the rest of the
computer is, especially if you're accustomed to seeing a more traditional
tower-type PC design.
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The elegant
iMac.

iSight camera

LCD screen

Foot
Speakers . =
p = ——Remote

Keyboard W
. Mouse
Disc slot
Courtesy of Apple

When you place a CD or DVD in the slot on the iMac’s right side, the disc gets
sucked inside the machine like a dollar in a vending machine’s bill changer.

The small square peephole at the top of the monitor covers up a built-in
iSight video camera (I bring up possible uses in Chapters 5 and 11). The com-
puter also comes with a Bic-lighter-sized Apple remote used to control
music, videos, and other media through Apple’s slick alternative full-screen
Front Row software interface, for launching the music, photos, DVDs, and
videos that reside on your Mac, especially when you're not quite sitting on
top of the computer.

Mac Mini

Is the Mac Mini shown in Figure 4-2 really a desktop? After all, Mac Mini is
easily mistaken for a bread box or coaster on steroids. But the petite 2-inch
tall, 6.5-inch square aluminum contraption is indeed Apple’s crazy (and cozy)
notion of what a budget desktop computer is all about. At less than 3 pounds,
Mac Mini is portable, but not in the same sense as a notebook you would fly
with cross-country. (Carting this computer from room to room is more like it.)
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Figure 4-2:
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Models start at just $599, but keep in mind that this is a BYOB computer — as

in bring your own keyboard, mouse, and monitor. (The assumption is that you
have these already, but if not, Apple will happily sell them to you.) Hey, at least
the Apple remote is supplied. Given its size and price, Mac Mini might make an
ideal second or third computer and is a perfect dorm room companion.

Because Mac Mini has Front Row and a collection of video connectors, you
can also hook it up to a big screen TV or take advantage of a superior speaker
system. And Mini includes the smarts to play back music or videos stored on
other computers in your house, including Windows systems.

Mac Pro

I don’t really expect many readers of this book to run out and buy the Mac
Pro. It may seem tempting to own the machine Apple billed as the “fastest
Mac ever” when it was introduced in August 2006. But there’s a reason the
word Pro is included in the name of this desktop machine — it’s not a com-
puter aimed at the masses. Instead, this machine is intended for profession-
als facing demanding graphics and other computing tasks. The computer is
noteworthy for another reason: Its arrival completed the transition of the
Mac line to Intel processors.

A standard Mac Pro configuration fetches $2499 and includes two 2.66 GHz
Dual-Core Intel Xeon processors, plus a 250GB hard drive. But this Mac is
meant to be the ultimate built-to-order computer. Apple says there are up to
4.9 million possible configurations, and you can build a Mac Pro that costs
well north of $10,000.

Going Mobile

You don’t have to be a traditional road warrior to crave a notebook these days.
You might just need something to schlep from lecture hall to lecture hall, your
home to your office, or maybe just from the basement to the bedroom.
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P In choosing any laptop, take into account its fraveling weight. Besides the
weight of the machine itself, consider the heft of the AC power cord and pos-
sibly a spare battery. None of the Mac laptops are kKillers as far as weight is
concerned, but some are lighter than others.

One of the first decisions you have to make is how big a screen you want.
Bigger displays are nice, of course, but they weigh and cost more. And you
may be sacrificing some battery life. Hmm, are you getting the sense that this
battery business is a big deal? It can be, which is why I offer tips on how to
stay juiced, at the end of the chapter.

As part of its migration to Intel processors, Apple retired two longtime mem-
bers of its laptop lineup in 2006, the ivory white iBook (popular with stu-
dents) and the silver PowerBook. Here’s a brief look at their Intel-inside
replacements, the MacBook and MacBook Pro.

MacBook Pro

The successor to the PowerBook is MacBook Pro, shown in Figure 4-3. It will
set you back $1999 or more. MacBook Pro resembles the PowerBook on the
outside, but it’s a lot different on the inside. That’s because it’s the first of the
Mac-tel notebooks. The inch-thin machine runs Core Duo processors. It has a
brighter (15.4-inch) screen than its predecessors, plus one of those incon-
spicuous iSight cameras. (There’s also a $2799 17-inch model.) MacBook Pros
also come with the Apple remote and Front Row.
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MacBook Pro did relinquish some features found on PowerBooks, such as
fewer ports and connectors. The absence of a standard dialup modem for
connecting to the Internet in hotels and elsewhere is an annoying and silly
omission. You can purchase an external modem that will connect to one of

the computer’s USB ports for $50.

Apple also replaced a standard PC Card-type slot for adding such things as
memory card readers and cellular modems with a new-generation slot called
ExpressCard. Many of those type cards are still being developed.

On the plus side, ambient sensors can illuminate the keyboard when the
cabin lights are dimmed on an airplane. If that doesn’t create a mood and
show the cute passenger in 12C how resourceful you are, nothing will.

Meanwhile, if you drop the machine, and trust me it happens, built-in sensors

instantly park the hard drive to reduce the damage.

The next neat feature, called MagSafe, may not win brownie points with
strangers on a plane. But it just might earn you raves at home. To find out
about it, see the “Cord tripping” sidebar.

Cord tripping

Has your dog or kid ever come barreling into a
room and tripped over the power cord connected
to your laptop? The machine goes flying off your
desk, and you scramble to assess the damage.
Have you no shame? Tend to your kid first.

Apple had this scenario in mind when it
designed the MagSafe connector, a nifty inno-
vation that debuted on the MacBook Pro.
Instead of physically inserting the power cord

to a connector as on previous Mac laptops, you
adhere the MagSafe magnetically.

So the next time your adolescents (canine or
human) come running in and trip the wire, the
cord should easily yank free, presumably with-
out harming the Mac or your first born. One
downside: The power brick in the middle of the
new cord is bulkier than cords used on previous
models.
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MacBook

Despite a lower price — they start at $1099 for a white model and $1499 for a
version in black — the MacBook shares some of the features of its Pro cousin,
including the built-in iSight camera, Front Row, the Apple remote, and
MagSafe. The main difference is the 5.2-pound nearly inch-thick MacBook has
a smaller (13.3-inch wide) screen and not quite the robust graphics capabili-
ties for running high-end photography programs such as Aperture. As with
the iBook it supplants, it should find a home on college campuses.

Taming the Trackpad

\\3

In Chapter 2, I introduce the trackpad, the smooth rectangular finger-licking
surface below the keyboard that’s your laptop’s answer to using a mouse.
You can still use a regular mouse with a laptop, of course, and may prefer to
do so if you're sitting at your regular desk. If you're sitting in coach instead,
the mouse is an unwelcome companion, critter, especially to the passenger
sitting next to you. Don’t be surprised if he or she calls an exterminator (or at
least the flight attendant).

A trackpad (and the human beings who control it) has its own annoying idio-
syncrasies. It may refuse to cooperate if you touch it coming out of the
shower. Hand-lotions are also a no-no. A trackpad loathes moisture and
humidity. If it does get wet, gently wipe it with a clean cloth. Do not use any
kind of household cleaning solution.

The best place to train a trackpad is in Keyboard and Mouse preferences.
Choose ®>System Preferences. Under Keyboard and Mouse preferences,
click Trackpad. The window in Figure 4-4 appears.

Here are some of the things you can do:

v Drag the Tracking Speed slider to change how fast the pointer moves
and the Double-Click Speed slider to set how fast you have to double-
click.

v~ If you want to click by tapping the trackpad surface, without having to
press the trackpad button, select the Clicking option.

v You can drag an item by tapping it twice, without having to hold down
the button, by selecting the Dragging option.

v Using two fingers on the trackpad surface will not move the cursor when
you select the Ignore accidental trackpad input option.
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v~ If you plan on using a regular mouse, select the Ignore trackpad when
mouse is present option.

v Two-finger scrolling is a recent trackpad function not included on older
models.

Keeping Your Notebook Juiced

A\

Sooner or later, especially if Murphy (the fellow behind that nasty Law) has
any say in the manner, your battery will lose its charge. At precisely the
worst possible moment. Like when your professor is prepping you for a final
exam. Or you are about to discover whodunit while watching a DVD on an
overseas flight. [ hasten to point out that watching a movie will drain your
battery a lot quicker than working on a spreadsheet.

A tiny gauge on the menu bar, as shown in Figure 4-5, gives you a decent mea-
surement of how long you can work before your battery peters out. You can
display this gauge by time or percentage. Just click the menu bar icon,
choose Show, and then choose Icon Only, Time, or Percentage.

The battery life cited by manufacturers has a lot in common with the miles
per gallon estimates quoted by automakers. Your actual battery life will vary,
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depending on how you drive your computer. Expect the total to be less than
the manufacturer’s claim.
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You may routinely keep the computer plugged to recharge the battery. Still,
Apple recommends pulling the plug periodically to keep the juices flowing. If
you don’t plan on using the computer for six months or more (and why the
heck not?), remove the battery and store it with about a 50% charge. You may
not be able to resuscitate a fully discharged battery that has been kept on the
sidelines too long.

Rechargeable batteries have a finite number of charging cycles, so even with
the best feed and caring they have to be replaced eventually. It is quite evi-
dent when it’s time to put the battery out to pasture because it will no longer
hold a charge. Remember to give it an environmentally correct burial.

Don’t give up the fight just yet. You can take steps to boost your battery’s
longevity. Your computer is smart about conservation. When plugged in, it
feels free to let loose. That means the hard drive will spin around to its heart’s
content, and the display can be turned up to maximum brightness settings.

You can tell a Mac how to behave when it is unplugged:

v Dim the screen. There’s nothing your laptop battery likes better than
mood lighting. Press F1 on the keyboard to turn down the brightness.

v Open Energy Saver (see Figure 4-6) by single-clicking the battery gauge in
the menu bar and then selecting Open Energy Saver. Alternatively,
choose ®=>System Preferences, and double-click Energy Saver. Near the
top of the window, choose Better Battery Life from the Optimization list.
You will notice other options in Energy Saver, including a slider to put
the computer to sleep when it’s not used for a certain period, plus a
slider to put the display asleep after the machine is inactive. Make sure
the option to Put the Hard Disk(s) to Sleep When Possible is checked.
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v Shut down the AirPort wireless networking feature (Chapter 18) if you
are not surfing the Internet. AirPort hogs power. And you shouldn’t be
using it anyway if you're traveling on an airplane.

v Likewise, turn off the wireless settings for Bluetooth if you're on a plane

or if you just want to save some juice.
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After all, given all your aspirations with your computer, the last thing you
want to have happen is to run out of power.
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In this part . . .

sn’t it about time to do some honest-to-goodness
computing? Roll up your sleeves. You're about to per-
sonalize the Mac to your taste and styles, dig into System
Preferences, go on lively search expeditions using
Spotlight, and create and print documents. And take
on the warm and fuzzy feeling that comes when you’ve
accomplished what you've set out to do.




Chapter 5
Making the Mac Your Own

In This Chapter
Creating user accounts
Implementing parental controls
Logging in and off
Choosing a desktop picture and screen saver
Exposing Exposé

Setting priorities

ou adore your family and friends to death, but you have to admit that

they can get under your skin from time to time. They know how to push
your buttons, and you sure know how to push theirs. People are fussy about
certain things, and that includes you (and me).

So it goes with your Macintosh. The presumption is that you and your Mac
are going to cohabit well into the future. Still, it can’t hurt to get off on the
right foot and set up the machine so that it matches your personal prefer-
ences and expectations, and not some programmer’s at Apple. No two Macs
ever end up the same. The software you load on your system differs from the
programs your best buddies install on their computers. You tolerate dozens
of icons on the Mac desktop, they prefer a less cluttered screen. You choose
a blown-up picture of Homer Simpson for your desktop background; your
pals go with a screen-size poster of Jessica Simpson.

Establishing User Accounts

As much as the computer staring you in the face is your very own Mac,
chances are you'll be sharing it with someone else: your spouse and kids,
perhaps, if not your students and co-workers. | know you generously thought
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about buying each of them a computer. But then your little one needs braces,
you've been eyeing a new set of golf clubs and, the truth is, your largesse has
limits. So you’ll be sharing the computer, all right, at least for awhile. The
challenge now is avoiding chaos and all-out civil war.

The Mac helps keep the peace by giving everyone their own user accounts,
which are separate areas to hang out in that are password protected to pre-
vent intrusions. (There’s not much the folks at Apple can do to avert fights
over when people use the computer.)

In Chapter 2, I explain how you create your own user account as part of the ini-
tial computer setup. Not all user accounts are created equal, and yours is extra
special. That’s because as the owner of the machine, you're the head honcho,
the Big Cheese, or in the bureaucracy of your computer, the administrator.

Being the Big Cheese doesn’t earn you an expense account or a plush corner
office with a view of the lakefront. It does, however, carry executive privi-
leges. You get to lord over not only who else can use the machine but who, if
anyone, gets the same administrative rights you have.

Think long and hard before you grant anyone else these dictatorial powers.
Only an administrator can install new programs in the Applications folder,
choose which files to share among all users, or muck around with such
system settings such as Date & Time and Energy Saver. And only an adminis-
trator can effectively hire and fire, by creating or eliminating other user
accounts.

To create a new account for one of your coworkers, say, follow the steps
below:

1. Choose ®c=System Preferences, and then click the Accounts icon.

Alternatively, click your user name on the upper-right corner of the
screen, mouse down to Accounts Preferences, and click. In both
instances, you end up in Accounts Preferences.

It’s worth remembering how you get to System Preferences because
you’ll be spending quite a bit of time there in this chapter. The Accounts
window that appears is shown in Figure 5-1.

2. If the Password tab isn’t highlighted, click it.
3. Click the + below the list of names on the right.

If the + appears dimmed, you have to click the padlock at the bottom of
the screen and enter your name and password to proceed. (You'll
encounter this padlock throughout System Preferences and must click it
and enter an administrative password before being allowed to make
changes.)



|
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4. Enter a name, a short name, a password, the password verification,
and (if you chose) a password hint.

This is the same drill you went through to create your own account.
Unless you have a good reason to do otherwise, leave the Allow user to
administer this computer option unchecked. (Of course, you may want
to give a coworker or other person sharing an account the ability to
enter his or her own password and user name.)

5. Click the Picture tab.

6. Select the small image that will be displayed next to the user name
when the account holder logs on to the computer. (Again, you may
allow the other person to choose his or her own picture.)

You can click the bowling pins, gingerbread cookie, or other goofy iconic
images presented by Apple in the Accounts window. But account hold-
ers may well want to choose one of their own images. To do so, open OS
X’s default navigational window Finder (by clicking the Finder dock icon)
and then click Pictures. Drag an image into the little picture box next to
the word Edit in the Accounts window. Alternatively, click the Edit
button and then click Choose, which puts the user back in the Finder.

Check out the “Entering the photo booth” sidebar for another, more enjoy-
able way to create an account picture.



66 Part ll: Mac Daily Dealings

Using Parental Controls: When Father
(or Mother) Knows Best

Suppose one of the new accounts you create is for your impressionable off-
spring Cookie Monster. As a responsible parent, you want to set limits to
keep him out of trouble. And as a responsible Mac owner, you want to keep
him from unwittingly or (or otherwise) inflicting damage on the computer.

It’s time to apply parental controls. When you do so, Cookie’s account goes
from being a regular standard account to a managed account, with you as the
manager. You have quite a bit of say about what your youngster can and
cannot get away with.

In the Accounts window, highlight Cookie Monster’s name in the list on the
left. Then click the Parental Controls tab. The window shown in Figure 5-2
appears. Your choices are as follows:

v Mail: Specifies who your kid can exchange e-mail with. Click to select the
Mail option. A separate window opens. (If the option is already selected,
click Configure instead.) Click the Add (+) button in that window and
type an acceptable e-mail address. Separately enter your own e-mail
address in the “Send Permission Emails To” box at the bottom of the
window to approve any requests from Cookie Monster to correspond
with a person not already on the approved list.

v Finder & System: Provides various options for what Cookie Monster can
do on the computer. You find out more about these in a moment.

v iChat: Spells out who Cookie Monster can hold chats with through
instant messages.

v~ Safari: Requires you, the administrator, to log in as Cookie Monster and
launch the Safari Web browser (Chapter 9). You can then add the sites
you deem kosher for your little guy.

+ Dictionary: Keeps Cookie Monster from looking up certain four-letter
words.

Now let’s explore Finder & System parental control options. Click the Configure
for Finder & System button, and the screen shown in Figure 5-3 appears. Select
the Some Limits option. Here’s where you get to decide whether Cookie
Monster will be able to administer printers, modify the dock, burn CDs and
DVDs, or open all System Preferences by selecting the corresponding check
boxes. You can also specify which applications he can open.
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Figure 5-2:
Parental
controls
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Figure 5-3:
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Entering the photo booth

Remember when you and your high school sweet-
heart slipped into one of those coin-operated
photo booths at the Five and Dime? Don’t worry,
I'm not telling what went on behind that curtain.
You probably confiscated the evidence years
ago, a strip with all those silly poses.

Silly poses are back in vogue. Apple is supplying
its own photo booth of sorts as a built-in soft-
ware feature on recent Macs with integrated
iSight cameras. You can produce an acceptable
account picture to use when exchanging
instant messages (Chapter 11).

The Apple Photo Booth and the photo booth of
yesteryear have some major differences. For
starters, you don't have to surrender any loose
change. What's more, there's no curtain to hide
behind (which is kind of too bad), though there
is a picture of a curtain in the Photo Booth icon.

Still, Apple’s Photo Booth application is practi-
cally guaranteed to provide you hours of unbri-
dled pleasure thanks mostly to the warped
things you can do to doctor up images. You have

not lived until you've seen a picture of your face
morph into a light tunnel.

Open Photo Booth by clicking its name in the
Applications folder. Then, to snap an image,
merely click the Shutter button below the large
video screen that serves as a viewfinder, as
shown in the picture. A three-two-one count-
down ticks off. On zero, the display flashes, and
your mug is captured. You can apply funky spe-
cial effects to your visage either just before or
after snapping the picture. For instance, you can
make it look as if the picture was taken with a
thermal camera or an X-ray, or drawn with a col-
ored pencil. You can turn the image into pop art
worthy of Warhol or make it glow radioactively.

The pictures you take end up in an on-screen
photo strip. Click the thumbnail you want, and
decide what you want to do with the image by
choosing an appropriate button: Account
Picture, Buddy Picture (to make it your iChat
buddy icon), E-mail (to the Mac's Mail applica-
tion), or iPhoto (to your picture library).

@ Photo Booth File _Edit Window  Help

% % 40 Sun 10.59 PM Apple Computer &)

(= Lala Photo Booth -

!Hnmz

iARRARE

9 ghos

KOOROPRLE IBBA ¢ AONYT W




69

Chapter 5: Making the Mac Your Own

\\3

Now suppose that instead of Some Limits you selected Simple Finder. Under
this setting, Cookie can’t alter the dock and will see a sparse, icon-free desk-
top when he logs on.

You don’t have to have kids to implement parental controls. These controls
work nicely in setting limits on employees, friends, or visiting relatives.

The Lowdown on Logging On

|
Figure 5-4:
Choosing
login
options.
|

You can create user accounts for any and all potential family members or visi-
tors who will be using this particular Mac. And you can control how they log
in. In this section [ describe how.

In System Preferences, again choose Accounts Preferences, and then click
Login Options at the bottom of the left pane, under the list of all the account
holders on your system. If need be, click the padlock and enter a name and
administrative password. Once in, you’ll see the window shown in Figure 5-4.
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To automatically log in a particular user (likely yourself), select the
Automatically Log In As option and choose the appropriate person from the
pop-up menu. You'll have to enter a password.

If the computer is set to automatically log you in, any user who restarts the
Mac in your absence will have access to your account.

If automatic log in is not turned on, users who start up the Mac will
encounter the computer’s Login screen. It will appear differently depending
on which radio button you chose under Display Login Window As under
Login Options.

Select List of Users to see a Login screen with a roster of people alongside
pictures for their respective accounts, plus a check mark if they’re already
logged in. As if that isn’t a clear enough marker, the words currently logged in
appear under the name.

Select Name and Password, and account holders must type a user name and
password in the appropriate boxes on the Login screen.

Either way, press Enter or click after entering the password to actually log in.
If you type the wrong password, the entire window wobbles as if having a
momentary seizure. Type it wrong a few more times, and any password hints
you previously entered appear (provided you chose that option under Login
Options).

And logging off

Say you are ready to call it quits for the day but don’t want to shut down the
machine. At the same time, you don’t want to leave your account open for
anyone with prying eyes. Baig’s Law: Just because your family, friends, and co-
workers are upstanding citizens doesn’t mean they won'’t eavesdrop. The way to
shut down without really shutting down is to choose ®Log Out.

Pulling a fast one

Now let’s consider another all-too-common scenario. You're in the middle of
working when — how to put this delicately — last night’s pasta exacts
revenge. Nature calls As you get up to leave, your spouse comes running in,
“Honey, can I quickly check my e-mail?” You could log out to let her do so, but
because you are going to be right back, you figure there’s got to be a better
way. The better way is called fast user switching. To take advantage of the fea-
ture, you must have previously checked the box next to Enable Fast User
Switching, in the Login Options window.
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Then, to let your spouse (or any other user) butt in, click your user name in
the upper-right corner of the screen. A list of all account holders appears.
The person can then click his or her name and type a password. Like a
revolving door, your entire desktop spins out of the way while the other
user’s desktop spins in. When you return moments later, you repeat this pro-
cedure by choosing your name and password. Your desktop twirls back into
view, right where you left off.

Letting Someone Go

Sometimes being the boss really does mean being the bad guy. The Mac
equivalent of terminating somebody is to delete the person’s user account
from the system. In the Accounts window, click the padlock (it’s at the
bottom right of the screen) to permit changes. Then select the name of the
person getting the pink slip. Click the — button under the list of names.

A dialog box presents two choices: Clicking OK wipes the account from the
system but saves the contents of the person’s home folder in a file appropri-
ately marked Deleted Users. You may want to retain some of his or her docu-
ments and files for your own records. If the user you’re booting was particularly
naughty (and you don’t need their files), you can choose Delete Inmediately to
completely and instantly wipe out all traces of their existence.

Changing Appearances

Now that you'’re past the unpleasant act of whacking someone from the
system, you can get back in touch with your kinder, gentler side. The part of
you solely occupied with making the Mac look pretty.

Altering the desktop

The surreal looking aqua-blue wallpaper Apple put up behind your desktop is
attractive enough. It’s just not necessarily your taste. You can rip it down and
start anew.

Choose ®=>System Preferences. Click Desktop & Screen Saver, and make sure
the Desktop tab is highlighted, as shown in Figure 5-5. Click one of the design
categories in the list on the left (Apple Images, Nature, Plants, and so on).
Various design swatches appear on the right. Best of all, unlike the swatches
a salesperson might show you in a home decorating store, you can see what
a finished remodeling job here will look like. All you have to do is click.
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|
Figure 5-5:
Becoming
your own
interior
decorator.
|
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The design categories on the left include a listing for the Pictures Folder as
well as folders from your iPhoto library (see Chapter 15). Clicking these
options lets you choose one of your own images for the desktop background.
Apple’s designer collection has nothing over masterpieces that include your
gorgeous child.

If variety is the spice of life — or you have a short attention span — click to
add a check mark to the Change picture every 30 minutes option (or select
another timeframe from the drop-down menu). Selecting the Random order
option will (you guessed it) change the background in random order. This
option cycles through pictures in the folder selected in the left pane.

Choosing a screen saver

“God save the screen. God save the screen? What's that, wrong slogan? “Queen?
Oh, royal bummer, never mind.”

Screen savers are so-named because they were indeed created to save your
screen from a ghostly phenomenon known as burn-in. Whenever the same
fixed image was shown on a screen over long periods of time, a dim specter
from that image would be permanently etched onto the display. Burn-in



Chapter 5: Making the Mac Your Own

|
Figure 5-6:
Beautifying
your display
with a
screen
saver.
|

ceased to be a problem long ago. But screen savers survived. Today their
value is strictly about cosmetics and personalization, in the same way you
might choose a vanity license plate or a ring tone for your cell phone.

In the Desktop & Screeg Saver window, click the Screen Saver tab. (Not in
that window? Choose ®=>System Preferences and then click Desktop &
Screen Saver.)

Click one of the screen savers in the box on the left side, as shown in Figure
5-6. Some of the pictures are truly stunning. (I recommend Cosmos or Nature
Patterns.) You can also select images from your own photo library or install
screen savers created by companies other than Apple.

You can preview screen savers in the small screen to the right or click the
Test button to get the full-screen impact.

After choosing a screen saver (or again having Apple choose one for you ran-
domly), drag the Start screen saver slider to tell the Mac to choose a time for
the screen saver to kick in, ranging from 3 minutes to 2 hours (or never).
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Tidying Up with Exposé

You are so frantically busy that your papers end up strewn every which way,
empty coffee cups litter your desk, and boxes pile on top of boxes. Worse,
you can’t lay your hands on the precise thing you need the very moment
when you need it. Sound familiar? Psychiatrists have a technical name for
this kind of disorder. It is called being a slob. (Takes one to know one.)

Things can get untidy on the Mac desktop, too, especially as you juggle sev-
eral projects at once. At any given time, you may have opened System
Preferences, the dictionary, iCal, an e-mail program, numerous word process-
ing documents, and then some. Windows lay on top of windows. Chaos
abounds. You have fallen into the dark abyss that is multitasking.

Apple has the perfect tonic for MDLS (Messy Desktop Layered Syndrome).
The antidote is Exposé, and it is as close as your F9 key (or the Fn+F9 combi-
nation on some models).

Go ahead and press F9 now (or Fn + F9). Each previously open but obstructed
window emerges from its hiding place, like crooks finally willing to give them-
selves up after a lengthy standoff. All the windows are proportionately and
simultaneously downsized so that you can temporarily see them all at once,
as shown in Figure 5-7.

Now move the cursor over one of the visible windows. The title of the appli-
cation or folder is revealed, and the window appears dimmed. Point to the
window you want to bring to the front (to work on) and press the spacebar,
press Enter, or click inside the window.

Exposé is good for a few other stunts, and these are the default keys to make
them happen:

v+ F10: Opens all the windows in the application you're currently using. If
you’re working on a document in Microsoft Word, for instance, any other
open documents in Word will also be brought to the front lines, as
shown in Figure 5-8.

v F11: Hides all windows so you can admire the stunning photograph you
chose for your desktop, as shown in Figure 5-9.
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Cluttered desktop before putting Exposé to work
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If you have something against F9, F10, and F11 (or are using those keys for
other purposes), open System Preferences, choose Dashboard & Exposé, and
assign alternative keys. And if you have something against keys in general,
you can arrange to have Exposé do its thing by moving the cursor to one of
the four corners of the screen.

Incidentally, if you're wondering about the Dashboard part of Dashboard &
Exposé, skip ahead to the next chapter. Those who wait will be rewarded with
a tour of some of the remaining items in System Preferences.

System Preferences: Choosing Priorities

Figure 5-10:
Doing it my
way through
System
Preferences.
|

You may be wondering what'’s left. We’ve already dug inside System
Preferences to alter the desktop and screensaver, establish parental controls,
muck around with Exposé, and then some. But as Figure 5-10 shows, there’s
still a lot more you can do. Let’s explore some of those options now.

Getting in sync with date and time

You established the date, time, and time zone when you set up the Mac ini-
tially (Chapter 2). In System Preferences, you can move the location of the
clock from the menu bar to a separate window. You can change the appear-
ance of the clock from a digital readout to an analog face with hands. You can
display the time with seconds or use a 24-hour clock. You can even have the
Mac announce the time on the hour, the half hour, or the quarter hour.

System Preferences
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Displays

If you are hunky-dory with what your display looks like, feel free to ignore
this section. Read on if you are the least bit curious about resolution and what
changing it will do to your screen. Resolution is a measure of sharpness and
expressed by tiny picture elements, or pixels. Pixels is such a nice sounding
word that I always thought it would make a terrific name for a breakfast
cereal, something like new Kellogg’s Sugar-Coated Pixels. But I digress.

You will see resolution written out as 800 x 600, 1024 x 768, 1680 x 1050, and
so on. The first number refers to the number of pixels horizontally, and the
second number is the number of pixels vertically. Higher numbers reflect
higher resolution, meaning the picture is sharper and you can fit more on the
screen. At lower resolutions the images may be larger but fuzzier, though this
depends on your monitor. Lower resolutions also refresh, or update, more
quickly, though you will be hard-pressed to tell with most modern monitors.
As it happens, the refresh rate doesn’t mean boo on computers such as the
iMac with LCD or flat-panel displays.

You can also muck around with the number of colors that a Mac displays
(millions, thousands, or down to a puny 256). Best advice: Play around with
these settings if you must. More often than not, leave well enough alone.

Sound

Ever wonder what the Basso sound is? Or Sosumi or Tink? I'd play them for
you if this was an audio book, but because it isn’t, check out these and other
sound effects in System Preferences. You'll hear one of them whenever the
Mac wants to issue an alert. Sound preferences is also the place to adjust
speaker balance, microphone settings, and pretty much anything else having
to do with what you’ll hear on the Mac.

Software update

Your Mac may be a machine, but it still has organic traits. And Apple hasn’t
forgotten about you just because you’ve already purchased one of its prized
computers. From time to time, the company will issue new releases of certain
programs to add new features it won’t make you pay for, to patch or fix bugs,
or to thwart security threats. For a full log, click Installed Updates.
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|
Figure 5-11:
Universal
Access
preferences.
|

You can have the Mac check for automatic software updates daily (might be
overkill), weekly, or monthly, or on the spot. If you choose, the Mac will fetch
important updates in the background, and bother you only when the pro-
gram update is ready to be installed. Software Update is accessible also
directly from the % menu.

Universal Access

Some physically challenged users may require special help controlling the
Mac. Choose Universal Access under System Preferences, and click the tab
you need assistance with: Seeing, Hearing, Keyboard, or Mouse, as shown in
Figure 5-11.
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Among the options, you can arrange to

v Turn VoiceOver on or off, to hear descriptions of what’s on your screen.

v Enhance the contrast, or alter the display from black on white or white
on black.
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v Flash the screen when an alert sound occurs.
v Zoom in on the screen to make everything appear larger.

v Use a Slow Keys function to put a delay between when a key is pressed
and when the result of that keypress is accepted. Or, if you can’t easily
press several keys at once, use Sticky Keys to press groups of modifier
keys (Shift, 38, Option, and Control) in a sequence.

The Mac may share a nickname with certain McDonald’s hamburgers. But it’s
actually an old Burger King slogan that is most apt when describing your
computer. As this chapter has shown, you can “have it your way.”



Chapter 6
Apple’s Feline Fetish

In This Chapter

Counting the new features in Tiger
Defining OS X Tiger

Searching through Spotlight
Understanding widgets

Automating the Automator

Sceve Jobs is fond of big cats. Before Apple unleashed Tiger, previous ver-
sions of Mac OS X software carried such purr-fect monikers as Cheetah,

Puma, Jaguar, and Panther. (Apple used the code words Cheetah and Puma

internally.) Leopard is coming next, perhaps even by the time this book hits

store shelves. Apple is also presumably breeding Lynx and Cougar inside its
Cupertino, California, cages.

As strong a release as it is, the name OS X just doesn’t have the bite that
Tiger or any of the other giant kitty nicknames command. However, X (for
ten) is the most celebrated use of Roman numerals this side of the Super
Bowl.

Tiger actually represents OS X version 10.4. Every year or so, Apple brings
out a new iteration of its operating system software (see the “An operating
system primer” sidebar), complete with a boatload of new features, and iden-
tified by an extra decimal point. Apple says OS X version 10.4 Tiger piled
more than 200 features onto its predecessor OS X version 10.3 Panther. I
haven’t counted.

During the course of a year, Apple will make interim tweaks to its operating
system. You will know because the OS takes on an extra decimal digit. At the
time of this writing, Apple was up to OS X version 10.4.7 (pronounced “ten
dot four dot seven™).

[ wonder how many features must be added before Apple changes the desig-
nation to OS XL
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'1:o check out the version of Mac software running on your system, choose
®>About This Mac. Choose Software Update to see whether the OS (and, for
that matter, other programs) are up to date.

Bottom line: Tigers are stunning and powerful creatures. They demand
respect and awe. Something like Apple’s computers.

How Many New Features?
Let Me Count the Ways

As already noted, Apple added more than 200 features to the Mac OS in Tiger
(and you can expect lots more features when Leopard prances on stage;
Apple was set to preview the new operating system in August 2006). Even if I
had the space, I don’t claim the expertise to do all the new features justice.
As a public service and, um, for your reading pleasure, I thought I'd at least
tick off a few of the items on Apple’s long laundry list of features. I'm letting
Apple do the talking here. I haven’t changed any of the company’s descrip-
tions (except for the boldface lead-ins).

Disclaimer: I'm not trying to demean any of these enhancements. These obvi-
ously provide great value to somebody. I'm just guessing that the items listed
here will collectively interest perhaps 1 percent of you. If you want to skip
ahead, I'm not going to stop you.

v+ For the international crowd: Tiger includes the Tamil language script, a
new input mode for Korean and extended system fonts to support Greek
(modern and classical), Vietnamese, Cyrillic, and Roman script lan-
guages of the former USSR.

v For UNIX lovers: Use command line file commands on HFS+ items with
proper results. Utilities such as cp, my, tar, rsync now use the same stan-
dard APIs as Spotlight and access control lists to handle resource forks.

v For networking types: Take advantage of the power of distributed com-
puting with Xgrid, Apple’s easy-to-use tool that turns a group of Macs
into a supercomputer.

v For developers: Take advantage of the latest version of the GCC com-
piler, featuring support for 64-bit code generation.



Chapter 6: Apple’s Feline Fetish

An operating system primer

There is software, friends, and there is SOFT-
WARE. Make no mistake, a computer’s operat-
ing system deserves top billing. If this were a
movie and the opening credits were rolling, the
name of the operating system would appear
above the title. All other performers on your
computer, no matter how much talent they pos-
sess, are supporting players by comparison.

Come to think of it, there would be no movie at
all without the operating system, for it is the
foundation on which all your other programs
run. Minus the 0S, that fancy photo editing pro-
gram you bought recently might as well be
chopped liver.

As operating systems go, you are truly fortunate
to have Tiger. OS X earns raves not just because
it's slick and easy on the eyes. Tiger is robust, reli-
able, and stable. Its underpinning is something

called UNIX, a venerable operating system in its
own right. The brilliance of Apple was in figuring
how to exploit UNIX without making you learn
UNIX. Just be thankful it's under the hood and
don't give it another moment's thought.

Now | know at least some of you can't leave it
there. You want to investigate UNIX. (You're the
person | want in the trenches with me.) Okay, here
goes. Open the Applications folder, choose
Utilities, and delve inside a program called
Terminal. What you'll find here isn't pretty, as the
figure shows. No icons. No easy menus. You have
split the town of GUI-ville and are now tooling
around with a command line interface— meaning
you have to type arcane commands to tell the
computer what to do. Doing so could wreak havoc
on your system, so be careful. You know what they
say about curiosity killing the cat.

Terminal
Last login: Sot Apr 1 82:19:81 on tiypl
Welcome to Darwin!
[Edward-Baigs-Computer-3:~] applek D

tcsh — BOx24
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Searching with Spotlight
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Whew! Now that I dispensed with that little piece of trivia, it’s time to concen-
trate on Tiger lilies all Mac users will appreciate. I'll start by putting the spot-
light on Spotlight, a marvelous desktop search utility I practically guarantee will
blow you away. If Spotlight was the only new feature Apple bred into Tiger,
those of you who haven’t bothered to upgrade a previous version of OS X in the
past would have to think long and hard about not doing so this time around.

Here’s why. Search is a big deal. A computer isn’t much good if you can’t
easily lay your hands on the documents, pictures, e-mail messages, and other
programs you need at any particular moment. When most people think about
searching on a computer, they probably have Google, Yahoo!, or some other
Internet search engine in mind. Internet search is of course a big deal too,
and I spend some time discussing it in Chapter 9.

The searching I have in mind here, however, involves the contents of your
own system. Over time, Mac users accumulate thousands of photos, songs,
school reports, work projects, contacts, calendar entries, and you name it.
Spotlight helps you locate them in a blink. It starts spitting out search results
before you finish typing.

What’s even better is that Spotlight can uncover material within documents
and files. That’s incredibly useful if you haven’t the foggiest idea what you
named a file.

Let’s try Spotlight now:

1. Click the blue magnifying glass icon in the upper-right corner of the
menu bar. Or press 38 and the spacebar simultaneously.

The Spotlight search box appears.
2. Enter a word or phrase you want to search for.

The instant you type the first letter, a window shows up with what
Spotlight considers the most likely search matches. The search is imme-
diately refined as you type extra keystrokes, as shown in Figure 6-1.
Searching is so fast you’ll see results more quickly than it takes you to
read this sentence.

Say you’re planning a tropical vacation and remember that your cousin
Gilligan e-mailed you awhile back raving about the beach at some deserted
Pacific island. You can open the Mac Mail program and dig for the missive
from the dozens that Gilligan sent you. (Evidently he had a lot of time on his
hands.) But it’s far simpler and faster to type Gilligan’s name in Spotlight.



|
Figure 6-1:
The
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search box.
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]

| Show All (70)

Top Hit | 3 beach

Documents | Gilligan tells me there are gr...
_ beach
& AlbumData.xml
=] Installer Log File
| Beach

Music ] 22 Do You Wanna Dance_.m4a
Al 19 Rock And Roll Music.m4a
|| 04 Beach Baby - First Class.m4a
[A 03 | Get Around - Beach Boy.
[/ 30 Good Vibrations.m4a
[ 29| Can Hear Music.m4a
[ 28 Darlin’.m4a
Al 27 wild Honey.m4a

Mail Messages [ °| Hey
| Testing with Gilligan

Events & To Do's ™ New Event

PDF Documents | @ 03_alltime_hasenorhl_jordan..
¥ Getting Started With AW 6.pdf
FAXstf™ X Benutzerhandbuch

Spotlight preferences...

Or maybe you want to give Gilligan a quick buzz. Without Spotlight, you
would probably open your Address Book to find your buddy’s phone number.
The faster way is to type Gilligan in Spotlight and then click his name next
to Contacts in the results window.

Rummaging through your stuff

Spotlight is built into the very fabric of the operating system. Quietly behind
the scenes, Spotlight indexes, or catalogs, all the files on the computer so you
can access them in a moment’s notice. The index is seamlessly updated each
time you add, move, modify, copy, or delete a file.

Moreover, Spotlight automatically rummages through metadata, the informa-
tion about your data. Digital photographs, for example, typically capture the
following metadata: the camera model used to snap the image, the date, the
aperture and exposure settings, whether a flash was used, and so on. For
example, if a friend e-mails you pictures taken with a Kodak camera, you can
quickly find those images — as opposed to, say, the pictures you took with
your own Canon — by entering the search term Kodak.
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|
Figure 6-2:
Spotlighting
the Spotlight
results
window.
|

Spotlight is one confident sucker. It boldly takes a stab at what it thinks is the
Top Hit, or search result you have in mind. (The Top Hit in Figure 6-1 is a doc-
ument named beach.) Its track record is pretty good. If it guesses right, click
the Top Hit entry. That will either launch the application in question, open a
particular file, or display the appropriate folder in the Finder. As is often the
case, there’s a shortcut. Press 38 and Return to launch the top hit.

Of course, Spotlight isn’t always going to get the Top Hit right, so it also dis-
plays what it considers to be the next 20 most likely matches. Results are seg-
regated into categories (Applications, Documents, Folders, PDF Documents,
Music, Images, Bookmarks, and so on). Again, just click an item to launch or
open it.

Some searches yield more than 20 possible outcomes. Often a heck of a lot
more. That’s what Show All (refer to Figure 6-1) is all about. Clicking Show All
doesn’t, in fact, show you everything. Most of the time your screen wouldn’t
be near big enough anyway.

Instead, Show All opens a separate Spotlight window like the one shown in
Figure 6-2. The most probable search results in each category are listed, fol-
lowed by an indication of how many more results are in each group. Click the
more line (for example, 20 more) to scroll through the list of other possible
search outcomes.

ene Spotlight: beach
70 Results {Q beach
- Group by:
" Gilligan tells me there are great beaches there.doc Today 9:00 AM ey
|71 Short Films.doc March 2004 Date
7 Beach February 2004 People
2 stray cats rumble in brighton.txt No Date Hatlis
¥ beach Saturday 5:36 M Sort Within Group by:
20 more Name
Date
— Kind
@ Redondo Beach Long.aif No Date
= People
[8 Redondo Beach Medium.aif No Date
@ Redondo Beach Short.aif No Date BT
[ 15 Good Vibrati 4 Feb 2004 A et
[f 15 Good Vibrations.méa ebruary aday
[#] 12 Help Me Rhonda.m4a January 2004 R

34 more This Week
v Mall Messagas J This Month
This Year

|_*] Baigbw@aol.com Hey Wednesday ~ 11:25 PM

[7] Baigbw@aol.com Testing with Gilligan Wednesday ~ 11:25 PM Where:

¥ Events & To Do's el

i
= New Event Wednesday ~ 11:30 PM o

FFJ Macintosh HD

FAXstf™ X Benutzerhandbuch August 2002
# Cetting Started With AW 6.pdf February 2003
¥ 03_alltime_hasenorhl_jordan.pdf July 2003
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Intelligent searching

You can customize search results in numerous ways. Take a look at the
column on the right side of the Spotlight results window. You can sort out-
comes by Kind (Documents, Mail Messages, and so on), Date (Today,
Yesterday, Previous 7 Days, Previous 30 Days, Earlier), and People (Gilligan,
Ginger, Skipper, and so on). You can also set various sorting preferences
within a group.

The best way to narrow results is to enter as specific a search term as possi-
ble right off the bat. As you plan your vacation, typing beach will probably
summon the e-mail message Gilligan sent you. But because Spotlight will find
all files or programs that match that text, results may also include Power-
Point presentations with a beach theme, pictures of your family by the
seashore, and songs on your hard drives sung by the Beach Boys. Typing
Gilligan and beach together will help you fine-tune your search.
If you know the type of item you're looking for, such as Gilligan’s e-mail as
opposed to his picture, you can filter the search in another way. Enter the
search term followed by kind and the file type you are looking for, as in
Gilligan kind:email
If you want to search for a presentation someone sent you on the world’s
best seaside resorts but can’t remember whether the presentation was cre-
ated in AppleWorks, Keynote, or PowerPoint, try
seaside resort kind:presentations
And if you want to search only for presentations opened in the past week, type
seaside resort kind:presentations date:last week
To search for an application such as Microsoft Word, type
Word kind:application
To search Gilligan’s contact information, type
Gilligan kind:contacts

To search for music, type

Beach Boys kind:music
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|
Figure 6-3:
Focusing the
limelight on
Spotlight
Preferences.
|

To search for pictures at the beach, type
Beach kind:images

And so on.

Searching your way

Up to now, you've let Spotlight determine how to present search matches.
Now let me remind you who'’s the boss. This being your Mac and all, you can
have Spotlight search according to your marching orders.

Spotlight pours through pretty much everything on your hard drive — unless
you dictate otherwise. To do so, open Spotlight preferences by clicking at the
bottom of the Spotlight results window. With the Search Results tab selected,
you can check or uncheck the types of items you want Spotlight to search, as
shown in Figure 6-3, and drag the categories in the order you want results to
appear.

Spotlight
[« » ][ showail | Q
O Spotlight helps you quickly find things on your computer. Spotlight is
@D located at the top right corner of the screen.
! Search Results = Privacy
Drag categories to change the order in which results appear.
Only selected categories will appear in Spotlight search results.
_1_- ?—-;—A‘i_)‘\pp]ications
2 z 4 Documents
3 o |7 Folders
4 ¥ 4 Music
5 o #® Mail Messages
6 z « System Preferences
7 Z W Contacts
8 W f Events & To Do Items
9 z = Images
10 z « PDF Documents
11 ¥ ¢4 Bookmarks
12 ) @ Movies
13 ¥ A Fonts
14 W § Presentations
[ Spotlight menu keyboard shortcut: 3 Space v
"I Spotlight window keyboard shortcut: 8 Space 20
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If you click the Privacy tab, you can prevent Spotlight from searching particular
locations. Drag folders or disks into the Privacy pane to let Spotlight know that
these are off-limits. Spotlight will remove any associated files from the index.

Find Me a Find

I've already told you how Spotlight is embedded in the very fabric of the
operating system. So it should come as no surprise that Spotlight hangs out
as well in Finder windows, the windows you use over and over to browse for
files and folders (press 38+N to open one).

That there’s a search box inside Finder isn’t novel to anyone who has spent
time with previous versions of OS X. But the similarity ends there. I love base-
ball analogies, so let me explain it this way. The previous Finder search box
was like a solid ballplayer who could hit, say, for a high average. But this
newest Finder search box is more like a five-tool player who not only hits for
average but can throw, run, field, and hit for power. In other words, he can
beat you in a number of ways.

So it goes with the newly powerful Finder search. It lets you tailor searches as
never before. To see it in action, open the search box by pressing 38 +F, or by
choosing File=>Find.

If you click the Privacy tab, you can prevent Spotlight from searching particular
locations. Drag folders or disks into the Privacy pane to let Spotlight know that
these are off-limits. Spotlight will remove any associated files from the index.

The moment you start typing a few characters in the search box, tabs show
up (see Figure 6-4). The top tabs — Servers, Computer, Home, Others —
dictate where you want to search. Note the Save button. I return to its purpose
in the next section, on Smart Folders.

Just below the tabs are customizable buttons that let you filter a search
according to specific parameters. You can add or delete these “criteria” but-
tons by pressing the + or — at the end of the row (refer to Figure 6-4). Pressing
the — button deletes the entire row.
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Figure 6-4:
The
powerful
Finder
search box
lets you
narrow
searches by
specific
criteria.
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Among your choices:

v~ Kind: by Images, Text, PDF, Movies, Music, Documents, Presentations,
Folders, Applications, Others. Stick with the default Any if you want to
search for all these.

v Last Opened, Last Modified, or Created: Today, Since Yesterday, This
week, Last 2 weeks, This month, Exactly, Before, After, and so on.

1 Keywords or Contents: Enter the specific word.
v Size: Greater than, less than.

1+ Color Label: Choose one of the color dots.

Suppose you want to search for all the songs with the word Lost in the title
that you listened to within the last two weeks. You would tailor a search that
would include Kind, Music, and Last Opened, Within The Last 2 weeks.

Fans of the hit TV series Lost may feel a chill at the mere mention of the Others.
(For those who don’t watch the show, they’re the bad guys.) But you may wel-
come the Others when it comes to running the most specialized search queries
on your Mac. I'll explain. Under Kind, choose Other as your search criteria. A
dialog box lists filtered attributes you can use in your search, plus a description
of their purpose, as shown in Figure 6-5.
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Figure 6-5:
Choosing
other

search
attributes.
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Select a search attribute Ql
Name 4| Description
Last Opened Date when this item was last used
Layers Names of the layers in the file
Loop descriptors Keywords describing the mood and other aspects of th
Loop file type Whether the file is a looping or non-looping file. Loopi
Loop original key Shows the loop's original key. The key is the root note
Loop scale type Whether the loop uses the major or minor scale, neithe
Lyricist Lyricist of the song in the audio file I
Max aperture Smallest F number of the lens in APEX value units, usuz
Metering mode The metering mode (Unknown, Average, CenterWeighte
Mixed State Item Count Number of mixed-state items in the OmniOutliner doci
Musical genre Musical genre of the song in the audio file %
Name Name of the media file v
————————3 alr
__Add to Favorites Cancel 0K

For instance, you can choose a search attribute based on the authors of an
item, makers of a device, due date, duration in seconds, lyricist of a song,
musical key of a song, genre, pixel height of a document, year an item was
recorded, and dozens more attributes.

Before closing out of your Finder window, you may want to save your search
results. To do that, continue with the next section.

Smart Folders

When you go to all the trouble of selecting specific attributes for your search
query, you may want to revisit the search in the future — incorporating the
latest information, of course. And that’s why the Finder window has a handy
Save button.

Traditionally, the files on your computer are organized by their location on
your disk. Smart Folders change the organizing principle based on the search
criteria you've chosen. These folders don’t give a hoot where the actual files
that match your search criteria reside on the machine. Those stay put in
their original location. You are, in effect, working on aliases, or shortcuts, of
those files. (See the next chapter for more on aliases.)

What’s more, behind the scenes, Smart Folders are constantly on the prowl
for new items that match your search criteria. In other words, they’'re
updated in real time.

To create a Smart Folder, click that Save button from inside the Finder
window. (The Save button is shown in the upper right in Figure 6-4.) A box

91



92

Part ll: Mac Daily Dealings

|
Figure 6-6:
The Smart
Folder
window
looks like
this.
|
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pops up asking you to specify a name and destination for your newly created
Smart Folder, as shown in Figure 6-6. If you want, select the Add to Sidebar
option to easily find the Smart Folder you just created.

Specify a name and location for your Smart Folder
Save As: Lost
Where: Saved Searches

v| Add To Sidebar Cance Save

Alternatively, choose New Smart Folder under the Finder File menu to create
a new Smart Folder.

You may want to create a simple Smart Folder containing all the documents
you've worked on in the past seven days. Give it an original name. Oh, I
dunno, something like What a Hellish Week! In any case, all your recent stuff
is easily at your disposal. Your older documents will pass new arrivals on
their way out.

Fiddling with Dashboard Widgets

Apart from prowling the virtual corridors of cyberspace or interacting with
Apple’s iLife programs, most of your face time on a Mac will find you engaged
with some full-blown (and often pricey) software application — even if you
take advantage of a relatively narrow set of features.

The wordsmiths among you couldn’t subsist without Microsoft Word or some
other industrial-strength word processor. You graphics artists live and
breathe Adobe Photoshop. But personal computing isn’t always about doc-
toring photos or penning the great American novel (or Dummies book).
Sometimes all you want is a quick snippet of information.

Maybe you need to check the temperature or a stock quote. Or you want to
look up a phone number or figure out if your plane is on time. Perhaps you want
to locate an Italian restaurant for dinner or calculate a mortgage payment.

That’s what a gaggle of mini-applications known as widgets are all about.
Indeed, these lightweight programs generally serve a useful and singular pur-
pose: from letting you track an overnight package to finding out whether your
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Figure 6-7:
Widgets
star in the
Dashboard
collection.
|

favorite team covered the spread. Frankly, you can perform many of these
tasks through the Web or other programs on your desktop. But few do it with
the convenience and flair of widgets.

Fronted by large colorful icons, widgets come at you en masse when you
summon Dashboard. This translucent screen, shown in Figure 6-7, lays on top
of your desktop. Nothing underneath is disturbed.

You either click the Dashboard icon in the dock (labeled in Figure 6-7) or
press the F12 key to open the Dashboard. Pressing F12 again closes
Dashboard. You can exit also by clicking anywhere other than on a widget.

To get you started, Apple supplies a collection of basic widgets (calculator,
clock, calendar, weather). The more interesting widgets are available online.
(More than 2000 were available as of this writing.) You can embark on a
widget hunt at www.apple.com/downloads/dashboard.

Previously used widgets
|

S (A

SUN MON TUE WED THU FRI

& o & 4 8 4
78° 87° B7° 89° 87° 87°

Dashboard icon Dashboard

Click to open widgets bar
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Figure 6-8:
Widget-
mania at the
widgets bar.
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You either click the Dashboard icon in the dock (labeled in Figure 6-7) or
When you call up Dashboard, only the widgets you previously used appear
on the screen, right where you left them. The rest are cozying up to the wid-
gets bar, which you can open by clicking the + button (labeled in Figure 6-7). If
you want to enlist one of the widgets, just drag it onto the Dashboard area. It
will dazzle you with a ripple effect as it makes its grand entrance. Click the X
button (labeled in Figure 6-8) to close the widgets bar.

The great majority of downloadable widgets are gratis. A few are available as
shareware, meaning you can try them out before paying. Whether you actu-
ally fork over the loot is up to your conscience, but unless you think the pro-
gram is worthless, its creator should be rewarded for his or her efforts.

Some widgets are extensions to other programs on your computer, such as
the ones that display data from iCal or your Address Book or bring up blank
Stickies.

But most widgets grab feeds off the Internet, so you need an online connec-
tion (see Chapter 9). Widgets in this category might tell you what’s on the
tube tonight or deliver a surfing report (on waves, dude, not cyberspace.)

() " 5
New York =00

L 4pT—— ——
SAT SUN MON TUE WED THU

T e % e e e
70% 642 | .57 520 55° | 887

Click to close the widgets bar Widgets bar

Drag icons from the widgets bar to the Dashboard display
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Other widgets wizardry:

v 1If you hold down the Shift key while you press F12, the widgets will open
or close in super-slow-motion.

v~ If you hover over an open widget and press 8+R, the wizard twists like a
tornado and refreshes itself. Any “live” information will be updated.

v To rearrange widgets on the Dashboard area, just drag them around.

»* You can display more than one of the same widget, which is useful, say,
if you want to check out the weather or time in several locations. Just
drag the widget out again from its hiding place in the widgets bar.

In Chapter 21, I rattle off ten widget goodies.

® Before we skip out on this widgets seminar, let me mention one more in pass-
ing, a widget to manage all your other widgets.. The widget shown in Figure
6-9 contains a list of other widgets (People, Researcher, Ski Report, and so
on). By unchecking the names of the widgets in the list, you can disable them
and in some instances send them to the trash. If you click the More Widgets
button, you’ll be transported to Apple’s main Dashboard Widgets Web page,
where you can download other widgets.

Uncheck Widgets to disable them.

¥ _%. People

| € Rescarcher

Figure 6-9: |/ Ski Report
The widget | ¥ —
totame |
o Stock:
other | & swoe
widgets.
|

I?? iﬂ" Tile Game

4

Unleashing the Automator

Quick show of hands: How many of you have ever taken a class in computer
programming? (You think I can’t tell if you have your hand up? Well, I can.)
That’s what I figured, not many of you.
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Figure 6-10:
Automator is
program-
ming

without the
program-
ming.
|

Tiger includes a feature called Aufomator that lets you program repetitive
tasks — renaming a batch of files, say — without having to master program-
ming. This is Apple’s way of automating or simplifying a computer practice
known as scripts.

Automator is built around specific tasks, or actions (Open Images in Preview,
for example), dragged from an Action list to a workflow area on the right side
of the window, as shown in Figure 6-10.

When you’ve dragged all the actions into the workflow area, click the Run
button in the upper-right corner of the Automator window; each action is
performed in a natural order with the results of one task flowing into the next
one. Thus, various tasks must be performed in sequence and make sense
working together.

To open Automator, open Finder, click Applications, and then double-click
Automator.

" Automator File
006
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A single action can constitute a workflow. To take a rudimentary example, you
can automate the process of removing empty playlists in iTunes by dragging
that action into the workflow space and clicking Run. A Workflow Execution
Completed message at the bottom-right corner of Automator signifies that the
job is finished. (For more on playlists and iTunes, read Chapter 14.)

Often multiple tasks make up a workflow. In the simple workflow shown in
Figure 6-11, the computer will search the address book for people having a
birthday this month, and send an e-mail greeting (with picture) to those folks.
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You can save and reuse workflows by pressing 8 +Shift+S.
A\

Third-party developers are creating workflow actions for their applications.
You can check some of these out at www.apple.com/downloads/macosx/
automator.

Automator is just one more reason to feel good about the Tiger in your tank.
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Chapter 7

Handling All That Busy Work

In This Chapter

Preparing your documents

Selecting text

Dragging, dropping, cutting, and pasting
Revealing fonts

Formatting documents

Saving your work

Making revisions

Taking out the trash

Understanding aliens

In professional football, the skill position players — quarterback, running
backs, and wide receivers — get a disproportionate amount of the glory
when a team wins and assume most of the blame when they fall on their col-
lective fannies. But any halfway-competent field general will tell you that
those in the trenches typically determine the outcome.

Sure you want to draw up a razzamatazz game plan for your Mac. Probably
something involving stupendous graphics and spine-tingling special effects. A
high-tech flea-flicker, to keep it in the gridiron vernacular.

There he goes again: using a sports analogy.

After all, you bought the computer with the intention of becoming the next
Mozart, Picasso, or at the very least Steve Jobs. (What, you expected Joe
Montana or Lawrence Taylor?)

I'm not here to dash anybody’s dreams. But for this one itty-bitty chapter, I
am asking you to keep your expectations in check. You have to make first
downs before you make touchdowns. Forget heaving Hail Mary’s down the
field. You're better off grinding out yardage the tough way.
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In coach-speak, the mission of the moment is to master the computing equiv-
alent of blocking and tackling: basic word processing and the other funda-
mentals required to get you through training camp and ultimately your daily
routine.

Practice these now. You can pour the Gatorade on my head later.

Form and Function: The Essentials
of Word Processing

MBER
\‘8‘
&

I'm old enough to recall life before word processors. (Hey it wasn’t that long
ago.)

[ can’t possibly begin to fathom how we survived in the days before every
last one of us had access to word processors and computers on our
respective desks.

Pardon the interruption, but I'm not thrilled with the preceding sentence.
Kind of wordy and repetitious. Permit me to get right to the point.

I can’t imagine how any of us got along without word processors.
Thanks, much more concise.

The purpose of this mini-editing exercise is to illustrate the splendor of word
processing. Had I produced these sentences on a typewriter instead of a com-
puter, changing even a few words would hardly seem worth it. [ would have
to use correction fluid to erase my previous comments and type over them. If
things got really messy, or I wanted to take my writing in a different direction,
I'd end up yanking the sheet of paper from the typewriter in disgust and
begin pecking away anew on a blank page.

Word processing lets you substitute words at will, move entire blocks of text
around with panache, and apply different fonts and typefaces to the charac-
ters. You won’t even take a productivity hit swapping typewriter ribbons in
the middle of a project (though, as the next chapter reveals, you will at some
point have to replace the ink in your printer).

Before running out to buy Microsoft Word (or another industrial strength and
expensive) word processing program for your Mac — and I'm not suggesting
you don’t — it’s my obligation to point out that Apple includes a respectable
word processor with OS X. The program is TextEdit, and it calls the Applications
folder home. TextEdit will be our classroom for much of this chapter.
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Creating a Document

MBER
‘x&
&

|
Figure 7-1:
In the
beginning
was a blank
page.
|

The first order of business using TextEdit (or pretty much any word proces-
sor) is to create a new document. There’s really not much to it. It’s about as
easy as opening the program itself. The moment you do so, a window with a
large blank area on which to type appears, as Figure 7-1 shows.

Untitled

Styles v | =|=|= = | Spacing »] [ Lists - Fe 40

id 3 3 b 3 3 2 3 2 3 2 | 2 |38 3
T 3 T T i i T % T IE T

Have a look around the window. At top you see Untfitled because no one at
Apple is presumptuous enough to come up with a name for your yet-to-be-
produced manuscript. We’ll get around to naming (and saving) your stuff
later. In my experience it helps to write first and add a title later, though, um,
scholars may disagree.

Notice the blinking vertical line at the upper-left edge of the screen, just
below the ruler. That line, called the insertion point, might as well be tapping
out Morse code for “start typing here.”

Indeed, friends, you have come to the most challenging point in the entire
word processing experience, and believe me it has nothing to do with tech-
nology. The burden is on you to produce clever, witty, and inventive prose,
lest all that blank space go to waste.

Okay, got it? At the blinking insertion point, type with abandon. Something
original like
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|
Figure 7-2:
Oops, |
made a
mistake.
|

It was a dark and stormy night
If you type like I do, you may have accidentally produced
It was a drk and stormy nihgt

Fortunately, your amiable word processor has your best interests at heart.
See the dotted red line below drk and nihgt (see Figure 7-2)? That’s TextEdit’s
not-so-subtle way of flagging a likely typo. (This presumes you’ve left the
default Check Spelling As You Type activated in TextEdit Preferences. Since
we're at the beginning of this exercise, that seems a safe presumption.)

Untitled
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You can address these snafus in several ways. You can use the computer’s
Delete key to wipe out all the letters to the left of the insertion point. (Delete
functions like the backspace key on the Smith Corona you put out to pasture
years ago.) After the misspelled word has been quietly sent to Siberia, you
can type over the space more carefully. All traces of your sloppiness disappear.

Delete is a wonderfully handy key. I'd recommend using it to eliminate a
single word such as nihgt. But in our little case study, we have to repair drk
too. And using Delete to erase drk means sacrificing and and stormy as well.
Kind of overkill if you ask me.
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Back to football. It’s time to call an audible. Two quick options:

v Use the left-facing arrow key (found on the lower-right side of the key-
board) to move the insertion point to the spot just to the right of the
word you want to deep-six. No characters are eliminated when you move
the insertion point that way. Only when the insertion point is where it
ought to be do you again hire your reliable keyboard hit-man, Delete.

v Eschew the keyboard and click with the mouse to reach this same spot
to the right of the misspelled word. Then press Delete.

Now try this helpful remedy. Right-click anywhere on the misspelled word. A
list appears with suggestions, as shown in Figure 7-3. Single-click the correct
word and, voila, it instantly replaces the mistake. Be careful in this example
not to choose dork.

A\
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Selecting Text in a Document

a\\J

a\

Let’s try another experiment. Double-click a word. See what happens. It’s as if
you ran a light-blue marker across the word. You've highlighted, or selected,
this word so that it can be deleted, moved, or changed.

Many times, you’ll want to select more than a single word. Perhaps a com-
plete sentence. Or a paragraph. Or several paragraphs. Here’s how to high-
light a block of text to delete it:

1. Using the mouse, point to the block in question.

2. Press and hold down the left mouse button and drag the cursor
(which bears a slight resemblance to the Seattle Space Needle) across
the entire section you want to highlight.

The direction in which you drag the mouse affects what gets highlighted.
If you drag horizontally, a single line is selected. Dragging vertically
selects an entire block. You can highlight text also by holding down Shift
and using the arrow keys.

3. Release the mouse button when you reach the end of the passage you
want highlighted, as shown with Once upon a time in Figure 7-4.

4. To immediately wipe out the selected text, press Delete.

Alternatively, start typing. Your old material is exorcised upon your very
first keystroke and filled in with the new characters you type.

To select several pages of text at once, single-click at the beginning portion of
the material you want to select, and then scroll to the very bottom. While
holding down the Shift key, click again. Everything in between clicks is high-
lighted.

Now suppose you were overzealous and selected too much text. Or maybe
you released the mouse a bit too soon so that not enough of the passage you
have in mind was highlighted. Just click once with your mouse to de-select
the selected area and try again.

Another screw-up. This time you annihilated text that upon further review
you want to keep. Fortunately, the Mac lets you perform a do-over. Choose
Edit=>Undo Typing. The text is miraculously revived. Variations of this lifesav-
ing Undo command can be found in most of the Mac programs you
encounter. So before losing sleep over some silly thing you did on the com-
puter, visit the Edit menu and check out your Undo options.
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Figure 7-4:
Highlighting
text.
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Dragging and Dropping

In Chapter 3 I discuss dragging and dropping to move icons to the dock. In this
chapter, we drag an entire block of text to a new location and leave it there.

Select a passage in one of the ways mentioned in the preceding section. Now,
anywhere on the highlighted area, click and hold down the mouse button.
Roll the mouse across a flat surface to drag the text to its new destination.
Release the mouse button to drop off the text.

You are not restricted to dragging and dropping text in the program you're in.
You can lift text completely out of TextEdit and into Word, Stickies, or Pages,
an Apple program for producing spiffy-looking newsletters and brochures.

Alternatively, if you know you’ll want to use a text block in another program
at some point in the future — you just don’t know when — drop it directly
onto the Mac desktop (see Figure 7-5) and call upon it whenever necessary.
Text copied to the desktop will be shown as an icon and named from text in
the beginning of the selection you copied. Moving text in this manner to an
external program or the desktop constitutes a Copy command, not a Move
command, so the lifted text remains in the original source.
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|
Figure 7-5:
Dropping
text on the
desktop.
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Cutting and Pasting

\NG/
g“‘“

In the preceding section, we copied material from one location and moved a
copy to another location. By contrast, cutting and pasting lifts material from
one spot and moves it elsewhere without leaving anything behind. (In the
typewriter era, you literally cut out passages of paper with scissors and
pasted them onto new documents.)

After selecting your source material, choose Edit=>Cut (or the keyboard alter-
native 8+X). To paste to a new location, navigate to the spot and choose
Editc>Paste (or 8+V).

The Cut command is easily confused with Copy (88+C). As the name suggests,
the latter copies selected text that can be pasted somewhere else. Cut clips
text out of its original spot.

The very last thing you copied or cut is temporary sheltered on the clip-
board. It remains there until replaced by newer material you copy or cut.
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If you can’t remember what was last on the clipboard, choose Edite> Show
Clipboard when Finder (the dock icon to the furthest left) is activated.

Changing the Font

When typewriters were in vogue, you were pretty much limited to the type-
face of the machine. Computers being computers, you can alter the appear-
ance of individual characters and complete words effortlessly. Let’s start with
something simple.

In the TextEdit window, click the pop-up menu Styles (see Figure 7-6) and
choose Italic. Highlighted text becomes fext. Now try Bold. Highlighted text
becomes text.
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\P
) [ recommend using keyboard shortcuts in this instance. Just before typing a

word, try 38+ for italics or 8+B for bold. When you want to revert to normal
type, just press those respective keyboard combinations again.
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|
Figure 7-7:
Afonts
funhouse.
|
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Making words bold or italic is the tip of the proverbial iceberg. You can dress
up documents with different fonts, or typefaces.

Open the Format menu and choose Font=>Show Fonts. The window in Figure
7-7 appears. You can change the typeface of any highlighted text by clicking a
font listed in the pane labeled Family. Choices carry names like Arial, Baghdad,
Chalkboard, Courier, Desdemona, Helvetica, Papyrus, Stencil, and Times

New Roman.

@ TextEdit File Edit Format Window Help 2 4)) % Sun12:15PM edwardbaig &
. - W N v ~
ene Untitled ’” :V
Sk TS =T e - saaet il Vi
?ﬂ ) T G qpce |mars_poster
= TH[=H[TH [ B s s e () 315 {ibe. B
Collections Family Typeface Size -
AllFots ) [ Desdemona ~ 'Regular B :z { |
Favorites Devanagari MT Obligue 5 T |
Recently Used Didot Bold i
Classic Edwardian Script ITC Bojd Obligue 11 )
Comlatife Engravers MT 12
Fixed Width Euphemia UCAS 13
e Eurastile i E
Modern Fang Song 18 =
New-0 Footlight MT Light 24 | m—
FoE Futura 36 {iste. squat
Wieh Garamond 48
GB18030 Bitmap 64 =
Geeza Pro 72
Geneva 96 E
Geneva CY 144
Georgia 288 JGRILOTTAU T
Gill Sans
Gill Sans Uitra Bold
— Gloucester MT Extra Condensed B
Goudy Old Style L=
Gujarati MT —
ke Gulim [earcnanty
| Gurmukhi MT
Hacuenschweller .
Handwriting - Dakota =
Harrington
Hei ) o
ke Helvetica v 288 (KiiEl)
+ |- [a-] Search |
LELOLLITONOON VBERLFQ «F RS ADPICE #

Unless you wrote your graduate thesis on Fontomology (don’t bother looking
the word up; it’s my invention), nobody on the Dummies faculty expects you
to have a clue about what any of the aforementioned fonts look like. [ sure
don’t. Cheating is okay. Peek at your document to see how highlighted words
in the text change after clicking different font choices.

As usual, another way is available. In the lower-left corner of the Font
window, click the icon that looks like the sun. Choose Show Preview from the
menu (see Figure 7-8). You'll be able to inspect various font families and type-
faces in the preview pane that appears above your selection. Click the sun
icon again to choose Hide Preview.
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Previewing your font

@ TextEdit File Edit Format Window Help Z 4) ¢ Sun12:20PM edwardbaig &)
L N L X - ~
e0e Untitled @ @
Styles B e = T ) (i B (i Traneel 40 5
LYo 0 e [ JPEG
TE,_,_,_F |mars_poster
Foass Hpg il
Helvetica -
TEEHE[T &) e P B 8) D252 fititrea]
Collections Family Typeface Size
All Fomts T Regular 12 &
Favorites Devanagari MT Oblique ‘B
Recently Used b Bold S |
Classic Edwardian Script ITC Eald Obligue 11 e g
Comic Life Engravers MT i )
Fixed Width Euphemia UCAS 13
Fun Eurostile 14
Modern Fang Song m 1 =
New-0 Footlight MT Light 24 | =
PDF Futura 36 ITrOTt )
web Garamond 8 [
GB18030 Bitmap 64
Geeza Pro 72
\ Geneva £ =
Add to Favorites -
: Geneva CY 144
Hide Preview : =
Hide Effects earg (S gy
'“E“-I Gill Sans IR
Color... Gill sans Ultra Bold
Characters... Gloucester MT Extra Condensed -
Typography... Goudy Old Style
Edit Sizes... Gularati MT ()
- ) Gulim = L
Figure 7-8: litae | vanagerons.. | S 1 T hocn
. i - REdIUILUS
+ | - | — Search
Previewing -
your fonts. Py ] : o o ey s
- 5 g . & B = k-4 ] & E
: \ (50 ) ¢ A W | : 2 v
LEELHLNWeO. vRERBLFQ T D¢ ROPICE ¥

Click to hide or show font preview

You can also preview the type size of your chosen font, as measured by a
standard unit called points. In general, one inch has 72 points. You can also
type your own words to see how they would look in a given font.

Revealing the Font Book

You likely have well over a hundred fonts on your computer, if not a lot more.
Some were supplied with TextEdit. Some arrived with other word processing
programs. You may have even gone on a font hunt and added more yourself
on the Internet. At the end of the day, you may need help managing and orga-
nizing them.

That’s the purpose behind an OS X program called Font Book, found in the
Applications folder. It’s shown in Figure 7-9. Think of Font Book as a gallery to
show off all your finest fonts. Indeed, fonts here are grouped in collections.
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Font Book.
|
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The main font groupings are listed as following:

v User: The private fonts unique to your user account (Chapter 5).

v+ Computer: The public fonts available to anyone who uses this machine.

v Classic: Fonts that work with applications in the ancient pre-OS X
Classic mode. Despite their prehistoric pedigree, nothing in the rule
book prevents you from employing these with Tiger.

You can create your own font collections by choosing Filec>New Collection
and typing a name for the collection. Then just drag fonts from the Fonts

column into your new collection.
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All in the fonts

Admit it, you're curious about the genealogy and the Font Book window reveals all, including
behind the font named Zapf Dingbats. Me too.  the full name of a font, the languages in which it
For that matter, you may be wondering aboutthe is used, and any copyright and trademark infor-
roots of other fonts on the system. Hey, it's your  mation. Best | can tell, Zapf Dingbats was not
computer, you have a right to know. Press 88+l  created by Archie Bunker.

By clicking a name in the Font column, you can sample what your font of
choice looks like in the pane on the right. Drag the slider (labeled in Figure 7-9)
to the right of that pane to adjust the type size of the fonts you're sampling.

P If you're like most mortals, you’ll use a small set of fonts in your lifetime. I'll
lay odds you’ll never take advantage of such esoteric fonts as Ayuthaya or
Zapf Dingbats (see the “All in the fonts” sidebar). Trust me, | am not making
these names up.

You can disable the fonts you’ll rarely if ever use by clicking the little box
with the check mark under the Font list (Iabeled in Figure 7-9). The word Off
appears next the font’s newly grayed-out name. If you change your mind,
choose Edit=>Enable font you disabled.

If, on the other hand, you want to add fonts to the machine, click the + button
under the same column and browse to the font’s location on your machine.
But you can also install new fonts you’ve downloaded or purchased by
simply double-clicking them. The fonts are automatically imported into Font
Book.
< When a dot appears next to a name in the Font list, duplicates of that font
family are installed. Select the font in question and choose Edit=>Resolve
Duplicates.

Formatting Your Document

Fancy fonts aren’t the only way to doll up a document. You have important
decisions to make about proper margins, paragraph indentations, and text
tabs. And you must determine whether lines of text should be single or
double-spaced. Hey it’s still a lot easier than using a typewriter.
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|
Figure 7-10:
When it has
to look just
like this.
|

Okay, we’re back in our TextEdit classroom. Set your margins and tab stops
by dragging the tiny triangles along the ruler.

Now click the drop-down menu that says Spacing, just above the ruler.
Clicking Single separates the lines in the way you are reading them in this
paragraph.

If I go with Double, the line jumps down to here, and the next line
jumps down to here.
Got it?

The control freaks among you (you know who you are) might want to click
Other under the Spacing menu. It displays the dialog box shown in Figure
7-10. Now you can precisely determine the height of your line, the way the
paragraphs are spaced (that is, the distance from the bottom of a paragraph
to the top of the first line in the paragraph below), and other parameters,
according to the points system.

Line height multiple 1.0 times

:: Exactly
Line height (2 At least

1 At most 0.0 . points

points

Inter-line spacing 0.0 points

before 0.0 points

Paragraph spacing

after 0.0

(arl (4v (19

points

(" cancel \ ok )

Here are other tricks that make TextEdit a capable writing companion:

v~ Aligning paragraphs: After clicking anywhere in a paragraph, choose
Formatm>Text and choose an alignment (left, center, justified, or right).
Play around with these choices to determine what looks best.

1 Writing from right to left: [ suppose this one’s useful for writing in
Hebrew or Arabic. Choose Format= Text=>Writing Direction and then
click Right to Left. Click again to go back the other way, or choose
Edit=>Undo Set Writing Direction.

1 Locating text: You can use the Find command under the Edit menu to
uncover multiple occurrences of specific words and phrases and replace
them individually or collectively.
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v Producing lists: Sometimes the best way to get your message across is
in list form. Kind of like what I'm doing here. By clicking the Lists drop-
down menu, you can present a list with bullets, numbers, roman numer-
als, uppercase or lowercase letters, and more, as shown in Figure 7-11.
Keep clicking the choices until you find the one that makes the most
sense.

v Creating tables: Then again, you may want to emphasize important
points using a table or chart. Choose Format=>Text=>Table. In the
window that appears (see Figure 7-12), you can select the number of
rows and columns you need for your table. You can select a color back-
ground for each cell by clicking the Cell Background drop-down list and
choosing Color Fill, and then choosing a hue from the palette that
appears when you click the rectangle to the right. You can drag the bor-
ders of a row or a column to alter its dimensions. You can also merge or
split table cells by selecting the appropriate cells and then clicking the
Merge Cells or Split Cells button.

i @ TextEdit File Edit Format Window Help 2 4) % Sun1:41PM edwardbaig &)
eoe Untitled 2
Styles = Spacing =] | Lists =] Pedo

S S
lo 17
A, Bashful
B. Doc i
C. Dopey :
D. Grumpy {8
E a

[

| 2 » None t | 3 2
[} i | E s 7 Tg Te Tio T T2 T3

Figure 7-11:
Formatting
a list.

— | EEPOZLING [ OBERVLIQA Y By AOVPECC® ~ i




’ ’4 Part lI: Mac Daily Dealings

Figure 7-12:
Creating a
table.
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Saving Your Work

You’ve worked so darn hard making your document read well and look nice
that I'd hate to see all your efforts go to waste. And yet in the cruel world of
computers that’s precisely what could happen if you don’t take a second to
save your file. And a second is all it takes to save a file — but you can lose
everything just as fast.

Stable as it is, the Mac is a machine for goodness sakes and not immune to
power failures or human foibles. Odd as it may seem, even tech authors
pound a calamitous combination of keys from time to time.

All the work you've done so far exists in an ethereal kind of way, as part of tem-
porary memory (see Chapter 2). Don't let the fact that you can see something
on your computer monitor fool you. If you shut down your computer, or it
unexpectedly crashes (it’s been known to happen even on Macs), any unsaved
material will reside nowhere but in another type of memory. Your own.

So where exactly do you save your work? Why on the Save sheet of course
(see Figure 7-13). It slides into view from the top of your document when you
press the keyboard combo 38+S, or choose Filem>Save.

Remember way back in the beginning of this chapter when I mentioned that
Apple wouldn’t dare name a file for you (except to give it the temporary
moniker Untitled). Well this is your big chance to call the file something spe-
cial by filling in a title where it says Save As. Go ahead and name it, I dunno,
Dark and Stormy.
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When you click the Save button, the contents of Dark and Stormy are
assigned to a permanent home on your Mac’s hard drive, at least until you're
ready to work on the document again.

But there’s more. You get to choose in which folder to stash the file. The Mac
suggests the Documents folder, which seems like and often is a logical choice.
But you can choose among several other possible destinations, as becomes
clear when you click the arrow next to where you just named your document.
You will see the sidebar we first became acquainted with in Chapter 3. You
can stuff your manuscript in any existing folder or subfolder or create one
from scratch by clicking the New Folder button and giving the folder a name.

It’s time to confess. I've been holding back. When you christened your opus
Dark and Stormy little did you know that you were actually giving it a slightly
longer name: Dark and Stormy.rtf. The little suffix, or extension, stands for
Rich Text Format, one of the file format types the Mac makes nice with. You
could have saved the file in the Microsoft Word format, which would have
given the file the .doc extension. Or you could have chosen HTML, the lan-
guage of the World Wide Web (see Chapter 9). If you want to see what exten-
sions are tagged to your various files, deselect the Hide Extension check box.

< So let’s review: As you work on documents, you are hereby advised to save
and save often.
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Making Revisions
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Dark and Stormy is safe and sound on your hard drive. But after downing a
few chill pills overnight, you have a brand-new outlook on life in the morning.
You’re past your brooding period. You want to rework your inspiration’s cen-
tral theme and give it a new name too, Bright and Sunny.

Back to TextEdit we go.

Choose File=>Open. A dialog box appears. Scroll down in the folder where you
last saved your document, and double-click its name or icon when you find it.

You are now ready to apply your changes. Because your document is only as
permanent as the last time you saved it, remember to save it early and often,
as you make revisions. Along the way, you can rename your bestseller by
using Save As and choosing a new name, though you’ll still have a version
under the old name.

You may be better off renaming a file by selecting it (from a Finder window or
the desktop) and pressing Enter. Type the new name and press Enter again.

As always, your Mac tries to assist you in these matters. The computer
makes the assumption that if you worked on a document yesterday or the
day before, you might want to take another stab at it today. And to prevent
you, Oh Prolific One, from having to strain too hard digging for a document
you may want to edit, choose File>Open Recent. Your freshest files will turn
up in the list. Just click the name of the document you want to revisit.

Perhaps the fastest way to find a file you want to revise is to use the Spotlight
tool, featured in the Chapter 6. Choose Spotlight by single-clicking its icon at
the upper-right corner of the screen and type the name of the manuscript
that requires your attention.

Taking Out the Trash

Like much else in life, documents, if not entire folders, inevitably outlive their
usefulness. The material grows stale. It takes on a virtual stench. It claims
hard drive space you could put to good use elsewhere.

Yes it’s time to take out the trash.
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|
Figure 7-14:
Think before
trashing.
|

Use the mouse to drag the document’s icon above the trash can in the dock.
Release the mouse button when the trash can turns black.

As usual, there’s a keyboard alternative, 88+Delete. Or you can choose Filew>
Move to Trash.

You’ll know you have stuff in the trash because the icon shows crumpled
paper. And just like your real life trash bin, you’ll want to completely empty it
from time to time. (Your neighbors might complain otherwise.)

To do so, choose Empty Trash under the Finder menu or press 8+Shift+Delete.
A warning will pop up (see Figure 7-14), reminding you that once your trash is
gone, it’s gone, as if it was going through a shredder. (Even then you may be
able to get it back, but you'll have to fork over some coin by purchasing data
recovery software or hiring an expert.)

Are you sure you want to remove the items in the
Trash permanently?

[
‘"_'II;" You cannot undo this action

Never Mind: Retrieving
What You've Tossed

\\3

It’s pretty easy to pull something out of the trash, provided you didn’t take
that last Draconian measure and select Empty Trash. And it’s less smelly or
embarrassing than sticking your hands in a real trash bin. Click the Trash
icon in the dock to peek at its contents. If you find something worth saving
after all, merely drag it back onto the desktop or into the folder where it used
to hang out.

If you're absolutely, positively certain that you want to get rid of the contents
of your trash — and paranoid about industrial spies recovering the docs,
choose Secure Empty Trash from the Finder menu instead of the regular
Empty Trash command.
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Making an Alias
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|
Figure 7-15:
The original
icon and

its alias.
|

You can create an alias of a file to serve as a shortcut for finding it, no matter
where it’s buried on your Mac. To understand what an alias is, it helps to
understand what it’s not. It’s not a full duplicate of a file. (If you want to
create a full duplicate, press 38+D or choose FilemwDuplicate.)

Instead, you are effectively copying the file’s icon, not the file itself, meaning
you are barely using any disk space. Clicking an alias icon summons the origi-
nal file no matter where it’s hanging out on the computer and even if you've
renamed the file.

Why create an alien in the first place? Perhaps you're not sure where to place a
file that you could easily justify putting in any number of folders. For instance,
if you have a document titled Seven Dwarfs, it might belong in a folder for Snow
White, one for Bashful, one for Doc, and so on. Because the Mac lets you create
multiple aliases, you can effectively place the file in each of those folders (even
though you and I know it really resides in only one place.)

To create an alias, highlight the original icon and press 8+L or choose File>
Make Alias. You can also drag an icon out of its file window at the same time
you hold down the Option and 38 keys.

As you can see in Figure 7-15, the alias looks like a clone of the original icon,
except the alias suffix is added to its name, and a tiny arrow appears on the
lower-left corner of the icon. Clicking either brings up the same file.

If you want to find the location of the original file, highlight the alias icon and
choose Filec>Show Original.

® e

(Bl ) Sieniiny Dark and Stormy
alias

To get rid of an alias, drag it to the trash. Doing so does not delete the original
file.

If you had separately deleted the original file, the alias can’t bring it back. But
you can link the alias to a new file on the machine.
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In This Chapter

Selecting a printer
Hooking up a printer
Printing

Troubleshooting

Using the Mac as a scanner

Using the Mac as a fax machine

C omputers are supposed to bring relief to packrats. The idea that you can
store documents and files in their electronic state on your hard drive —
thus reducing physical clutter — has widespread appeal. A few trees might
breathe a sigh of relief too.

Yet for all the buzz over the years surrounding the potential for a “paperless”
society, I don’t reckon pulp industry executives are losing much sleep.

Fact is, you want to pick up something tangible for your own edification and
convenience. And you want hard copies to show people. It’s better to hand
grandma printed pictures of the newborn rather than pull out a computer (or
other gizmo) to show off your latest bundle of joy. What’s more, even in the
age of e-mail and electronic filings, you still usually print documents and
reports for employers, teachers, financial institutions, and (sigh) the Internal
Revenue Service.

Which reminds me: Despite wonderful advances in state-of-the-art printers,
the counterfeiters among you will find no helpful hints in this chapter about
printing money.
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Choosing a Printer
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What are those state-of-the-art printers? So kind of you to ask. Today’s print-
ers generally fall into two main camps: inkjet or laser, with the differences
coming down to how ink makes its way onto a page. Printers vary by speed,
features, resolution (sharpness), quality of the output, and price.

The most popular models are produced by Canon, Epson, and Hewlett-Packard,
but you can buy printers of one type or another from a host of competitors.

Believe it or not, you can still find an el-cheapo hand-me-down daisy-wheel or
dot-matrix printer on eBay and elsewhere. But these so-called impact printers
are most definitely not the state-of-the-art [ have in mind. Keep them a safe
distance removed from your very modern Mac. Purchasing a daisy-wheel for
a Mac would be along the lines of adorning the Queen of England with cos-
tume jewelry. Not to mention the royal pain you’d have trying to hook up
these relics.

In this section, we take a closer look at your most realistic printing options.

Inkjets

Inkjet printers consist of nozzles that squirt droplets of ink onto a blank
sheet of paper. Models may be equipped with a single black cartridge and a
single color cartridge. Or they may contain several color cartridges.

Where’s that magenta cartridge when I need it?

Most of you, I suspect, will end up with an inkjet printer. They are the least
expensive to buy, with some rock-bottom models costing as little as $40.

Bargains aren’t always what they seem, however. The cost of ownership of
inkjet printers can be exorbitant. You must replace pricey ($30 or so) ink car-
tridges on a routine basis, more often if you spit out lots of photographs of
your pet kitten Fluffy. So an inkjet printer’s cost-per-page tends to be consid-
erably higher than that of its laser cousins.

Having said that, inkjets are generally the most flexible bet for consumers,
especially if you demonstrate shutterbug tendencies. Besides standard size
8%-by-11-inch paper, some inkjet models can produce fine looking 4-by-6-inch
color snapshots on glossy photographic paper. (Photo paper, I'm obligated to
point out, is expensive.)

Granted, black text produced on an inkjet won’t look nearly as crisp as the
text produced by a laser, though it can be quite decent just the same. Under
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certain conditions, some inks bleed or smudge. But for the most part, the
quality of inkjets is perfectly acceptable for producing, say, family newslet-
ters or brochures for your burgeoning catering business.

Lasers

It’s somewhat remarkable that a focused laser beam can produce such excel-
lent quality graphics. Then again, if lasers can correct nearsightedness and
perform other medical miracles, perhaps printing isn’t such a major deal
after all.

Laser printers use a combination of heat, ink, and static electricity to pro-
duce superb images on paper. Such printers, especially color models, used to
fetch thousands of dollars. To be sure, you'll still find prices for some models
in the stratosphere. But entry-level color lasers are now south of $500.

However affordable they have become in recent years, lasers still command a
premium over inkjets. But they are far more economical over the long term.
Toner cartridges are relatively cheap and don’t need to be replaced very
often. A highly efficient laser might cost a couple of cents per page to oper-
ate, a small fraction of what an inkjet costs to run.

Lasers remain a staple in corporate offices. Businesses appreciate the photo-
copier-like output and the fact that lasers can handle high-volume printing
loads at blistering speeds. The machines typically offer more paper handling
options as well.

All-in-ones

Printers print, of course. But if your Mac is the centerpiece of a home office,
you probably have other chores in mind. Copying and scanning, for instance.
And faxing too. (Although as you discover later in this chapter, Macs with
built-in modems can fax without a separate fax machine.) An all-in-one model,
otherwise known as a multifunction printer, can provide some combination of
these tasks. Most multifunction workhorses in home offices are inkjet based.

It’s cheaper to buy a single multifunction device than several standalone
devices. That lone machine takes up less space too. And many current all-in-
ones are photo friendly.

If your fax, copier, or scanner goes on the fritz, you may also have to live
without a printer while the multifunction unit is under repair.
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What else to think about

Other features to consider when shopping for a printer follow:

1 Large paper trays: Few things are more annoying than having to load a
fresh stack of paper in the middle of an important printing job. With a fat
paper tray, you won’t be hassled quite as often. And some models have
separate trays for photo paper, so you won’t have to constantly shuffle
different types of paper in and out depending on what you’re printing.

* Memory slots: Maybe I shouldn’t mention this feature in a Mac book.
Because frankly, their purpose is to take the Mac out of the equation.
Indeed, you can print images stored on a memory card without getting a
computer involved.

v LCD display: You use this for peeking at the pictures you want to print
(see preceding item) without the benefit of a computer. You can use the
display also for various menu functions on the machine.

1 Two-sided printing: This is useful (you guessed it) for printing on both
sides of a sheet of paper.

1 Networking capabilities: For sharing your printer among multiple Macs
or Windows PCs or both. Wireless network printers cost more. I'll speak
more of networking in Chapter 18.

Connecting and Activating a Printer

\NG/
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Almost all printers compatible with OS X, and that includes most printers
sold today, connect to your Mac through the Universal Serial Bus (USB) port
we became acquainted with in Chapter 2. So much for un-retiring the printer
in the closet that connects through what’s called a parallel port.

Here’s one of my pet peeves. You shell out all this loot for a dandy printer
only to have the salesperson tell you it doesn’t come with the USB cable you
need to connect it. In fact, that’s the norm. Manufacturers are notoriously
chintzy when it comes to supplying this necessary accessory. They’ll tell you
they don’t include such a cable because people already have them. I'm not
buying it. My feeling is that it’s the company’s way of advertising a lower
price for a printer, while ultimately making a generous markup.

Indeed, you'll almost certainly leave the store considerably poorer than you
would have first imagined. Gotta buy stacks of paper. Plus extra ink because

the starter cartridges included with your printer may not last very long. And
the aforementioned USB cable.
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Ready, Set, Print

|
Figure 8-1:
Fit to print?
|

You have ink. You have paper. You have a USB cable. You are antsy. Time’s a
wasting. [ sense a certain impatience. So let’s get around to the task at hand.

Plug the printer into an AC wall jack. Plug the USB cable into the USB port on
the Mac and make sure it’s connected snugly to the printer itself. Turn on
your printer. The thing is warmed and ready for action. Tiger big-heartedly
assembled most of the software drivers required to communicate with
modern printers. Chances are yours is one of them. If not, it probably resides
on the software that came with the printer. Or visit the company’s Web site.

Configuring wireless or wired (through Ethernet) networked printers is a tad
more complicated. For now, we’ll assume we’ve connected a USB printer.
Open the Mac’s trusted word processor, TextEdit. Then follow these steps:

1. Open the document you want to print.

2. Choose File=Print, or use the keyboard shortcut 3+P.

Even though we’re doing this exercise in TextEdit, you'll find the Print
command under the File menu across your Mac software library. The
38 +P shortcut works across the board too. The print window shown in
Figure 8-1 appears.

3. Click the Printer drop-down list and select your printer, if available.

Printer: "ﬁ-h_o.t-csmartmﬁab s-e_ri.e_s m
Presets: | Standard m

["Copies & Pages

Copies: 1 @Ccllated
Pages: @ All
“)From: 1 to: 1
l.\';.\ ( PDF¥ ) (_ Preview ) [4 Supplies.. ) (_ Cancel ) @

4. If your connected USB printer is not in the print window:
a. Click Add Printer in the drop-down list.

The Printer Setup Utility opens. You can access the utility also
from the Utilities folder inside the Applications folder.
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|
Figure 8-2:
Adding a
printer.
|

b.

If your printer appears in the list, click to select it (if it’s not
already selected) and you’re golden. Continue with Step 5.

. If your printer isn’t listed, choose Add from the Printer List.

A Printer Browser sheet appears.

. Click the printer connection type at the top and make the appro-

priate selection, as shown in Figure 8-2.

In that connection type box, choices likely include USB, AppleTalk
(signifying a network), Bluetooth (a type of wireless connection),
and so on. When you make your choice, the Mac will search for
any available printers and their drivers.

. Highlight the printer you want to use and then click Add.

0ee

D

T oName EPSON FireWire I

Printer Model: = Generic

AppleTalk =}
Bluetooth
| ¥ Windows Printing

| Canon |) Network
EPSON AppleTalk |3

EPSON TCP/IP
EPSON USB
Lexmark Inkjet Networking

[ Cancel ) Add

Location:

Print Using:

()

Please select a driver or printer mode!

( More Printers... | Add

5. Make your selections in the print window.

Select which pages to print (All is the default, but you can give any range
by tabbing from one From box to the other.) You also get to select the
number of copies you need. You can check a box to indicate whether
you want pages collated. And you can choose whether to save your doc-
ument in the Adobe PDF format.

Note

that print dialog boxes differ slightly from program to program. In

Microsoft Word, for instance, you can get a quick preview of the docu-

ment

you want to print.
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|
Figure 8-3:
Choosing a
print layout.
|

6. When you're satisfied with your selections, click Print.

If all goes according to plan, your printer will oblige.

Even if the Mac instantly recognizes your printer, | recommend loading any
Mac installation discs that came with the printer. | specify Mac installation
disc because printers that work with both Macs and Windows — and again
that includes most models — may well supply separate discs for each operat-
ing system.

[ know what you must be thinking. Why bother? My printer is already printing
stuff out. So smart of you to ask. The answer is that the disc might supply
you with extra fonts (see Chapter 7), as well as useful software updates.

It wouldn’t hurt to also visit the printer manufacturer’s Web site to see
whether updated printer drivers are available.

Printing it your way

The Mac gives you a lot of control over how your printer will behave and
your printouts will look.

You may have noticed another pop-up menu in the print sheet called Copies &
Pages. Click, and a gaggle of other choices are revealed. Let’s examine most
of them:

v Layout: You can select the number of “pages” that will get printed on a
single sheet of paper, and determine the ways those pages will be laid
out, as shown in Figure 8-3. You can also choose a page border (Single
Thin Line, Double Hairline, and so on).

Printer: = Photosmart 3300 series

Presets:

.\‘:l) (_ PDFvy ) (_ Preview ) ( Supplies... ) ( Cancel )
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|
Figure 8-4:
Print & Fax
preferences.
|

v Scheduler: Suppose that you have to print dozens of invitations for your
spouse’s surprise birthday party and want to make sure to do so when
your honey is out of the house. Set your Mac to print at a time when the
two of you are out together.

v Paper Handling: You can choose to print only odd- or even-numbered
pages or to print pages in reverse order. You can also scale a page so
that it fits a legal- or letter-sized sheet, an envelope, or a variety of other
paper sizes.

1 ColorSync: Choose this setting if you want to add black and white, blue
tone, sepia, or other filters.

1 Cover Page: Pretend you work for the CIA. Then print a cover sheet stat-
ing that everything else you're printing is classified, confidential, or top
secret? (Yea, like they’re not going to look.)

v+ Two-Sided Printing: For printers that can handle such a requirement.

v Paper Type/Quality: Clues the printer in on the type of paper you
loaded (such as inkjet, transparency film, brochure.) You also get to
choose the print quality. A fast draft uses less ink than printing in the
spiffiest, or best, quality. If your printer has more than one tray (for
example, a main tray and a photo tray), you can also choose the source
of the paper to use.

1 Borderless Printing: Tell your printer to print without borders. Or not.

This seems as good a time as any to drop in on System Preferences, which is
under the ® menu. Under the Hardware section, click the Print & Fax icon. As
you can see in Figure 8-4, three tabs appear: Printing, Faxing, and Sharing. I'll
touch on Faxing later in this chapter.

Print & Fax
[« »|[ Showall | Q

' Printing | Faxing | Sharing !

In Menu  Printer
—

v Photosmart 3300 series w

Name: Photosmart 3300 series
Location: Directly attached via USB
Kind: HP Photosmart 3300 series
Status: Idle

Supplies for this printer...

+ |- (" Print Queve... ) [ Printer Setup...

Selected Printer in Print Dialog: “Last Printer Used

Default Paper Size in Page Setup: = US Letter

il
i 'ﬂ\ Click the lock to prevent further changes.
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If you click the Printing tab, you can choose a default paper size, click the
Print Queue button to check the status of any current printing jobs, and
more. If you click the Sharing tab, you can designate which of your other
computers can share a particular printer.

Previewing your print

Before you waste ink and paper on an ill-advised print job, you probably want
to be sure your documents meet your lofty standards. That means the mar-
gins and spacing look jiffy and you have a clean layout with no widows. That’s
publishing-speak for a lonely word or two on a line of text all to itself.

The Mac lets you take a sneak peek. Click the Preview button in the sheet
that appears when you click Print in TextEdit. In Microsoft Word or other pro-
grams, you can choose File>Print Preview to see a version of what you are
about to print. Word also gives you a preview in a small window that appears
in the Word print sheet.

If you're satisfied, press 38+P. If not, go back and apply the necessary changes
to your documents.

One more nice thing about printing on your Mac: The various programs you
work in give you lots more custom printing options. For example, you can
print a CD jewel case insert in iTunes (Chapter 14) or a pocket address book
in Address Book.

When Printers Stop Printing

As sure a thing as you'll get in computing is that sooner or later (but proba-
bly sooner) your printer will let you down. I've already hinted at why.

Running out of ink or toner

Ink is perishable. Especially with an inkjet printer. The symptoms will be
obvious. The characters on a page get lighter and lighter each time you print,
to the point where they become barely legible. The software that came with
your printer may give you an estimate on how much ink you have left each
time you print. You can also check supply levels in the Print Queue, found
again by clicking the Printing tab under the Print & Fax section of System
Preferences.
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Digital longevity?

Does the paper you buy make a difference?
Some experts believe it does. Scientists main-
tain that the ink and paper combination you use
to print digital photographs has a major effect
on how the images will endure through the
decades. Wilhelm Imaging Research has con-
ducted accelerated aging tests that have indi-
cated that, even on the same printer, prints

made on high-quality paper could last more
than 70 years when exposed to light, as com-
pared to just two or three years using inferior
paper. Regardless of the paper you use, you can
bolster the lifespan of printed photographs by
keeping them from light, humidity, and cigarette
smoke and other pollutants.

\\3

\\3

Running out of paper

Unless you make a habit of peeking at your printer’s paper tray, you won’t get

a fair warning when your paper supply is exhausted. Of course, the rule of
thumb is that you will run out of paper the hour before an important term
paper is due (or legal brief or journalism deadline; feel free to insert your

own catastrophe).

Click the Supplies button in the TextEdit print sheet (and other print sheets).
It whisks you off to the Apple store on the Internet, where you can buy

replacement ink cartridges and paper. Because Tiger knows the kind of

printer you have, you won’t have to waste your time locating the requisite
supplies. Tiger serves as your personal shopper, ushering you to the correct
aisle in the store. If you have, say, an HP printer, Tiger will find the cartridges
compatible with your particular printer model.

Alternatively, click Supplies for This Printer in the Print & Fax section of

System Preferences.

Wherever you buy your ink and paper, | recommend having a spare set

around.

Sometimes a printer stops working for no apparent good reason. In the Print
Queue, try clicking Resume or Start Jobs. If all else fails, turn off and restart

your printer.
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Hooking Up a Scanner

As with printers, connecting a scanner is no big deal. It usually hooks up
through USB, though FireWire models are in the marketplace as well. Or you
may gain a scanner as part of a multifunction, or all-in-one, device.

Scanners are kind of anti-printers because you already have a printed image
that you want to reproduce on your computer screen, such as receipts, news-
paper clippings, or photo slides and negatives. Standalone scanners may cost
less than $50, though you pay a lot more as you add features.

If you click Scanner in the Print Queue, you can tinker with the software pro-
vided by your scanner manufacturer. The software may let you remove dust
or scratches from an image and restore faded colors.

Turning the Mac into a Fax Machine

If you bought a Mac with a built-in, dial-up fax modem (see Chapter 9), you
don’t need a dedicated fax machine. Just connect a telephone cord to the
Mac’s modem jack and you’re all set. Unfortunately, the dial-up modem is no
longer standard on the latest Macs. Instead, it’s a $49 USB add-on.

Sending a fax

If you have the Apple modem, you’ll appreciate the convenience of computer
faxing. You don’t have to print a document and go to the trouble of feeding a
dedicated fax machine. Instead, you dispatch faxes directly from any program
with printing capabilities.

1. Open the document you want to fax.

2. Chose File= Print.

3. Click the PDF button and choose Fax PDF from the pop-up menu.

A sheet such as the one shown in Figure 8-5 appears.
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|
Figure 8-5:
Fill in the
necessary
fields to
send a fax.
|

To: (12125551234 £s
Dialing Prefix: 9
Modem: _mtemai Modem ?! 1
Presets: " Standard _¢]
“Fax Cover Page ?J
@ Use Cover Page
Subject: Greetings
Message: You're going to love this..]
(Preview ) (Cancel )

4. In the To field, type the fax number of the person to whom you want
to send the fax, including 1 and the area code.

If necessary to access an outside line, add a dialing prefix such as 9 in
the box marked as such.

Alternatively, chose an entry from your Address Book by clicking the
shadowy silhouette icon to the right of the To field and then double-
clicking the card of the contact to whom you want to fax.

5. In the Modem box, select Internet Modem (or whatever) as the means
for dispatching your fax.

6. If you want a cover page, select the Use Cover Page option and type a
subject line and brief message.

7. If you click the pop-up menu that says Fax Cover Page, you can choose
other options to schedule the delivery of your fax or alter the layout.

8. To review the fax before sending it, click the Preview button.
9. Click the Fax button.

You should hear that awful, grinding faxing sound. It’s the best evidence
that your fax is on its merry way.

Receiving a fax

It makes sense that if a Mac can send a fax, it can receive one too. Make sure
you have an available phone line and your computer is awake. A Mac in sleep
mode cannot receive a fax. Then follow these steps:
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1. From System Preferences, choose Print & Fax and then click the
Faxing tab.

2. Select the Receive Faxes on This Computer option.

3. Type your fax number in the box, as shown in Figure 8-6.

Print & Fax
[« » ][ showal | Q

! Printing = Faxing | Sharing

z Receive faxes on this computer

My Fax Number: 212 555-1234

When a Fax Arrives: Answer after 4 |, rings

\_/ Save to: ._ é.hare.dnlzaxes

[ |Email to:  Edward Baig <baigbw@aol.com>

[ Print on printer:  Photosr

I _—
(_ Set Up Fax Modem... )
Figure 8-6: _
. __| Show fax status in menu bar (&)
Hold on. I'm =
getting a )
1
fﬂX. J l% Click the lock to prevent further changes.
I

3. Designate the number of rings before the fax is answered.

Make sure the computer gets to pick up before an answering machine
connected to the same phone line.

4. Choose how you want the incoming fax to be treated:

e Save the fax as a PDF in the Shared Faxes folder that Apple sug-
gests, or save it to another folder

¢ Send the fax to a specific e-mail address

e Automatically print the fax

You can accept an incoming fax even if you haven’t bothered to set up the
system to receive faxes automatically. Go to System Preference, choose Print &
Fax, and click Faxing. Select the box Show Fax Status in Menu Bar option.
When the phone rings, choose Answer Now from the Fax Status icon in the

menu bar.

\\3
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The 5th Wave By Rich Tennant
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“Wow, T didn’t know O X could redirect
an e-mail message like that.”



In this part . . .

Do you sometimes feel like the last person on Earth to
figure out the Internet? The chapters here will direct
you online, and help you survive after you get there. You

also find out why e-mail is so wonderful — and so horrific
at times — and give some deep thoughts to the merits of

.Mac membership.




Chapter 9
Stairway to the Internet

In This Chapter
Deciding how to connect
Comparing features from ISPs
Browsing with Safari

Discovering a Web of online riches

R emember what life was like prior to the middle half of the 1990s? Before
this nebulous thing called the Internet changed only everything.

Way back in the Dark Ages people routinely set foot in record stores to buy
music. Students went to the library to do research. Folks paid bills with
checks and read newspapers on, gosh, paper. They even picked up the tele-
phone to gab with friends.

How passé.

Nowadays, such transactions and exchanges occur gazillions of times a
second on the Internet. Cyberspace has become the place to shop, meet your
soul mate, and conduct business. It is also a virtual playground for the kids.

You can fetch, or download, computer software, movies, and all kinds of other
goodies. You may even get the stuff for free. Let your guard down, however,
and you can also lose your shirt. (You really have to question how you won
the Sri Lankan lottery when you never bought a ticket.)

Nobody in the early days of the Internet could have envisioned such a future.
What eventually morphed into the Net was invented by the nerds of their day,
1960s Defense Department scientists. They constructed — in the interest of
national security — the mother of all computer networks.
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Hundreds of thousands of computers would be interconnected with hun-
dreds of thousands more. The friendly face of cyberspace — what became
the World Wide Web, or Web for short — was still decades away.

Has this somehow passed you by? Forget about fretting if you haven’t
boarded the cybershuttle just yet. Getting up to speed on the Internet isn’t as
daunting as you might think. You can enjoy a perfectly rewarding online expe-
rience through your Mac without ever deciphering the Net’s most puzzling
terms, everything from domain names to file transfer protocols. And you cer-
tainly don’t have to stay up late cramming for any final exams.

But the Internet is not for people who cherish siestas either. It’s as addictive
as nicotine. Expect a warning from the surgeon general any day now:
Spending time online is hazardous to your sleep cycle.

Feeling brave? Want to take the online plunge anyhow? The rest of this chap-
ter will clue you in on how best to proceed.

Dialing In

Let the games begin. You can find your way online in two main ways, and
both involve getting chummy with an important piece of computer circuitry,
the modem. 1 address dialup modems here and broadband modems in the
next section.

Dialup is the simplest and cheapest scheme. It’s nearly as brainless as making
a phone call. Wait a second, it is making a phone call. When the modem
works its magic, it dials the Internet over a regular phone line as if you were
calling your mother. The difference is that no one at the other end will make
you feel guilty for not visiting often enough. With any luck, you won’t get a
busy signal, either.

In many cases you won’t actually see the modem because it resides inside
the Mac. That’s okay. You only need to locate the phone jack on the back or
side of the computer (depending on the model). A little phone icon lets you
know you’ve arrived at the right place. On recent Macs, a built-in dialup
modem is no longer standard, probably because Apple reckons that most
users are embracing broadband; you can buy an optional dialup modem that
connects to a USB port on the machine. Either way, connect one end of a
standard phone cord into the modem jack and the other end into the wall
jack where your telephone was connected.
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Speed kills

When geeks speak of modem speeds, they typ-
ically talk in terms of kilobits per second, or
kbps, which is the equivalent of one thousand
bits per second. The itty bitor binary digitis the
tiniest unit of measurement for data. Dialup
modems are typically rated at 56 Kbps (often
expressed as 56K). Reality check: Rarely are the
maximum speeds achieved, so a 56K modem is
probably transmitting data at 48K or so. If you
don't have a clean connection, you might creep
along at much slower speeds than that. You'll be
counting “one Mississippi, two Mississippi,

three Mississippi” and so on before the Web
page you clicked on even starts to show up.

Now consider broadband modems. The ones
that truly rock might blaze along at 5000kbps or
faster (sometimes expressed as 5 megabits per
second, or 5 Mbps.) The broadband to dialup
difference is like comparing an Olympic sprinter
to a weekend jogger. Web pages can turn up
thisfast, downloaded files also show up in a jiffy,
and videos appear much more fluid, as if you
were watching TV rather than viewing the
equivalent of a herky-jerky slide show.

\\3

This all sounds fine and dandy, save one knotty problem. You still want to be

able to make and receive regular calls using the phone whose cord you

removed. The answer is a small, inexpensive, plastic doodad called a splitter
(or Y-jack), which as its name suggests splits a single phone jack into two. So
now you can plug your computer and phone into the same wall jack, though

you still can’t handle regular calls and use the Internet at the same time.

If doing both simultaneously is an essential requirement, you can always
have the phone company come out to install a second phone line in your
house. You can then dedicate one line to the modem and another to the
phone. This peachy little arrangement will cost you a pretty penny each
month, however, and is not necessarily the ideal solution, as I expand on in
the next section. It’s time to consider broadband.

Taking the Broadband Express

If the traditional dialup modem is the local, broadband is the express. Who

can blame you for wanting to take the fast train? You’ll pay more for a ticket —
monthly charges can amount to $35 to $50 on up, often more than double the

dialup fees. The positive spin is that you won’t need a second phone line.

Besides, the broadband express is almost always worth it. After you've experi-

enced a fast hookup, you’ll have a difficult time giving it up.

137
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DSL or cable?

Broadband service comes in three flavors. Depending on where you live, you
may have a choice of all, some, or none of the various alternatives. All three
broadband types have dedicated modems that reside outside the computer.
In many but not all cases, a technician will come to your house (generally for
a fee) and connect a broadband modem to the service you have selected. The
options are

v+ Cable modem: Typically the fastest of the broadband choices and the
one that probably makes the most sense if you already subscribe to
cable TV. The reason is your cable company is likely to cut you a small
break on the monthly fee. The connection involves hooking up the cable
TV cord to the modem.

v DSL: As with dialup, DSL, which stands for Digital Subscriber Line, works
over existing telephone lines. But a big difference compared to dialup is
that you can prowl the Internet and make or receive phone calls at the
same time. And DSL, like a cable modem, is leagues faster than a dialup
modem. As with cable, deals can be had if you take on service from the
same company supplying your regular phone service.

v~ Satellite: Possibly the only alternative if you live in the boondocks. You
get the Internet signal the same way you receive satellite TV, through a
dish or antenna mounted on your house. If you go the satellite route,
make sure your modem can send, or upload, information as well as
receive, or download, it. Upload speeds are typically much pokier than
download speeds, and satellite service in general is sluggish compared
to other broadband choices. (Of course, uploading and downloading are
components of all modem types.) Satellite also commands higher
upfront costs than cable or DSL because you have to shell out for the
dish and other components.

Always on, always connected

In the dialup world, you make your call, wait for a connection to be estab-
lished, grab what you are looking for on the Net, and say adios. Heaven forbid
you forget something. Each time you want to go back online, you have to
repeat this drill. Amounts to too many phone calls, too many hassles.

Broadband generally has fewer hang-ups. The experience is far more liberat-
ing because you have a persistent, always-on connection, at least as long as
the Mac itself is turned on. You won’t have to compete with your teenagers for
access to the only phone in the house. Web pages get updated. E-mails and
instant messages usually arrive in a blink. What’s more, you can share your
Internet connection with other computers in the house (see Chapter 19).
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Let Me In

This whole Internet business has one more essential piece: deciding on the
outfit that will let you past the Net’s front gate. That company is called an
Internet Service Provider, ISP for short. You'll invariably have to slip this gate-
keeper a few bucks each month, though sometimes paying annually lowers
the price of admission. Many ISPs, such as AOL, Comcast, EarthLink, and
MSN, are large, well-known enterprises. But tiny unfamiliar companies may
also serve the bill.

As always, there are exceptions: You may not have to shop for an ISP if your
employer provides the Internet gratis. Students often get complimentary
access on college campuses, though the costs are likely buried in tuition.

If you signed up for broadband, chances are you've already met your ISP
because it’s the cable or phone company that set you up. But if you're play-
ing one company off against another, here are key points to consider:

v Service: An ISP’s reputation is the whole enchilada. Seek companies that
do a lot of handholding, from Getting Started pamphlets to toll-free tech-
nical-support phone numbers. If they do provide toll-free support, give
the number a try before you sign up. Look elsewhere if it takes forever
for a live person to answer your call.

v Fees: Membership fees vary, and companies often run promotions.
Compare rate options if you live in a town with lots of dialup and broad-
band choices. Choose a plan in which you are given unlimited access for
a generous chunk of hours. Metered pricing in which you are billed
hourly isn’t smart for anyone but the most disciplined user who rarely
expects to go online.

v Local number: This is an important consideration for dialup customers.
If possible, choose a plan where you can dial the Net without incurring
long-distance charges. If you travel a lot, it’s also helpful to have a
choice of local numbers in the city or cities you most often frequent.

v E-mail: Just for being a customer, some ISPs give you one or more e-mail
accounts. More is obviously better if you intend on sharing the com-
puter with family members. Ask also whether the ISP provides tools for
cutting down on spam. I'll have more to say on this topic in Chapter 10.

v Family protection: If you have kids, find out whether the ISP offers
parental controls or takes other steps to help protect the little ones in
cyberspace.
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Whither online services

America Online remains the colossus of ISPs, but
it also is the prime representative of a crumbling
institution: the online service as we once knew
it. (An online service is essentially a private club
where you can pontificate in chat rooms and on
bulletin boards, download files, get news, seek
help with technical problems, and access
e-mail.) In the days when only nerds had heard
of the Internet, AOL competed against and ulti-
mately clobbered consumer rivals such as
Prodigy and more technically oriented online
services such as CompuServe and GEnie. In fact,
AOL eventually acquired CompuServe.

As with any ISP, subscribers today rely on AOL
as the gateway to the unfettered Internet. But
you also must fork over a premium for the privi-
lege. At $25.90 a month for an unlimited plan,
you'd be hard-pressed to find a more expensive
dialup alternative.

Throngs of members, including lots of Net
beginners, or newbies, made AOL the online
champ because of the way the company clev-
erly prepackaged and organized material inside
its “walled garden.” Sure, you could eventually
venture out to the Internet at large, but more
than likely you'd remain inside AOL's friendly
confines. The environment was pretty safe —
AOL offered excellent parental controls and
tried to rid the joint of its relatively few bad
apples. The company also made it a breeze to
get started. AOL's free software disks turned up
in shops, in your mailbox, and as magazine
inserts.

In recent years, though, AOL members started
ditching the service in droves. Folks discovered
broadband and figured that much of what they
were getting inside AOL for hefty fees, they
could find on their own in cyberspace for less. It

hardly mattered to these people that AOL ped-
dled broadband connect services like its rivals.
They couldn’t care less that AOL reduced the
tab for its proprietary content when they arrived
online through another ISP. Bottom line: AOL
became less relevant.

AOL got the hint. It quietly transitioned from a
company that has traditionally trumpeted the
flagship online service into one that aggres-
sively competes in the free Web portal, or entry-
way space, against the likes of Yahoo!, MSN,
and Google. This means that much of the mate-
rial previously available only to subscribers can
be accessed for free by visitors to its Web
pages. What's more, as of this writing, AOL
parent Time Warner was reportedly consider-
ing a plan that would drop subscription fees for
high-speed broadband customers. (Dial-up
members would still have to pay.) Such an
altered landscape begs an obvious question: Is
AOL membership worthwhile? A slew of AOL
critics sneer that AOL wasn't worth the price of
admission even in its heyday. The reasons for
staying put are dwindling even for AOL loyalists.
Although AOL still provides fine parental con-
trols, most of the other PC protection and secu-
rity features it offers with a subscription mean
little to the Mac community. Viruses and spy-
ware are mostly somebody else’s problem (see
Chapter 14).

Still, Mac users will appreciate some of the con-
tent that remains solely available to AOL sub-
scribers, notably all XM satellite radio’s music
channels. Perhaps the most compelling reason
to stick with AOL: Veteran members may not
want to go through the hassle of telling friends
and cohorts that the AOL e-mail address they've
used for years is now out of service.
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Going on a Safari

It is virtually impossible to ignore the World Wide Web. Practically everyone
you come across is caught up in the Web in one way or another. On a typical
day, you might hear how “little Johnny built this amazing Web page at
school.” How your best friend researched symptoms on the Web before head-
ing to the doctor. And how you can save a bundle booking your vacation
online. Web addresses are plastered on billboards, business cards, and the
cover of books like this one.

Just browsing

Technologists have an uncanny knack for making simple things hard. They
could ask you to make a phone call over the Internet. But if they told you
instead to make a VoIP or Voice over Internet Protocol call, they’d pretend to
be really smart. So it is unbelievably refreshing to discover that to browse or
surf the World Wide Web, you need a piece of software that is called, um, a
Web browser. Okay, so they might have called it a Web surfer.

Because you had the good sense to purchase a Mac, you are blessed with one
of the best browsers in the business. It’s aptly named Safari because much of
what you do in cyberspace is an expedition into the wild. See Figure 9-1.

Learning to tame Safari means getting fluent with the concept of a Web address,
or what those aforementioned technologists dub a URL (Uniform Resource
Locator). Scary stuff. I told you, these guys can’t seem to help themselves.

Just because of the way things are, all Web addresses begin with http:// or
www. and end with a suffix, typically .com (pronounced “dotcom”), .edu, .gov,
.net, or .org. What you type in between is often (but not always) an excellent
indicator of where you will end up on the Web. So typing www . usatoday .
com takes you to the nation’s largest newspaper. Typing www . espn . com
leads to a popular sports destination. And so on. You enter the URL into an
address box at the top of the browser window (labeled in Figure 9-1).
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Clicking links

Web surfing would be awfully tedious if you had to type an address each time
you wanted to go from one site to another. Fortunately, the bright minds who
invented Safari and other browsers agree.

On the Safari address bar you'll typically see a series of buttons or icons to
the left of the box where you entered the URL. The buttons you see and the
order in which they appear vary, depending on how you customize the
browser. To make the address bar disappear entirely, choose Viewr>Hide
Address Bar. To make it reappear, choose View=>Show Address bar.

The left- and right-facing arrow buttons on the address bar function as the
back and forward buttons, respectively. So clicking the left arrow transports
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you back to the last page you were looking at before the page that is cur-
rently displayed. Click the right, or forward, button to advance to a page you
have already looked at.

Click the address bar icon that looks like a house, and you go to your starting
base, or home page. That’s the site that greets you each time you fire up the
browser for the first time. It’s no coincidence that Apple chose one of its own
Web pages as the default Safari starting point. That way, it can promote the
company and try to sell you stuff. As you might imagine, home pages are
valuable pieces of screen real estate to marketers. Everyone from AOL to
Google to Yahoo! would love for you to choose their portal as your start page.
Fortunately, changing Safari’s home page is simple. Select Preferences from
the Safari menu, click the General tab, and then type the Web address of your
page of choice in the box labeled Home page, shown in Figure 9-2.

A\

You'll notice that some text on various Web pages is underlined in blue. That
means it’s a link. Clicking a link takes you to another page without having to
type any other instructions.

Some links are genuinely useful. If you are reading about the Indianapolis
Colts game, you may want to click a link that would lead to, say, quarterback
Peyton Manning’s career statistics. But be wary of other links that are merely
come-ons for advertisements.
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Using bookmarks

Odds are you'll rapidly get hooked on a bevy of juicy Web pages that become
so irresistible you’ll keep coming back for more. We won’t ask, you need not
tell. Of course it’s downright silly to have to remember and type the destina-
tion’s Web address each time you return. Create a bookmark instead.

Choose the Add Bookmark item under Safari’s Bookmarks menu or press the
keyboard shortcut 88+D. A dialog box appears (see Figure 9-3), asking you to
type a name for the bookmark you have in mind and to choose a place to
keep it for handy reference later. You can group bookmarks in menu folders
called Collections. If you decide to bookmark the Internet Movie Database
home page, for example, you might decide to place it in a Collections folder
called Entertainment. Whenever you want to pay a return visit to the site, you
open the Entertainment folder and click the bookmark.
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Despite your best organizational skills, your list of bookmarks and
Collections may become so, well, overbooked, that it becomes far less func-
tional. I practically guarantee that you will tire of at least some of the sites
now cluttering up your bookmarks closet. To delete a bookmark, highlight its
name, click the Edit menu at the top of the screen, and then choose Cut. If
you change your mind, choose Edite>Undo Delete Bookmark.

If all that seems like too much work, highlight an unwanted bookmark and
press the Delete button on your keyboard.

You’ll want to return to some sites so often they deserve VIP status. Reserve
a spot for them in Safari’s Bookmarks marquee, otherwise known as the book-
marks bar, situated below the browser’s address bar. Choose Bookmarks Bar
when the dialog box pops up, asking where to place the bookmark you’ve just
created.

Employing the tools of the
trade on your Safari

Safari is capable of other neat tricks. [ describe some of them in this section.

Pop-up blocker

Tolerating Web advertising is the price to pay for all the rich Web resources
at your disposal. Problem is, some ads induce agita. The most offensive are
pop-ups, those hiccupping nightmarish little windows that make you think
you woke up in the middle of the Las Vegas strip. Pop-ups have the audacity
to get between you and the Web page you are attempting to read. Turning on
the pop-up blocker can shield you from such pollutants. Click Block Pop-Up
Windows under the Safari menu or employ the keyboard shortcut $8+K. If a
check appears, you have successfully completed your mission. Once in a
great while, a pop-up is worth viewing; to turn off the pop-up blocker simply
repeat this exercise.

Google search bar

You can conduct a Google search by visiting www . google. com. But Safari
saves you the time and trouble. You can enter search terms directly into a
box right in the address bar. I'll have more to say about Google and other
search engines later in this chapter.

Chapter 9: Stairway to the Internet 7 45
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Filling out forms

Safari can remember your name, address, passwords, and other information.
So when you start typing a few characters into a Web form or other field, the
browser can finish entering the text for you, provided it finds a match in its
database. From the Safari menu, choose Preferences=>AutoFill, and select the
items you want Safari to use (such as info from your Address Book card). If
several choices match the first several letters you type in a form, a menu
appears. Press the arrow keys to select the item you have in mind and then
press Enter.

Tabbed browsing

Say you want to peek at several Web pages in a single browser window
instead of having to open separate windows for each “open” page. Welcome
to the high art of tabbed browsing. To turn on the feature, choose Preferences
in the Safari menu and then click Tabs. The window shown in Figure 9-4
appears. Select the Enabled Tabbed Browsing option and the Select New Tabs
As They Are Created option. Then close the Preferences window.

Now each time you 8-click, you open a link in a new tab instead of a window.
To toggle from one open Web page to another, just click its tab. The tabs
appear just under the bookmarks bar. You can also press 8+T to open a new
tabbed window.

Benefiting from History

Say you failed to bookmark a site and now days later decide to return. Only
you can’t remember what the darn place was called or the convoluted path
that brought you there. Become a history major. Safari logs every Web page
you open and keeps the record for a week or so. So you can consult the
History menu to view a list of all the sites you visited on a particular day
during the week. If you're wigged out by this Internet trail, you can always
click Clear History to wipe the slate clean.
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General Appearance Bookmarks @ Tabs RSS  AutoFill Security Advanced
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Private browsing

Hey maybe you do have something to hide. Perhaps you’re surfing in an
Internet cafe. Or just possibly you're being paranoid. Whatever. Turn on a
hush-hush Safari feature called private browsing by choosing that option on
the Safari menu. Now Safari won’t add the Web pages you’ve visited to the
History menu (though you can still use the Back and Forward buttons to
return to sites you’'ve been to). When private browsing is turned on, AutoFill
is turned off, and Web cookie preferences (see Chapter 14) are also deep-
sixed.
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Using an Alternative Browser

Safari is swell, but it’s not the only game in town. Eventually, you’ll stumble
upon a Web site that doesn’t make nice with the Apple browser. That'’s likely
because the site was programmed to work solely with the Grand Poobah
among browsers, Microsoft’s Internet Explorer. Hey, no one ever said life was
fair (see the “Putting up with Internet Explorer” sidebar).

Other fine browsers abound and choosing one is like deciding between Coke
and Pepsi. Check out Mozilla Firefox, iCab, and Opera at their respective Web
sites.

Putting up with Internet Explorer

For years Microsoft adopted a kind of /aissez-
faire approach when it came to revving up its
famed Web browser. It generally left tabbed
browsing and other innovations to others. Such
is the complacency that sets in when you've
bagged a monopolistic share of the market. Still
the venerable browser comes in handy at times,
especially if Safari has difficulty communicating
with a particular Web page you're trying to
view. On older Macs, you'll find Internet
Explorer in the Applications folder. On newer
systems, you have to fetch the program yourself
from the Internet.

Just don't expect any niceties from the folks at
Microsoft headquarters in Redmond, Washington.
In the middle of 2003, Microsoft announced that
IE for the Mac would undergo no further devel-
opment. A couple of years later, Microsoft said
it would no longer offer tech support for the
Mac version of IE and indicated it wouldn't pro-
vide security or performance updates either.
The message was practically deafening: Go
book a Safari.




’ 48 Part lll: Rocketing into Cyberspace

The Skinny on Search Engines

So all these plum pickings are on the Internet, along with quite a lot of
garbage. This leads to the obvious question: Where in goodness sakes do you
uncover the gems amidst all the junk? A search engine is the best place to
begin. These useful tools scan Web pages to find links based on instances of
the search terms you enter.

Google this

Anyone who is anyone — and that might as well include you — uses Google.
Google has become so popular that it’s often treated as a verb, as in, | googled
something. It is also why Google’s founders have become richer than Croesus.

Haven’t the foggiest idea who Croesus was? Just Google the name, and you'll
soon discover how this sixth-century Lydian monarch managed to amass a
fortune without launching an IPO.

The slowpoke way to Google something is to visit www.google.com. Type
your search query, Croesus in this example, and click the Google Search
button. Safari, however, provides a faster alternative. Just enter your query in
the Google text box inside the Safari address bar, as shown in Figure 9-5.

Google text box

288 croesus - Google Search
| 4. » G || + | [Glhup:/ jwww.google.com/search?client=safari&rls =en&q=croesus&le=UTF-8&oe=UTF-8 ~ Q- croesus
[0 Apple(S6)v Amazon eBay Yahoo! News(73)v

. ——

Web Images Groups MNews Froogle Local more»

(Search) Advanced Search
0( )g e croesus earch ) proforences

Web Results 1 - 10 of about 503,000 for croesus [definition]. (0.04 seconds)

King Croesus - All About Turke:

Gold coins of Lydia The expression “as rich as Croesus" comes from the ... The Lydians in
the time of Croesus, it is believed, were the first people to mint ...
www.allaboutturkey.com/croesus.htm - 7k - Cached - Similar pages

Croesus, Greek Mythology Link.
King Croesus of Lydia became proverbial for his wealth and the ... History, and not the
myths, affirns that Croesus reigned, as last king of Lydia, ...

homepage.mac.com/cparada/GML/Croesus.htrml - 97k - Cached -

CROESUS MINING NL - OFFICIAL WEBSITE
www.croesus.com.aul - 1k - Cached - Similar pages

Croesus - Wikipedia, the free encyclopedia

King Croesus welcomed him but then Adrastus accidentally killed Croesus' son, ...
Unfortunately for him Cyrus didn't and he attacked Croesus in Sardis and ...
en.wikipedia.org/wiki/Croesus - 17k - Cached - Similar es

|
Croesus Finansoft - Portiolio Management System
F- 9 5_ Croesus Finansoft is a worldwide software leader in the field of securities and portfolio
|Qure = management. Our financial solution is available for Brekerage, ...
. www.croesus.com/ - 18k - Cached - Similar pages
Arich

. Ancient History Sourcebook: Herodotus: Solon and Croesus, from The ...
search in | Ths did Solon admonish Croesus by the example of Tellus, enumerating the ... When he
had ended, Croesus inquired a sscund time, who after Tellus seemed to ...

GOOg'e. www.fordham. edu/halsal html - Similar pages

— | Crossus
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Either way, Google will rapidly spit back a list of findings, or hits, containing
links to Web pages. That would be all there is to it, except you’ll probably
have to help Google narrow things down a tad. The Croesus example yields
about 503,000 hits, which is more than you probably bargained for.

Enter an even broader search term such as rockets, and Google responds with
something in the order of 45 million hits. I don’t know about you, but I have
time to pore through only half of them. What’s more, smart as Google is, it
has no way of knowing whether you mean the flying machine that soars into
outer space, the basketball franchise that plays in Houston, or even the ham-
burger chain Johnny Rockets.

The obvious takeaway: the more descriptive you are the better. Two or three
search terms almost always work better than one.

You can assist Google in several ways. Putting quotation marks around your
search term narrows the returns because the browser thinks you're search-
ing for that exact phrase. This works wonders with song or book titles.

Conversely, you can exclude topic areas by putting a minus sign next to the
word. For example, if you enter

rockets -houston

you shouldn’t receive references to the basketball team. If you want to find
pages that include either of two search queries, use an OR between the
words. For example

Rockets OR Jets

displays results for two professional sports franchises. But proving again
how tricky the search biz can be, you would have to be more explicit if the
rockets and jets you have in mind are the kind that require astronauts and
pilots.

Here’s a sampling of other nifty Google tricks that would make a professional
researcher proud:

v Solve arithmetic: Enter a math problem, such as 63/7.8 = and Google
supplies the answer (8.07692308).

v Provide the forecast: By adding weather next to a city name or postal
zip code, you can peek at the current temperature, wind, and humidity
and get a quick weather snapshot of the days ahead.

v Do a reverse phone lookup: Type an area code and a phone number,
and Google will reveal whose number it is (if listed).

v Track airline delays: Google can tell you whether a plane is on time.
Just type in the flight number.
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1~ Take over for Webster: Place define before a word and Google offers a
definition.

1 Convert currency: Want to determine how many dollars there are to the
euro? Type, for example, 250 us dollars in euros.

MSN and Vahoo!

Google is the search engine of choice for your humble author, but other alterna-
tives are available. Yahoo! and MSN (from Microsoft) are probably the best-
known rivals, and both do a decent job. In fact, Yahoo! is kind of the granddaddy
of the search business. Moreover, when you go to the Yahoo! or MSN site, at
www . yahoo . com or www . msn . com, respectively, you'll be taken to their respec-
tive Web portals, where you can do a lot more than search. Portals are launching
pads for a gaggle of goodies, including news and entertainment links, stock
quotes, games, and e-mail.

The Davids to the search Goliaths

You may want to do a Google search on search engines because so many
smaller, specialized ones pop up all the time. (I suppose the creators of these
sites want entrée into the same country clubs as the Google guys.) Search
companies may narrowly focus on news, health, travel, local goings-on, poli-
tics, or shopping. And some, such as Dogpile (www.dogpile.com), merely
aggregate or compile results from other leading search engines into one.

A particularly interesting approach is taken by Clusty, found at
www.clusty.com. It groups similar items together into folders, or clusters. If
you type Giants, for example, Clusty generates groupings such as New York
Giants, San Francisco Giants, Barry Bonds, Corporate Giants, Dinosaurs, and
Land of the Giants. Click the appropriate cluster, and the displayed search
results pertain only to that grouping.



Chapter 10
Going Postal over E-Mail

In This Chapter
Setting up e-mail accounts
Composing messages
Receiving messages
Dealing with attachments
Handling junk mail

Getting tutored on smart mailboxes

Eectronic mail is a blessing and a curse.

Why you can’t live without e-mail: Messages typically reach the person to
whom they’re addressed in a few seconds as compared with a few days for
snail mail. (That’s the pejorative label geeks have tattooed on regular postal
mail.) You won’t waste time licking envelopes either.

Why e-mail drives you batty: It won’t take long before you're likely buried
under an avalanche of messages, much of it junk mail, or spam.

Not that any mail system is perfect. You can only imagine the snide com-
ments heard in the day of the Pony Express: Love that I got my tax refund and
Sharper Image catalogue, but the stench on that steed. . . .

If you're an e-mail tyro, you discover the basics in this chapter. But even
those who have been sending electronic missives for years might be able to
collect a useful nugget or two.
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Understanding E-Mail

In broad terms, e-mail is the exchange of messages over a communications
network, typically the Internet but also a network within an organization.

To use e-mail, you need an e-mail account, such as the ones traditionally
offered by employers, schools, or Internet Service Providers (ISPs) such as
AOL, EarthLink, or MSN. You also need e-mail software to send, receive, and
organize these messages. Fortunately, Apple includes such an application
with OS X, and there can’t be any doubt about what the program does. It’s
aptly named Mail.

To access Mail, single-click the icon that looks like a stamp on the dock. If for
some reason the icon isn’t there, double-click the Mail icon inside the
Applications folder.

By the way, don’t let the stamp representing the Mail icon fool you. E-mail
doesn’t require postage; for that matter, many e-mail accounts are free. Well,
like most things in life, e-mail is not really free. You pay for it

v As part of your ISP fees

v As part of your college tuition

v By having to read irritating online advertisements

v By the aggravation accompanying your boss’s e-mails

The Worldwide E-Mail Exchange

<MBER

\\3

Before telling you how to set up e-mail accounts to work with the Mac’s Mail
program, know that you can continue to send and read mail inside such
applications as Microsoft Entourage (like Outlook for the Mac crowd). What’s
more, if you've been sending and receiving e-mail on other computers
through Web accounts such as Google’s Gmail, Microsoft’s MSN Hotmail, or
Yahoo! Mail, you can continue right along on the Mac. AOL, the outfit that
popularized the phrase “You've Got Mail,” works too.

Having one or more Web-based e-mail accounts is nice. You get the tremen-
dous advantage of being able to access mail from any Internet browser (on a
Mac or PC). Plus, popular Web e-mail accounts are free and loaded with gobs
of storage.
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Setting Up a New E-Mail Account

Sending and reading e-mail through the Mac’s Mail program is a breeze, after
you set the thing up. Indeed, the process for first-timers can be a slightly har-
rowing experience:

1. Open Mail by clicking the Mail icon (it looks like a stamp) on the dock
or by double-clicking Mail in the Applications folder.

You are greeted with a Welcome to Mail window, shown in Figure 10-1.

New Account

Welcome to Mail

You'll be guided through the necessary steps to set up
your mail account.

Tgreror | |0
Figure 10-1:

Setting up a
new Mail
account
begins here.
|

To get started, click Continue.

{ Cancel ) ( Continue )

2. Click Continue.
3. Fill in the General Information required in the next screen.

You must fill in an Account Type (from a drop-down menu), Account
Description, Full Name, User Name, and Password.

4. In the next few screens, you have to supply other dreadful sounding
particulars, such as the name of the incoming mail server (something
like pop . yourprovider.com).

This is where your e-mail congregates before it is retrieved. There’s also
the outgoing mail server (typically SMTP. yourprovider.com). Okay, |
won’t keep you in the dark any longer: SMTP stands for Simple Mail
Transfer Protocol, POP is short for Post Office Protocol, and IMAP for
Internet Mail Access Protocol or Internet Message Access Protocol.
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Setting up additional mail accounts involves repeating these steps. Begin by
choosing File>Add Account in Mail.

Piece of advice: Unless you're looking for an excuse to get away from the
chatterbox you’ve been kibitzing with at a cocktail reception, avoid dropping
these unfriendly terms into your conversation. It’s like having a big N (as in
Nerd) stamped to your forehead.

If the IMAPs and SMTPs and the rest are not exactly at your fingertips (and
why should they be?), call your ISP or poke around the company’s Web site
for assistance.

Incidentally, setting up e-mail through a .Mac account (see Chapter 12) is a
far simpler endeavor because Apple fills in some of the blanks on your behalf.

Before You Click Send

[ promise the difficult part is behind you. And if you're already an e-mail whiz,
you can skip the next few sections. I'll greet you on the other side.

If you're still with me, you're going to find out how to send e-mail, with minimal
attention paid to protocol. E-mail addresses always have the @ symbol some-
where in their midst. They look something like this: paula@americanidol.
com, deputyfife@mayberrysheriff.gov, or costanza@nyyankees.com.

With the Mail program open, choose Filem>’New Message, use the keyboard
alternative 3+N, or click New in the Mail toolbar. (Once again, if Mail isn’t
open, click the stamp icon on the dock.) A window like the one shown in
Figure 10-2 appears.

Addressing your missive

With the New Message window on your screen, you're ready to begin the
process of communicating through e-mail with another human being.

In the To box, carefully type the recipient’s e-mail address. If you type even a
single letter, number, or symbol incorrectly, your message will not be sent
(you should get a bounce-back notification) or worse, will be dispatched to
the wrong person.
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|
Figure 10-2:
How to send
an e-mail
message.
|

Click to save a message you're not ready to send
The main recipient of your message

These folks are copied but can't
see who else received the message

These folks are copied | Message subject

Click to send the message )
The main body

Click to attach a file of the message

| Opie cutting class? [=]

& B @ @

Amach Address Fonts  Colors Save As Draft

|2

o: sherifftaylor@mayberrysheriff.gov

Cc: deputy rysherrif.gov, berry.com = Edward Baig = —
Bcc: gomer@mayberry.com, b berry.com
Subject: Opie cutting class?
|=+| Account:[ Edward Baig <baiged@mac.com> 5 Signature:| Neme 3| ! 4]

Hey Andy,

Keep an eye out on Opie. | saw him fishing during school hours.

EB

As you start banging out an e-mail address, the Mac tries to be helpful. It fills
in the name and address of the person it thinks you are trying to reach
(culled from your Address Book). Don’t worry if the wrong name shows up at
first. Keep typing until either Apple guesses correctly or you have manually
entered the full address.

If you are sending mail to more than one recipient, separate the addresses
with a comma.

If you want to send mail to folks who are not the primary addressees of your
letter, type the addresses for these people (again separated by commas if you
have more than one) in the Cc:, or carbon copy, box.
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There’s an even easier way to add an e-mail address, provided your recipient
already resides in your Address Book. In the New Message window, click the
Address button. Then just double-click the name of the person from your
Address Book who you want to send mail to, and the Mail program takes care
of the rest. The real names of these Address Book people appear in the To
box (or cc box); you won'’t see their actual e-mail address. For example, you’d
see the name Tony Soprano rather than boss@sopranos. com. Have no
fear, under the hood, Apple is making all the proper arrangements to send
your message to the rightful recipient.

You may want to keep the recipients’ list confidential. (The Feds need not know
where all Tony’s mail goes.) There are a couple of ways to accomplish this:

»* You can send mail to a Group in your Address Book (Chapter 3) just by
typing the Group name in the To field. Mail then automatically routes
mail to each member’s e-mail address. To keep those addresses private,
choose Mail=>Preferences and select Composing. Make sure the “When
Sending to a Group, Show All Member Addresses” option is not checked.

v To keep the addresses of recipients who are not members of the same
group private, click the little drop-down arrow to left of the Account box
in the New Message window. Choose Bcc Address Field. Bec stands for
blind carbon copy. Everyone included in the list will get the message, but
they won’t have a clue who else you sent it to.

Composing messages

Keep a few things in mind before pounding out a message. Although optional,
it’s good e-mail etiquette to type a title, or Subject, for your e-mail. (See the
“E-mail etiquette” sidebar.) In fact, some people get right to the point and
blurt out everything they have to say in the Subject line (for example, Lunch
is on at noon).

To write your message, just start typing in the large area provided below the
address, subject, and account lines. You can also paste passages (or pic-
tures) cut or copied from another program.

The standard formatting tools found with your word processor are on hand.
You can make words bold or italic and add spice to the letters through fancy
fonts. Click the Fonts button to display different typefaces. Click the Colors
button to alter the hues of your individual characters. Both the Font window
and the color wheel are shown in Figure 10-3.
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Figure 10-3:
Changing
fonts and

colorsin
your
e-mails.
|

@ Mail File
eoe
uw._/‘/-\"r“.E",{.“g'

Send  Chat  Amach Address Fonts  Colors Save As Draft

Edit View Mailbox Message Format Window Help 2 4) % Sun7:04PM edwardbaig &

Opie cutting class? (=]

To: sherifftaylor@mayberrysheriff.gov

Ce: de rysherrif.gov, ry.com Edward Baig

Bec: ry.com, ayberry.com

Subject: Opie cutting class?

=v| Account:| Edward Baig <baiged@mac.com> ] Signature:| None | IERE
Hey Andy,
Keep an eye outon Opie. | saw him fisting during © 11| hours. 600 Colors =]
EB O = a
000 Font =
[TH=R[TH[C ] [T |t— e — @ 315° q‘_i_!
- — =
Collections Family Typeface Size [
Al Fonts #RilGH Regular 12 - |
Favorites Apple Chancery El™ el
Recently Used AppleGothic 10 Yy
Classic Apple LiGothic £
Comic Life Apple LiSung ol 4 |
Fixed Width AppleMyungjo 3
Fun Apple Symbols 14
Modern + | Monotype Corsiva |a 16 |5
New-0 v Monotype Sorts | v 24 |7
[+]- [ Search ) I
= x Z |

LEPRRLENO OBBRALEA 7 BgHOvRtC® T W

You’re almost there. But what if you're waiting to insert an updated sales
figure? Or decide it wouldn’t be a bad idea to let off a bit of steam before sub-
mitting your resignation (via the cold harsh world of e-mail)? Click the Save
as Draft button and do whatever it is you do to calm down. When you’re
ready to resume working on the message, demanding a raise instead, choose
Mailbox=>Go To, and click Drafts. Or press 88+3.

Attaching files

You can attach a payload to your e-mail. Attachments are typically word pro-
cessing documents, but they can be any type of file: pictures, music, spread-
sheets, videos, and more.

To send a file with your e-mail, click the Attach button. In the window that
appears, select the file you have in mind from the appropriate folder on your
hard drive.

157
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Figure 10-4:
Changing
the size of a
picture
before
sending the
photo by
e-mail.
|

Given the market dominance of that other operating system, it’s a fair bet
you're sending attachments to a Windows user. Windows is particular about
the files it can read. It wants to see the file extension, such as .doc (see Chapter
7). Because Apple apparently wants to play nice with the rest of the computing
public, all you need to do is check the box that reads Send Windows Friendly
Attachments before sending an attachment to a Windows pal.

Windows users may receive two attachments when you send mail from a
Mac. (And you coulda sworn you sent a single file.) One reads “TheNameofthe
FilelSent” and the other “._TheNameoftheFilelSent.” Your recipients can safely
can ignore the latter.

You'll make everyone happy if you clue recipients in ahead of time if you're
planning on sending them large files, particularly high-resolution images and
video. And by all means refer to the attachment in the message you send. You
should do for a couple of reasons.

v Many Windows viruses are spread through e-mail attachments. Although
you know the files are harmless, your Windows pals may be understand-
ably skittish about opening a file without a clear explanation of what
you'’re sending. Mac users have managed to avoid such headaches.

v Sending oversized attachments can slow down or even clog your recipi-
ent’s e-mail inbox. It can take him or her forever to download these files.
Moreover, ISPs may impose restrictions on the amount of e-mail storage
users can have in their inboxes or in the size of a file that can trans-
ported. The company you work for may enforce its own limits. In fact
some employers prevent staffers from sending messages (or replying to
yours) until they’ve freed up space by wiping out older messages and
attachments.

To get past an ISP’s size restrictions, Mail gives you the option to resize
images. Click the tiny pop-up menu at the bottom-right corner of the New
Message window, which shows up along with the image you are sending. The
menu appears in Figure 10-4.

+ Small
Medium
Large

Actual Size
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|
Figure 10-5:
Spelling
counts.
|

Spell checking

There’s a certain informality to e-mail. Rather than type a sentence that says,
“How are you?” you might instead type “How r u?” But not always.

Spelling counts (or ought to) when you are corresponding with potential
employers or, for that matter, the person currently responsible for your pay-
check. I know you won’t want to be reprimanded if you send e-mail with mis-
spellings to your seventh-grade English teacher.

Fortunately, Apple provides assistance to the spelling-challenged among us.
A spell checker is a basic feature.

To access the e-mail spell checker, choose Mail=>Preferences, and then click
Composing. Under the Check Spelling pop-up (see Figure 10-5), choose As |
Type, When I Click Send, or Never.

@ Mail File Edit View Mailbox Message Format Window Help Z 4) % Tuell:37PM edwardbaig &)
Drafts ()
a
|®enoD Composing =19 Sestch
Subject a
1 g =] A = / =] I .
Ll @ 6 O = [4 £ @& e
General Accounts Junk Mail Fonts & Colors Viewing Composing  Signatures Rules o5 am
test messge | — | 12:23 AM
tst Composing: Message Format: = Rich Text L 1131 PM

4 Check spelling 14

A icall when | click Send
Ul automatically oo g
Addressing: @Aummaticaﬁv complete addrasses ( Configure LDAP... )

# When sending to a group, show all member addresses

[T Mark addresses not in this domain: example.com

Send new mail from: | Account of last viewed mailbox 4

Responding: ] Use the same message format as the original message
Respond using Rich or Plain Text

™ Quote the text of the original message

M Increase quote level

When quoting text in replies or forwards:

() Include all of the original message
@ Include selected text if any, otherwise include all (@)

EEPORLENOO ! PBRLEG T By AOPeC L am * W

Assuming you ignored that last option, the Mail program will underline in red
what it thinks are misspelled words, just as TextEdit and other word processors

159
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do, provided you selected As I Type in the Composing section of Mail Preferences

(which you can access from the Mail menu). Right-click the suspect word and
click the properly spelled word from the list of suggested replacements.

E-Mail etiquette

If Emily Post were alive today, she would surely
draw up a list of acceptable practices for han-
dling e-mails. In her absence, permit me to
school you on e-mail decorum. I've already
mentioned a few proper conventions: It helps to
add a title or subject line to your e-mail and
warn people if you're going to send large
attachments. In some instances, you'll also
want to use Bcc to protect the anonymity of the
other people receiving your messages.

Here are some other conventions. DON'T SHOUT
BY USING ALL CAPITAL LETTERS. Typing in low-
ercase letters like these is much more civilized.
And you will avoid someone SHOUTING BACK
and deliberately insulting, or flaming, you.

Do not forward e-mail chain letters. They will
not bring you or your comrades vast riches. Or
good luck. On the contrary, chain letters have
been proven to cause people to stick needles in
voodoo dolls representing the person who
passed on the chain letter.

If replying to an e-mail, include the original
thread by clicking reply rather than composing
a new message from scratch. If the original
thread does not automatically show up (as is the
case with AOL mail), try this trick. Highlight the
pertinent passages (or all of) the incoming mes-
sage you want to respond to. When you click
Reply, the original text will be there. Tailor your
reply so the responses are right next to the orig-
inal queries.

Keep emoticons, such as : ) — a smiley face —
and text shortcuts, such as LOL (laugh out loud)

and IMHO (in my humble opinion), to a minimum.
You can use these more often when sending
instant messages, as | elaborate in the next
chapter.

In general, keep messages short and sweet.
Some people get hundreds of e-mails a day. If
you want your message to be among those that
are read, don't compose an e-mail that is the
text equivalent of a filibuster.

Take care to ensure that the message is going to
the right place. Nothing’s worse than mistakenly
sending a message that says “Jack is a jerk” to
Jack. For that matter, think long and hard before
sending the “Jack is a jerk” memo to Jill.
E-mails have a life of their own. They can be
intentionally or accidentally forwarded to
others. Maybe Jill is on Jack's side. (They've
been spotted together fetching a pale of water,
you know.) Maybe she thinks you are the jerk.

Along this line, remember that e-mails lack the
verbal or visual cues of other forms of commu-
nication. Maybe you were kidding all along
about Jack being a jerk. But will Jack know you
are merely pulling his chain? To make sure he
does know, this is one instance where it is per-
fectly acceptable to use a smiley.

In general, ask yourself how you'd feel receiv-
ing the same message. And don’t assume your
message will remain private. Think before send-
ing anything in an e-mail that you'd be reluctant
to say in public.

Ignore these suggestions at your own peril.
Somewhere Emily Post is watching.
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P If your spell checker keeps tripping over a word that is in fact typed correctly
(your company name, for instance), you can add it to the spell checker dic-
tionary. Control-click the word and select Learn Spelling from the pop-up list.
Your Mac should never make the same mistake again.

Signing off with a signature

You can personalize Mail with a signature plastered at the bottom of every
outgoing message. Along with your name, a signature might include your
snail mail address, phone number, iChat account name, and a pithy slogan.

To add your e-mail “John Hancock,” choose Mail=>Preferences. Click the
Signatures tab, and then click the Add (+) button. You can accept or type
over the default signature Apple suggests and choose whether to match the
font already used in the message.

Managing the Flood of Incoming Mail

The flip side of sending e-mail, of course, is having to sift through the mess of
messages that may come your way. You can spend hours trying get through
an e-mail inbox, depending on your line of work.

The little red balloon on the Mail icon on the dock indicates the number of
unread messages demanding your attention.

New e-mails arrive as a matter of course through the Internet. You can click
the Get Mail button on the Mail toolbar to hasten the process, as shown in
our little tour of the Mail program in Figure 10-6. Tiny status circles next to
each of your e-mail accounts spin until the number of messages in that
account pop up.

A\
If you click the Get Mail button and nothing happens, make sure your account
isn’t offline (the account name appears dimmed). To remedy the situation,
choose Mailbox and then choose Go Online.

A\ If that too fails to alleviate the problem, choose Window=>Connection Doctor.

It verifies that you're connected to the Internet and examines each e-mail
account to make sure it’s properly configured.
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Figure 10-6:
The drill on
reading
e-mail.

The number of unread
e-mails in the account

Mesages with a blue
dot haven't been read

Drag divider to adjust

Drag bar to adjust window size

Drag slider to scroll through
messages in your inbox

Click column header to

Check out the new events at the Apple Store.
Testing with Gilligan

B Mac Account
5 Gmail

Thanks for renewing!

column width sort by that criteria
@ Mail File [Edit V[ew Mailbox Mefsage Format Window Help ¥ © & |4) sat1:02AM Edward Baig @ ||
08086 Inbox — baiged@mac.com (29 message{, 4 unread) =)
@ ESESES @4 & @ @
Defete  Reply ReplyAll Forward  New  Get Mail Junk Search
=] |2 |* [ ® From Subject Date Received &
("W InBax 2 © Apple " Apple Store Grand Upening, Larden State Plag February Z, 20U 530 PM
TD« Jefferso...  here's the link 10:21 PM

> Drafts
i Stay in touch, share photos, and more
» 1/ Sent [} Keep your important information in Sync
& From: Edward Baig
% '% Trash Subject: Testing with Gilligan
baloed@maccom @3 Date: March 28, 2006 11:25:06 PM EST
§ Mac Account To: (Edwird Bayg
ﬁ Nancy B. He likes the tropical beaches there.

The red balloon on the Mail icon tells you how
many unread messages demand your attention

A;;ﬂi 21, 2006 3
Aprll 24, 2006
Aoril 29, 2006

Single-click an incoming message to read it in the lower pane of the Mail
window. Or double-click the message to read it in a window like you see in

Figure 10-7.
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Hey — Inbox =S

. ]
Delete Junk Reply Reply All Forward Print

From: Edward Baig

Subject: Hey
Date: March 29, 2006 11:25:33 PM EST
To: Edward Baig

Great beaches there

Giligan

|
Figure 10-7:
Opening

mail in its
own
window.
|

Choosing what to read

I'm no censor. I'd never tell you what you should or should not read — online
or off. So know that I have only your best interests at heart when I urge you
to maintain a healthy dose of skepticism when it comes to tackling your
inbox.

As you pore through said inbox, you’ll probably notice mail from companies,
online clubs, or Web sites you might have expressed an interest in at one
time or another. You might have subscribed to e-mail newsletters on subjects
ranging from ornithology to orthodontrics. Most of the mail you get from
these outfits is presumably A-OK with you.

I'll also take it as a given that you're going to read all the e-mails you get from
colleagues, friends, and family. Well, maybe over time you’ll come to ignore
mail from Uncle Harry and Aunt Martha, especially if they insist on sending
you the lamest of joke lists. If your mother is now using e-mail to hassle you
about how you still aren’t married, you have permission to ignore those too.
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That leaves e-mail from just about everyone else, and it likely falls into one of
three buckets. These categories fit most people’s definition of junk mail, or
spam:

v They’re trying to sell you something. If might be Viagra or Xanax. It
might be a (supposedly) cheap mortgage. It might be a small-cap growth
stock. It might be a Rolex. It probably means trouble.

v They’re trying to scam you. You have to ask yourself, why me? Of all the
deserving people on the planet, how is that you have been chosen by a
private international banking firm to collect a small fortune left by a rich
eccentric? Or the secret funds hidden by a deposed Third World diplo-
mat? This too will probably get you in a pickle. (In Chapter 13, I discuss
a special type of scam known as phishing.)

1 They’re sending you pornography. It’s out there. In a major way.

Opening mail from strangers

What was it your parents taught you about not talking to strangers? That’s
generally sound advice with e-mail too. As I hinted at in the preceding section,
cyberspace has a lot of misfits, creeps, and (I knew I'd have to throw this
phrase somewhere in the book) bad apples. They’re up to no good. Because I
don’t want to cast aspersions on every unknown person who sends you
e-mail, go with your gut. Common sense applies.

You can learn a lot from the subject line. If it refers to someone you know or
what you do, I don’t see the harm in opening the message.

If the greeting is generic — Dear Wells Fargo Customer; Get Out of Debt Now —
I'd be a lot more cautious. Ditto if there’s no subject line or there are gross
misspellings.

If a sender turns out to be a decent business prospect or your new best
friend, you can always add him or her to your Address Book by choosing one
of the following alternatives.

v Choose Messager>Add Sender to Address Book.

v Right-click a sender’s name or address in the From line of a message and
select Add to Address Book. (If you have a one-button mouse, the alter-
native is Ctrl-click.)

A few other handy shortcuts appear when you right-click a sender’s name.
You can Copy the person’s Address, reply to the person, send him or her a
new message, create a smart mailbox (more on this later in this chapter) or
run an instant Spotlight search on the person.
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Junking the junk

If senders turn out to be bad news, you can sully their reputation. At least on
your own computer. Throw their mail into the junk pile. It’s easy: Just click
Junk on the message toolbar.

Marking messages happens to be your way of training the Mail program in
what you consider spam. Apple updates its databases accordingly. The com-
pany flags potentially objectionable mail by highlighting messages with a
brown tinge. Click Not Junk in the message if Apple applies the junk label to
the innocent.

You can direct Apple on how to handle the junk. Choose Mail=>Preferences,
and then click the Junk Mail tab. The screen shown in Figure 10-8 appears.

By default, the Mail program leaves junk mail in your inbox so that you get to
be the final arbiter. If you want Tiger to segregate suspect mail in its own
mailbox, click the Move It to the Junk Mailbox option.

As a matter of course, Apple exempts certain messages from spam filtering.
This includes mail from senders who are in your Address Book, as well as
senders who already received mail from you. Messages that use your full
name are also exempt. In the Junk Mail section of Mail Preferences, remove
the check mark next to any Mail preferences you want to change.

Most reputable ISPs attempt to fight spam on their own. If you're satisfied
with the job they’re doing, leave the box “Trust junk mail headers set by my
Internet Service Provider” checked. Apple’s Mail program will leverage your
ISP’s best efforts.

Junk Mail (]

i @ Bl O m Y £ MR

General Accounts Junk Mail Fonts & Colors Viewing Composing Signatures Rules

[ Enable junk mail filtering

When junk mail arrives:
(=) Leave it in my Inbox, but indicate it is junk mail (Training)
) Move it to the Junk mailbox (Automatic)
) Perform custom actions (Click Advanced to configure)

The following types of messages are exempt from junk mail filtering:

Z Sender of message is in my Address Book
z Sender of message is in my Previous Recipients
z Message is addressed using my full name

'Z'Tlus[junk mail headers set by my Internet Service Provider

()

( Advanced... ) ( Reset.. )
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Tips for avoiding spam

You can do your part to eliminate spam too. Spammers are resourceful and
can get your e-mail address through various methods:

v They employ automated software robots to guess at nearly every possi-
ble combination of addresses.

v They watch what you're doing. Do you fill out online sweepstakes forms?
There’s a winner, all right, the spammer.

v Do you hang out in chat rooms and Internet newsgroups? Bingo.

v Do you post messages in a public forum? Gotcha again.

You can stop engaging in these online activities, of course, but then the
Internet won'’t be nearly as much fun. [ have a better idea. Set up a separate
e-mail account to use in these out-in-the-open kinds of scenarios. (ISPs such
as AOL let you set up myriad accounts or screen names.) You'll still get spam
there. Just don’t bother using those accounts to send or receive e-mail.
Instead, treat your other account or accounts as the sacred ones you share
with family, friends, and colleagues.

Setting the rules

Potent as Apple is at filtering spam, you can set up your own filters, or rules,
for combating junk. But you can set rules also to automatically reorganize the
messages on hand that are perfectly acceptable. When incoming mail meets
certain conditions such as who sent the mail or the subject matter, the Mail
program automatically forwards, highlights, or files them accordingly. For
instance, you might want to redirect all the messages you’ve received from
your investment advisor into a mailbox named stock tips.

To set up a rule, follow these steps:

1. Choose Mail=>Preferences, and then click the Rules tab.

2. Select Add Rules to open the pane shown in Figure 10-9.
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Description: How to get rich

If | all ) of the following conditions are met:

From + | | Begins with s | wbuffett

@)

Perform the following actions

Move Message 4+ to mailbox: | [ stocktips =]

(l)(l\
@)

Set Color 7% [of backaround +! | [IGreen

I

[ Cancel ) € oK

3. Choose parameters identifying which messages are affected by the
rule.

To redirect e-mail from your financial guru, for example, choose From in
the first box, Begins With in the second box and the name in the third.

4. Now choose parameters for what happens to those messages.

In this instance, those messages will be highlighted in green and moved
to the stocktips mailbox.

5. When you’ve finished entering parameters, click OK.

Smart mailboxes

In Chapter 6, you discover dynamic smart folders. Welcome to the e-mail vari-
ation, smart mailboxes. Just as smart folders are constantly on the prowl for
new items that match specific search criteria, smart mailboxes do the same.
They are tightly integrated with Tiger’s Spotlight search technology.

You can set up smart mailboxes as a way to organize all mail pertaining to a
specific project or all mail from a specific person. For instance, you might
want to create a smart mailbox containing all correspondence with your boss

for the most current fortnight. Mail older than two weeks is replaced by the
latest exchanges.

Incidentally, the messages you see in a smart mailbox are virtual; they still

reside in their original locations. In that sense, they are similar to aliases,
described in Chapter 7.
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To create a smart box:

1. Choose Mailbox=>New Smart Mailbox.

The screen shown in Figure 10-10 appears.

2. Use the pop-up menus and text fields to characterize the parameters of
the mailbox.

The process is similar to the one you follow when creating a rule. To add
criteria, click the + button. To remove a condition, click the - button.

3. When you’re finished, click OK.

Smart Mailbox Name: The boss
Contains messages which match  all %) of the following conditions:
|
From ) Begins with £ headhoncho@mycompany.com [ :
Figure 10-10: ———— — e —— Bt e
Date Received ) [is in the last 2 Weeks 3 =3 (F
The 2 &
Subject + || Contains ) Bonus &) (&
smartest . . ~
mailbox | —
_! Include messages from Trash
around. linclude messages from Sent ‘.\: Cancel ‘ '\. oK )
|

Searching mail

With an assist from Spotlight, the Mac’s fast and comprehensive search system,
you can find a specific e-mail messages, or the content of those messages, in a

jiffy.
v To search an open message, choose Edit~Find and type the text you're
looking for.
» You can also enter a search term in the search box at the upper-right
portion of the Mail program screen. Use the All Mailboxes, Entire

Messages, From, To, or Subject headers (which appear only when you’ve
entered a search) to determine how to display the results.

Opening attachments

You already discovered how to send attachments. But now the tide has
shifted, and someone sends you one (or more). Attachments appear with an
icon in the body of the message, as shown in Figure 10-11.
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You'll find this amusing — Inbex
sl - ™
Junk Reply Reply All Forward Print
From: Ed Balg
Subject: You'll find this amusing
Date: April 30, 2006 B:35:25 PM EDT
To: Edward Baig
» 4 1 Attachment, 195 KB ( Save = |

Pertaining 1o your favorite balliub...

| o
Figure 10-11: | now bour th...doc (19.5 kB)
Attachments
show up
with anicon
in the
message
body.

You have a few choices:

v Drag the icon onto the desktop or a Finder window.

v Double-click the icon, and the attachment should open in the program
designed to handle it (for example, Word for a Word file or Preview for
an image).

v Click Save to save the file to a particular destination on your computer.

“&N\BER Normally, I tell people not to open attachments they weren’t expecting, even
3 if they know the sender. Mac users can be a little more relaxed about this
than their Windows cousins. While the times they are a-changin’, the odds
that the attachment will damage the Mac, even if it did carry some type of
Windows virus, are low.

QP If you want to remove an attachment from an incoming message, choose
Messager>Remove Attachments. As a reminder, the body of the message will
include a line telling you that the attachment in question has been “manually
removed.”

Making the Most of Your Mail

Before leaving this chapter, I want to introduce other ways to get the most
out of your e-mail:
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1 View a photo slideshow: Picture attachments are afforded special treat-
ment. Click the Slideshow button that appears when someone sends you
pictures and you can view the attached images in a lovely full-screen
slideshow. From an on-screen control panel, you can go back to the pre-
vious image, pause the slideshow, or advance to the next slide. You can
also click to add pictures to your iPhoto library (see Chapter 15). When
you’re finished with the slide show, press the Escape key on the key-
board to go back to the original e-mail.

1 Pass it on: Sometimes you get stuff that is so rip-roaringly hysterical (or
at the other extreme, tragic and poignant) you want to share it with
everyone you know. To forward a message, click the Forward button
inside the e-mail and enter the recipient’s address in the New Message
window that pops up. The entire previous e-mail will go out intact, save
for a couple of subtle additions: the Fwd: prefix in the Subject line, and
the phrase “Begin forwarded message” above the body of the message.
You can add an introductory comment along the lines of “This made me
laugh out loud” or “I'm sorry to have to call this to your attention.”

v Synchronize e-mail: If you have a .Mac account (Chapter 12), you can
synchronize all your rules, signatures, and other settings across all your
Tiger computers.

1~ Use parental controls: You can restrict who junior can correspond with
through e-mail to only those addresses you've explicitly okayed. Visit
System Preferences under the % menu and choose Accounts. You'll be
notified when your kid gets (or tries to send) messages to addresses not
on your authorized list.

v Get rid of mail: You can dispose of mail in a number of ways. Highlight a
message and press Delete on the keyboard. Drag the message to the
Trash folder. Or click the Delete button on the toolbar. The messages
aren’t permanently banished until you choose Mailbox=>Erase Deleted
Messages. Apple can automatically extinguish mail for good after one
day, one week, or one month, or when you quit the Mail program. To set
this up, go to Mail Preferences, click Accounts, choose an account, and
select Mailbox Behaviors.



Chapter 11

Caught Up in the Web

In This Chapter

Joining chat rooms

Communicating through instant messages
Digging through newsgroups and blogs
Socializing through social networking
Finding a mate online

Shopping online

Calling on Sherlock

F)lks routinely surf the Web seeking specific types of information.
Headlines, stock quotes, vacation deals, weather, homework help, sports
scores, and technical support. But as much as anything, the Internet is about
meeting and connecting with people. These people could be job prospects or
would-be employers. Or people who share your zeal for the Chicago Cubs,
sushi, and Macintosh computers. Persuasion takes on a major role in cyber-
space too. You'll get on your virtual high horse and attempt to coax others
around to your way of thinking.

And, yes, finding companionship, romance, and (under the best of circum-
stances), long-lasting relationships is part of the cyber-experience too.

Critics have often sneered, “these people need to get a life.” But many
Netizens (citizens of the Internet) have rewarding lives online and offline,
thank you very much. And on the Net, they’'re congregating in vibrant commu-
nities with individuals of similar interests and passions.

We’ll explore many of these avenues in this chapter.
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Chat Rooms
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Alot of congregating on the Net happens in chat rooms, areas where you can
converse in real time on pretty much any topic: knitting and quilting, cricket,
fad diets, parenting, biotechnology, model airplanes, extraterrestrial sightings,
and on and on. The conversing has typically been left up to your fingertips.
Indeed, typos be damned; expect to bang away at the keyboard with reckless
abandon because text exchanges in chat rooms come fast and furious. There
may be a few dozen people or more in a room. Good luck determining who’s
talking to whom.

As broadband hookups becoming increasingly common, audio and video
chats (through the use of a small cameras called webcams) are likewise
becoming more widespread.

Chat is also a staple in the online gaming environment. In an immersive three-
dimensional virtual fantasy world, your persona may be represented by an
animated avatar. One such setting (available to Mac users with a recent ver-
sion of OS X) is called Second Life (www.secondlife.com). Be aware that
the environment sometimes exceeds PG-13 sensibilities.

Some chat rooms are monitored by people who make sure that the discourse
is civil and courteous. In rare instances, monitors may dictate who can and
cannot speak, or they may boot somebody out.

The first exposure many people had to chat rooms was inside the virtual con-
fines of America Online. AOL established a set of community guidelines, mostly
having to do with banning hateful speech as well as threatening or abusive
behavior. As you can see in Figure 11-1, the subject categories in chat rooms are
quite varied. AOL’s primary rivals, Yahoo! and MSN, run their own chat areas.

[ tell people visiting a chat group for the first time to say hi to everyone and
then take a backseat. Observe. Get a feel for the place. Figure out whether
participants are around the same age (or maturity level) as you. Determine
whether they’re addressing topics you care about — and speak the same lan-
guage. Participants in these joints come from all over the planet (and some-
times it seems from outer space).

Along those lines, don’t be surprised if it appears as though members of the
chat community are typing in tongues. You’ll notice strange uses of punctua-
tion and abbreviations. Check out the “And you thought mastering Latin was
difficult?” sidebar for a crash course in emoticon linguistics.



Chapter 11: Caught Up in the Web 1 73

ilels AOL Chat Room Listings

AOL Chat Room Listings

Search All Chats by Topic:
eare el Fealing Flirtatiously Frisky?
‘ | (search | Get romantic with these chats.

» Plus: More Relationships
Created by People Connection

1 ,,,"“m"":;’ggw 2 Double-click to enter a room: @ Start Your Own Chat
| Category | ‘ People Rooms in 'Mews, Sports & Finance' | © Enter or Start Private Chat
Cheerlsading

‘Black Vaicas
3  Debate Poltics
Friends | | Don't Touch That Dial ..
7 Chat about it here.
| i Extrame Sports your saul? Chat about it hare.

- Alternative | Country | 805

Gay & Lashian ‘ 2 Entrapreneur | J What kind of music speaks to

— Lite 3 From the Left Gothic | Heavy Metal | Hi-Hoo
. . News, Sparia & Finanza | [| % Fromme Rt + Oldies | Pog | Punk | Rock
Flglll'e 11-1: Plaes Gun Cantrol
. Gymnastics
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Spendmg Jiomence ‘ . e What ¥a Think About That?

) N Special Interests \ ’ i Find avery topic undar
time in AOL [This Genaratian - Hamsland Security v Q 1| the sun and shara

\AOL Puerto Rico | - = = = your opinion,
chat rooms. E [ Go Chat J [ Who's Chatting ] | More |

Keyword- Boards
I ADL Keywaord: Chat Room Listings

And you thought mastering Latin was difficult?

Becoming fluent in the lingo of chat rooms and instant messaging is crucial if you want to fit in or
merely understand what's taking place. However, remember to resist the overuse of emoticons in
your e-mails and real-world correspondence.

Common Emoticons Common Acronyms

:) = smile BTW = By The Way

;) = wink ROTF = Rolling On The Floor (Laughing)
:D = laughing LOL = Laugh Out Loud

:(=frown IMHO = In My Humble Opinion
’(=crying BRB = Be Right Back

>:-} = a devil TTFN = Ta-Ta For Now

0:-) = an angel GMTA = Great Minds Think Alike
{}=hug F2F = Face to Face

* =kiss FOAF = Friend Of a Friend

:P = sticking out tongue WB = Welcome Back
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Communicating One-on-One:
Instant Messaging

You may be speaking (broadcasting really) to dozens of people at a time in a
chat room. But what if you strike a bond with the mysterious stranger whose
quips catch your fancy? And want to whisper sweet nothings behind this
person’s ear and no one else’s? Such intimacy requires a private conversa-
tion. It requires an instant message, or IM.

Instant messages need not originate in chat rooms, and for most people they
do not. Participants instead rely on dedicated instant messaging client soft-
ware that can be downloaded for free from AOL, Yahoo!, Microsoft, and
Skype.

Just as the company did with e-mail, AOL gets the lion’s share of the credit
for spreading IMing — yes, you can treat it as verb — among the masses in
the United States. AOL owns the popular AOL Instant Messenger, or AIM, soft-
ware, as well as the exceedingly popular global IM program, ICQ. You can
fetch these free without joining AOL at www.aim.com and www. icqg. com,
respectively. In fact, as we’ll see shortly, you need not even download AIM,
because Apple’s own iChat program lets you kibitz with the AIM community.

Instant messaging has become a mainstay in business as well as in social cir-
cles. It’s a complement to e-mail and in many ways more appealing. Here’s
why: Just as in a chat room, instant messaging conversations occur in real
time, without the delays associated with e-mail. In addition, IM permits the
kind of spontaneity that’s not possible through e-mail or even an old-fash-
ioned phone call. Through a concept known as presence, you can tell not only
whether the people you want to IM are currently online but also whether
they’re willing to chat. Status indicators next to their names on a buddy list
clue you in on their availability.

Instant messaging has at least one major downside compared to e-mail and
the plain old telephone: the lack of interoperability among the major IM pur-
veyors. For competitive reasons, market leader AOL carefully guards its
buddy list, so an AIM member can’t send a direct instant message to a Yahoo!
or MSN user, at least not without techie workarounds. Think about what
would happen if a Verizon cell phone customer, say, couldn’t call a friend who
was a Cingular subscriber, and vice versa.

Just as regular chat has evolved well beyond a text-only communications
channel, so has instant messaging. Today’s IM programs let you engage in
audio exchanges and make free computer-to-computer Internet phone calls.
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Moreover, if you have a webcam — and owners of certain new Macs are
blessed with built-in iSight cameras — you can also hold face-to-face conver-
sations. And that leads us to Apple’s own ever-evolving instant messaging
application, iChat AV.

iChat AV

In truth, calling iChat AV an instant messaging program is selling it way short,
kind of like telling somebody that Michael Jordan knows how to make free
throws. The AV part stands for audio visual or audio video, depending on who
you ask.

So yes, iChat is a competent instant messenger for handling traditional text
chatter. But consider some of iChat’s other tricks:

»* You can exchange files while talking with someone.
» You can have a free audio conference with up to nine other people.

»* You can engage in a video conference from your Mac desktop with up to
three other people.

You'll need at least one of the following to get going with iChat:

v An existing AIM or AOL screen name and password. As noted, iChat is
tied in with AOL’s popular instant messaging program.

v A Jabber ID. You can use a Jabber ID to exchange messages with
cohorts who share the same Jabber servers. Jabber is an open standard
chat system employed in many organizations. Through Jabber, you can
exchange instant messages with a Google Talk member. Although iChat
is still not directly compatible with screen names from the MSN or
Yahoo! instant messaging systems, you may be able to do a technologi-
cal workaround through Jabber.

* By using or signing up for a fee-based .Mac account. You can get a free
.Mac account just for the purposes of using iChat by sampling all the
other .Mac features on a trial basis. (You have to pay to keep using these
other features, which I elaborate on in Chapter 12; you can hold onto
your iChat account for as long as you want.)

v On a local network or in a classroom using Apple technology called
Bonjour, formerly known as Rendezvous. Through this built-in technol-
ogy, iChat lets you see who on your local network is available to chat.
Bonjour, however, is used for configuration-free networking throughout
OS X.

175
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Figure 11-2:
Adding new
buddies to
the list.
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If you want to exploit video, you'll need a fast broadband Internet connection,
plus a compatible camera. Apple’s own iSight camera (standard on recent
iMac and MacBook Pro models) works well, but any FireWire-based camera
should do. You'll also need a Mac with OS X version 10.2.5 or later.

Hey buddy

Naturally, iChat AV is useless without one more essential component: At least
one other person with whom to schmooze. If you signed up with an AIM
account and have been using AOL’s instant messenger for awhile, your buddy
list may already be populated with a bunch of names.

To add new people to the list, click the + button at the bottom of the Buddy
List window, choose Buddies>Add Buddy, or press Shift+8+A. You're given
the option to choose an entry from your Address Book. (Data you put there is
made available to iChat.) Otherwise, click New Person to add, well, a new
person. You type the person’s chat name (under Account Name) and fill in
the other blanks shown in Figure 11-2. The person’s name turns up instantly
on your buddy list. A buddy list is as long as you are popular.

Enter the buddy's AIM screen name or Mac.com account:

Account Type: | .Mac 4

Account Name: dummieswriter @mac.com

Address Book Information {optional):

First Name: Ed

Last Name: Baig
Buddy
lcon Email: @mac.com

( Cancel ) [ Add

You can also lump your buddies into groups (such as co-workers and soccer
team). To do so, Choose View=>Use Groups and click + to add or edit a group.

The buddy list has a bunch of visual status cues. Your buddy may have
included a mug shot, perhaps through the Mac’s Photo Booth feature (see
Chapter 5). Or your buddies may express themselves through small images
called buddy icons. What’s more, a telephone symbol tells you whether you
can connect through voice, and a movie camera icon indicates that you can
connect through video, as shown in Figure 11-3.
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Mostly you'll be able to tell whether your buddies are online at the moment
and willing to give you the time of day. Here’s how:

v A green circle to the left of a person’s name means he or she is ready
and (presumably) willing to talk.

v A red circle means the person is online but otherwise engaged. The
person is considered Away.

v A yellow circle means the person on your list is idle and has not used
the machine for awhile (the window tells you how long the person has
been in this state). Your buddy just hasn’t bothered to change his or her
status from Available to Away.

v If a name is dimmed, your buddy isn’t logged on to iChat or AIM.

P You can set your own status for everyone else to see. And you are not limited
to Available or Away. Click under your own name and choose Custom from
the drop-down list. You can choose a custom message to appear next to a
green or red circle, depending on your circumstance. Type any message you
want, such as, can chat in a pinch but busy or back after lunch.

177
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Incidentally, if you've been absent from the computer for awhile, the Mac will
kindly welcome you back to the machine and ask whether you want to
change your iChat online status from Away back to Available.

Chatting

To initiate an instant message, double-click a name in the buddy list, which
pops up whenever you open iChat. Type something in the bottom box. Hey
stranger will suffice for now.

Alternately, you can chose File>’New Chat and enter the name of the person
with whom you would like to chat. This can be done even if the individual is
not in your buddy list or Address Book.

What you type instantly appears in a comic-strip bubble in the upper portion
of the window. If the person responds, what he or she has to say appears in
its own comic-strip bubble. And so on.

To illustrate this point, check out Figure 11-4. It shows yours truly having a
silly conversation with yours truly. (Honestly, [ don’t normally talk to myself.
This little exercise is strictly for the benefit of the reader.)

M Chat with Edward Baig

32 PM
" hello”

Hey big guy. You look familiar

that's bic I'm u silly dude. (2*/

ifigured 1 was something like that

ranch?

yaa, 'm writing this dummies book

(<)
“
“s0 anything new down atthe @
@

kewl o] |

Now say you're having an important IM exchange with your lawyer or
accountant. Or swapping tuna casserole recipes with your best friend. You
may want a record of your conversation that you can easily refer to later. To
create a transcript of your chitchatting, open iChat Preferences, shown in
Figure 11-5. To do so, click the iChat menu and then click Preferences. Choose
the Messages icon and then select the Automatically Save Chat Transcripts
option.
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You can tell your IM chums what music you are
listening to in iTunes. From the iChat drop-down
list indicating your availability status, choose
Current iTunes Track. This serves a few pur-
poses, best | can tell. For one thing, your pals
will discover how hip you are (assuming they
don't know it already). What's more, you
become an influencer: If your friends click your

Sharing a tune

musical selection, they can preview the song in
the iTunes Music Store (Chapter 14). If your bud-
dies purchase ten or more of the songs you're
listening to over a two-week period, Apple
sends you a computer. Okay, so | made the last
part up. But know this: Steve Jobs will really like
you.

P You can use iChat also to send files to your IM buddy (or get a file in return).
Not only is it convenient, but unlike with e-mail there’s no size restriction on
the file you're sharing. (You can send only one file at a time, however.) Select
a name on your buddy list and then choose Buddies=>Send File. Select the file
you want to send. Alternatively, drag a file to a buddy’s name or into the area
of an open chat window. Either way, your buddy has the option to accept or

reject the incoming file.

While we’re on the painful subject of rejection, if one of your buddies (or

anyone else) initiates an IM and you don’t feel like talking, click Decline in the

window that pops up.

Messages
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If the person gets on your nerves, click Block to prevent the person from ever
sending you IMs again. (Just know that your would-be buddies can do the
same to you.)

You can proactively determine who can see that you're online and send you
messages. Under iChat Preferences, click the Accounts icon and then click
the Security tab. Choose a Privacy Level that you're comfortable with. The
options are

v Allow anyone.
v Allow people in my buddy list.

v Allow specific people. If you make this choice, you have to type each
person’s AIM or .Mac address.

v Block everyone.

v Block specific people. Again, type the appropriate addresses.

Seeing is believing; hearing too

As I already alluded to, IMing and text chatting in general are kind of yester-
day’s news (though still darn useful). The twenty-first-century way of commu-
nicating is through a video phone call. (Never mind that a primitive version
of this technology was exhibited at the 1964 New York World’s Fair.)

Assuming your camera and microphone are configured to your liking, click
the video camera icon in the buddy list or, for just an audio session, click the
telephone icon. Members of your buddy list have little icons next to their
names too; these icons are telephones or video icons depending on their
respective configurations.

As usual your IM partner has the option to accept or decline the invitation. If
he or she accepts, you can gaze at each other full screen.

This stuff is super slick. In a multiroom conference, participants appear in a
virtual three-dimensional conference room with authentic video effects that
make people’s reflections bounce off a conference table, as you can see in
Figure 11-6.

The quality is generally pretty good, though the picture may show some dis-
tortion, depending on your cable or DSL connection.

The video used in iChat (and QuickTime) adheres to a video standard known
as H.264 or Advanced Video Codec (AVC). It’s meant to deliver crisp video in
smaller file sizes, saving you bandwidth and storage.
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Figure 11-6:
Videocon-
ferencing
through
iChat AV.

Courtesy of Apple

If you have a webcam but your IM buddies do not, they still get the benefit of
seeing your smiling face at least. And provided they have a mike, you still get
to hear them.

Having an Online Voice

There are lots of places on the Internet for you to be heard and seen. In this
section we explore some of these places.

Newsgroups

The term newsgroups may make you think of journalists retreating to the
nearest watering hole after deadline. (Been there, done that.) Or a posse of
friends sitting around together watching, [ dunno, Katie Couric. Newsgroups
are defined differently in the chapter you are so kindly reading.

Newsgroups go by numerous descriptors: electronic (or online) bulletin
boards, discussion groups, forums, and Usenet (a techie name that dates
back to Duke University in the late 1970s). Google acquired the Usenet
archives in 2001; through Google Groups, you can read more than one billion
Usenet postings dating back to 1981.
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In a nutshell, people post and respond to messages on everything and any-
thing: pipe smoking, low-carb diets, monster movies, world-class tenors,
nanotechnology, canine incontinence, alternative sources of energy, snake
charmers ... Thousands of these discussions are taking place online.

Newsgroups generally adhere to a hierarchical structure. At the top level,
you'll see comp for computers, rec for recreation, sci for sciences, soc for
socializing, talk for politics, news for Usenet, misc for miscellaneous. alt for
alternative and so on. As you move down the food chain, the categories
become more specific. So you might start at alt, then drill down to

alt. animals, then alt.animals.cats, then alt.animals.cats.siamese.

You’ll need a newsgroup reader program to read these posts. If you bought
Microsoft Office for the Mac, it includes a newsreader in the Entourage e-mail
program.

You can also download free or low-cost shareware newsreaders for the Mac.
They go by names such as Hogwash, MacSoup, MT-NewsWatcher,
NewsHunter, Thoth, and Unison.

Blogs

Blogs, or weblogs, have become an Internet phenomenon. The blogging
search engine Technorati is tracking more than 47 million blog sites and
counting. Some 70,000 new blogs pop up every day, and there are about
700,000 posts daily.

Although still in its relative infancy, the blogosphere has already been
exploited by politicians, educational institutions, marketers, publicists, and
traditional media outlets. And as you might imagine, you can also find Mac-
related blogs, such as blog.wired.com/cultofmac, www. tuaw.com (The
Unofficial Apple Weblog), and www . theappleblog. com.

Some bloggers may dream of becoming journalistic superstars overnight,
though few achieve such status. And many in the mainstream media fret that
bloggers lack editorial scrutiny and journalistic standards. But most blogs are
nothing more than personal journals meant to be read by a tight circle of
friends and family. Bloggers share their musings, provide links to other con-
tent, and invite comments from others.

Destinations for creating and hosting a blog include Google’s free Blogger.com
service, WordPress, also free, and SixApart’s TypePad (starting at $5 a month).
You can subscribe to or read other blogs through technology known as RSS.
See the “What the heck is RSS?” sidebar? for more information. You can use
the Mac’s new iWeb program to publish a blog through the .Mac service ($100
ayear).



What the heck is RSS?

Blogs and other news feeds are distributed
through a technology known as RSS, shorthand
for Really Simple Syndication. You can view RSS
feeds in a Safari browser (they're sometimes
called XML feeds). When you subscribe to an
RSS feed, you'll get a barebones summary (and
title) for articles listed, such as the feed shown
here from my USA TODAYtech column. You can
click the Read more link to check out the full
article. If Safari finds a feed, RSS appears in the
address bar, as shown in the figure.

If you want to be notified when new feeds arrive,
go to Safari preferences (found in the Safari
menu), click RSS, and select how often to check
for RSS updates (every 30 minutes, every hour,
every day, or never). To peek at all RSS feeds
(from multiple sites) at one time — a greatway to

customize your own newspaper, in effect —
place all your feeds in a single bookmark folder.
Then click the folder’s name and choose View All
RSS Articles.

You can even turn your RSS feeds into a cool
screensaver with flying news headlines that
charge at you like the credits in a Tinseltown
blockbuster. Choose System Preferences under
the & menu, click Desktop & Screen Saver, and
then click the Screen Saver tab. Next, in the
Screen Savers list, click RSS Visualizer. Then
click the Options button and select a specific
RSS feed. If you want to read the underlying
news story, you'll be instructed to press the 1
key to read one feed, 2 key to read another, and
S0 on.
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Being a pioneer is fraught with risks. Take the gorgeous, black $3,500 Sony Vaio VGN-AR180G notebook Is the first laptop with & built-in recordable Blu-
ray drive. But the computer is outrageously expensive. And it Is saddled with stubborn technical snags around disc burning and playback

Read more...

Samsung's new Blu-ray DVD player is pretty nifty and pretty pricey

On Sunday, Samsung launches the first stand-alone next-generation DVD player based on Blu-ray high-definition technology. The debut comes seven
‘weeks after | reviewed Toshiba's HD-XA1, which uses a rival high-definition DVD format known as HD DVD.
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Social Networking

Who do you know? Who do your friends know? Who do the friends of your
friends know? Oh, and how can I benefit from six (or many fewer) degrees of
separation?

That’s pretty much what online social networks are all about. By leveraging
your direct and indirect contacts, you might find a place to live, broker the
deal of the century, or land a recording contract. That’s the hope anyway.
Hate to be a glass-is-half-empty kind of guy, but none of these outcomes is
guaranteed.

Still, social networking sites can help you network and help you be social.
They may combine blogs, instant messaging, photo sharing, and other tools.
Some are difficult to pigeonhole, so don’t take offense if the dozen sites listed
next don'’t fit the classic definition of social networking, assuming there is
such a thing:

V¥ www.classmates.com: Looking for an old high-school flame? An Army
buddy? Classmates is a good place to wax nostalgic and find reunions.

V¥ www.craigslist.com: A network of global community sites in dozens
of international cities with forums and free classifieds advertising jobs,
gigs, housing, personals, and more.

v www . facebook . com: Social networking on the college campus and in
select corporations.

v www . f1ickr.com: Image sharing site (owned by Yahoo!). Members tag
their uploaded pictures so they can be discovered by others.

v www . friendster.com: An early pioneer in online social networking,
with more than 27 million member profiles.

V¥ www . imeem. com: Instant messaging meets social networking.
V¥ www . jokebox . com: Billed as MySpace.com meets Comedy Central.

V¥ www.linkedin.com: Geared toward helping you with business and pro-
fessional connections.

V¥ www . MySpace. com: A popular hang-out (more than 70 million mem-
bers) for young people, including burgeoning musicians. Now owned by
Rupert Murdoch’s News Corp.

v www .orkut . com: An invitation-only community owned by Google that
seems to attract an intelligent crowd.
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V¥ 360.yahoo.com: A place to share blogs, pictures, recommended books,
music, movies, and more.

V¥ www .youtube.com: A place to upload and share amateur videos, includ-
ing bootleg footage from concerts.

The Virtual Meet Market

As you might have surmised by now, Cupid spends a lot of time on the
Internet. You may even run into him in one of the aforementioned social net-
working sites. But if you're determined to find a mate in cyberspace at all
costs, the direct approach is probably best. Dating sites often let you peruse
online personals and fill out detailed online profiles for free. With some varia-
tion in subscriptions and fees, they typically start charging only when you’re
ready to get in touch with Mr. or Ms. Right.

Rest assured, there’s a dating site to fit your lifestyle. Online matchmakers
focus on particular communities, political beliefs, sexual preferences, religions,
hobbies, and even love of four-legged creatures (check out datemypet . com).

The following sites are among the major mass-market online matchmaking
destinations:

V¥ www . americansingles.com: Lets you send “flirts,” or one-liners, to
members you're interested in. The object of your affection can flirt back
if he or she so desires.

V¥ www . eharmony . com: For the marriage-minded. eHarmony eschews the
term dating site and is instead an online matchmaker that attempts to
find people it thinks are right for you. Founder Dr. Neil Clark Warren says
he has identified the 29 “dimensions” of compatibility that make for a
successful, long-term relationship. (I don’t think it’s among the blessed
29, but it helps if you and your potential mate both have Macs.)

v www .match.com: Features relationship insights from Dr. Phil.

V¥ personals.yahoo.com: Offers two pay services — basic membership
for casual daters and premium membership for those seeking serious,
long-term relationships.

V¥ www . true.com: Says it will prosecute married men and criminals who
try to use the service.
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A few important disclaimers: [ take no responsibility for who you meet online
through these or other Web sites (unless it works and then you can invite me
to the wedding). And I can’t predict what kind of sparks will fly if a Windows
user pairs up with Mac loyalist.

Buying Stuff Online
Grandpa, what was it like when people shopped in stores?

I doubt you’ll hear such a conversation anytime soon. But more and more
people are purchasing products online, and those products are not just books,
music, and software. Increasingly, folks go to the Net to shop for big-ticket
items: backyard swing sets for the kiddies, high-definition televisions, and
even automobiles. Electronic commerce, or e-commerce, is alive and kicking.

Shopping over the Internet has many plusses. For example:

+ You avoid crowds and traffic.
* You save on gas or commuting costs.
»* You avoid pushy salespeople.

» You can easily compare products and prices across numerous Web sites,
increasing the likelihood that you’ll end up with an excellent deal. Visit
such comparison shopping sites as www.mysimon.com, www.price-
grabber . com, and www.shopzilla.com.

» You can choose from a large inventory of products (which is not to sug-
gest that stuff won’t be out of stock).

»* You can get buying recommendations from your cyber-peers.
Shopping online has a few negatives too:
» You can’t “kick the tires” or otherwise inspect the items under
consideration.
»* You won't get personal attention from a reliable salesperson.
»* You might get spammed.

v Without proper safeguards, your privacy could be at risk.
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v Instant gratification becomes an oxymoron, except on such items as
downloadable software and music.

+* You can’t make goo-goo eyes with attractive strangers you might meet
cruising the aisles.

Amazon.com

As an e-commerce pioneer, Amazon.com is probably still best known for sell-
ing millions of discounted books online. But you can shop for items across
more than 30 product categories, from video games and computers (includ-
ing Macs) to gourmet foods and pet supplies.

Before spending any loot on a book or other merchandise, you can read online
reviews from fellow customers. You might also want to consult the “Customers
who bought this item, also bought this” list. Amazon has been at the forefront
of many online shopping initiatives, including 1-Click Shopping (rapid way to
process an order as long as your credit card and shipping info are on file) and
Wish List (letting folks know what you want for your birthday).

Indulging the eBay addiction

[ don’t know who first uttered the cliché “one person’s junk is another
person’s treasure,” but he or she could have been describing eBay. The famed
Internet auction site has listings for more than 10 million items in thousands
of product categories, and more than 100 million registered users. Many
buyers are insanely obsessed — and believe me I say that with affection.

eBay is the ultimate garage sale. It’s only a slight exaggeration to suggest that
if you can’t find the thing you're looking for on eBay, you probably can’t find it
anywhere. Many of the products peddled on eBay have long since gone out of
circulation. It’s a hodgepodge that includes obscure products, interesting
inventions, memorabilia, and collectibles. Maybe you’re looking for vintage
comic books, an original Cabbage Patch Kid doll, replacements for broken
china dishes, or even a 1970s, 8-track cartridge player (heaven knows why?).
Sellers on eBay peddle new stuff too, from digital camcorders to acoustic gui-
tars. (Some folks make a decent living selling wares through the service.)

Indeed, eBay may be a godsend if you finally get around to cleaning the attic.
Keep it quiet, but you can also get rid of that homely “what-were-they-think-
ing” serving plate you received as a wedding gift.
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Managing travel

It used to be that people bought airline tickets and booked hotels over the
Internet strictly for convenience. After all, booking online beats languishing
on hold waiting to talk to an airline customer service rep. And you can
choose seats from the comfort of your own keyboard and even print boarding
passes. (Okay, when things get complicated with connections or flying with
pets, you might still want to go through an airline staffer or a travel agent.).
Nowadays, carriers want you to go through the Web and take advantage of e-
tickets. In fact, you're typically penalized for requesting a paper ticket.

Although you can find deals elsewhere, the big three online travel sites —
www . expedia.com, www.orbitz.com, and www. travelocity.com — are
worth a visit. Also check out the carrier’s own Web site and ask to get on an
e-mail list in which the airline notifies you of last-minute bargains.

Putting Sherlock on the Trail

Figure 11-7:
Sherlock is
on the case.
|

Sherlock, Apple’s Internet sleuth, is meant to help you get to the bottom of
specific kinds of Web searches on the quick, from tracking stocks and eBay
auctions, to finding out whether your flight is on time and when flicks you
want to see are playing. Searches are assigned to specific Sherlock channels,
known as Dictionary, Translation, and so on (see Figure 11-7).

Sherlock - Stocks

l?; e T @aer @i B 9

Channels  Internet Stocks Movies eBay Flights Dictionary Translation AppleCare

Company Name or Ticker Symbol

WX @ Quates delayed 15 minutes
-

Name Symbol | Last Trade Change Day Range Volume

Apple Computer, Inc. AAPL 63.549 -0.781 (-1.21%) 63.14 - 64.56 15,464,811

Time Warner Inc TWX 17.44 0.00 (0.00%) 17.32 - 17.48 18,957,400

[ DJIA: 11276.61 +0.00 (0.00%) + Nasdaq: 221037 +0.00 (0.00%) = S&P: 1280.16 +0.00 (0.00%)

Date Recent Headlines

28 MAY 03:09am Apple Loses Court Bid to Identify Sources
26 MAY 07:21pm Apple Loses Court Bid to Identify Sources
26 MAY 07:21pm Apple Loses Court Bid to Identify Source
25 MAY 06:28pm NBC Offers Variety of News in iTunes

25 MAY 05:24pm NBC Offers Variety of News in Tunes

25 MAY 04:21pm NBC Offers Variety of News in ITunes

25 MAY 03:00am Pearson to Acquire PowerSchool .|

24 MAY 07:10pm Apple's Glass Structure Embodies Growth y| | SRR

Read the story at http://finance.lycos.com/home/news/story.asp?story=58820462.

Content provided by (T138I)
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A researcher’s toolbox

Imagine if you could take the Britannica or
World Book Encyclopedia and alter or update it
at will. You now have some idea of what
Wikipedia, found at www.wikipedia.org,
is all about. It's billed as a free encyclopedia that
anyone can edit. At the very least, entries are
more timely. The collaborative global perspec-
tive may provide insights lacking in other refer-
ence material.

| know what you’re thinking. There's a flip side
to all this. What if I'm mischievous? What if I'm
biased? What if I'm a misinformed know-it-all?
Why couldn’t | change the text to read that the
South won the Civil War, or Dewey beat
Truman? Yes, it can and does happen, because
the very essence of a wiki allows for anyone

with an Internet connection to mess with any of
the references. In most instances, blatant van-
dalism and dubious submissions are corrected
by the collective efforts of honest writers and
editors from around the world.

But open-sourced wiki entries are organic and
never quite finished, and mistakes are intro-
duced, overtly or subtly, consciously or other-
wise. One side of an argument might be
presented more eloquently than another. There
is almost always room for interpretation and
debate. So, Wikipedia is a remarkably useful
online resource, provided you recognize its lim-
itations and don't treat everything you come
across as gospel.

189

Sherlock gets on the case when you single-click the dock icon with the detec-
tive hat and magnifying glass (if it’s there) or call upon its services from the
Applications folder. Following are a few of the channels worth noting:

v Translation: Type the phrase you want to translate in the original text box,
and then select the original language and the language you want to trans-
late the words into from the drop-down menu that appears. See Figure 11-8.

RO 6 Sherlock - Translation (=]
e < X A

& 6 g § B @

Channels . Intemet Stocks Movies eBay Flights Dictionary Translation AppleCare

Criginal Text

dummies book

(" Translate ) | English to Russian

KHUra AyMMUdH

Figure 11-8:
How do you
say Itin ,

The above is an automated translation provided by SYSTRAN. Apple is not responsible for its accuracy. As automated translations are performed by software

R USSia n 2 toals and do not involve any human intervention or verification, it is not advisable to rely upon this translation where absolute accuracy is required. Click
: here for SYSTRAN'S terms of service.

— | Content provided by S SYSTRAN
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v~ AppleCare: This is a fast way to read troubleshooting tips and other
articles in the AppleCare knowledge base.

+~ Internet: Lets you quickly search the Web, but it’s no Google.

v Stocks: Enter the company name or the ticker symbol of stocks you're
interested in, and Sherlock reports back the price of the last trade
(delayed 15 minutes), the change over the previous quote, and the day’s
range, volume, and relevant headlines. You can even display a mini stock
chart showing prices for the year, week, or intraday.

Whenever Apple adds channels, they automatically show up in Sherlock. But
has Scotland Yard (or Steve Jobs) put the famed detective on notice?
Sherlock already appears to be past his prime. Many of his duties are now
handled by newer and slicker Dashboard widgets (see Chapters 6 and 21).

Sayonara Sherlock?



Chapter 12

Joining .Mac, the Club That Will
Have You for a Member

In This Chapter

Deciding whether to join
Getting to know iDisk
Backing up digital keepsakes
Turning to .Mac Mail
Synchronizing multiple Macs
Publishing your Web site

One hundred bucks a year. That’s the price to join Apple’s .Mac (pro-
nounced “dot Mac”) service. The suite of Internet goodies you get for
that sum includes an e-mail account, tools to keep multiple Macs in sync, plus
online storage. Most .Mac services are cleverly woven into Tiger and iLife.

Okay, so my inner fact-checker compels me to point out that .Mac actually
costs $99.95 per annum. What'’s a nickel among friends? While we're at it, a
Family Pack .Mac subscription, (including a single master account and five
subaccounts) fetches $180, um, $179.95 per year.

If you really must know, .Mac used to be called iTools and used to be free.
Television was once free too, but no one argues when you get a lot more
viewing choices for the money. So it goes with .Mac. The folks at Apple have
piled on the features these last few years, even as they now make you fork
over extra coin.

Which raises the overall question: Is .Mac worth the price of admission? This
is where I'd love to pause, run a couple of commercials, keep you hanging for
a few minutes. They do it all the time on TV. Oh, well, wrong medium.

At the risk of copping out, the answer is, it depends.
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Why Belong?

In general, .Mac is a worthwhile investment for many but not all Mac owners.
The service gets a lot more interesting for you creative types looking to share
your inspirations — photos, blogs, Web pages, music — in cyberspace.

I suspect that most of you can take advantage of the extra online storage that
comes with .Mac membership.

Apple lets you use limited versions of certain .Mac features risk free for 60
days, so give it a shot. If it doesn’t work out, well, as they say in basketball,
no harm, no foul.

You’ll have the opportunity to sign up to a .Mac account (or trial) when you
first turn on your Mac. No worries if you're already well past that point: Go to
System Preferences and click the .Mac icon (found under Internet & Network).
Or visit www . apple.com/dotmac.

Here’s a bird’s-eye view of .Mac features, some of which I'll delve into in
greater detail in this chapter, some in other chapters:

v~ iLife Media Publishing: When you create Web sites or blogs through
iWeb or podcasts through GarageBand (see Chapter 17), .Mac gives you
a place to host, or publish, your work.

1 Photocasting: Family and friends can “subscribe” to so-called photo-
casts consisting of dynamic photo albums you create in iPhoto 6
(Chapter 15). As you update those albums in iPhoto, they’re dynamically
updated on subscribers’ computers.

v~ iDisk: A centralized online storage facility you can use to exchange files
with others.

v Backup 3: A method of scheduling automatic backups for your Mac.
v Mail: An ad-free e-mail account with built-in virus protections.

v Groups: Lets you communicate, coordinate, and collaborate with other
friends, family, and colleagues who congregate in groups. Groups might
consist of classmates who arrange study sessions and field trips online.
You might create a group for the Little League team you’re managing, to
post photos and alert everyone to scheduling changes.

v Sync: Keeps contacts, calendars, bookmarks and other info in sync on
multiple Macs. .Mac Sync lets you access your Address Book from any
computer connected to the Net, including a Windows machine.
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v Learning Center: Provides step-by-step tutorials and other training
resources for Tiger, iLife, and other applications.

v+ Member Central: A repository for free Mac software downloads and spe-
cial discounts.

With that, let’s examine some of .Mac’s most prominent features up close,
starting with the online storage lockers called iDisk.

iDisk Backups in the Sky

\\3

iDisk is arguably the most useful .Mac feature of all. Who wouldn’t want per-
sonal storage in the clouds, or in reality on Apple’s secure servers (that is,
big powerful computers)? For one thing, data copied to your iDisk is safe and
preserved if anyone ever drops a bowling ball on your computer (I don’t ask).
This won’t be the only reference in this book to the importance of backing up
your digital treasures.

What’s more, as long as you have an online connection, you can access the
files in your iDisk locker wherever you happen to be, even from a Windows
machine. Plus you can easily collaborate or exchange documents with others
or access files remotely yourself, especially those too large to e-mail.

Basic .Mac membership comes with 1GB (gigabyte) of storage space (as of
this writing), which you can allocate as you want between iDisk and your
.Mac e-mail account. You can boost the storage amount to 2GB or 4GB, for an
extra $49.95 or $99.95, respectively. Upgrade prices are prorated daily; your
.Mac expiration date is unchanged.

Subscribers to .Mac can access iDisk via the Finder by choosing Go=iDisk=>
My iDisk (or by pressing Shift+88+I).

The icon for iDisk also shows up in all Finder windows.
You can connect to another user’s iDisk or Public folder in the same manner.

Click that icon now. If you didn’t know better, you'd think iDisk was like any
other hard drive inside or connected to your computer.

An iDisk actually consists of ten folders (or eleven for a Family Pack account)
for storing your digital valuables. Storing files inside these folders is as
simple as dragging stuff to them, just as with any Mac folder. Most of the fold-
ers shown in Figure 12-1, including Documents, Movies, Music, and Pictures,
are self-explanatory.

193
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I'll highlight the others:

v Public: You can share the contents of this folder with anybody in cyber-
space who knows your .Mac name and (if you created one) password.

v~ Sites: Holds the Web pages you spawned through a .Mac feature called
HomePage.

v Groups: Here’s where to put files for the Little League team, book club,
or the clandestine committee planning to overthrow your company’s
management. .Mac Groups members can share calendars, photos, files,
and so on, and post to group message boards. They also get ad-free
e-mail. The iDisk Groups folder has subfolders accessible only to group
members.

v+~ Shared: This folder appears only if you have a Family Pack .Mac mem-
bership. Included are files that can be accessed by the master account
holder and subaccounts.

v Backup: Houses the files you’'ve backed up using a .Mac software feature
called Backup, which I cover later in the chapter.

v Software: Includes programs and files available only to .Mac members,
plus other software you can download from Apple. You can’t drag your
own files to this folder.

v Library: Another read-only folder. It includes files for .Mac Sync, which
lets you keep personal data (such as bookmarks, addresses, mailboxes,
and calendars) synchronized among all the Macs you own, provided
they’re connected to the Net.
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& If you ever decide not to renew a .Mac account, drag your data back onto

your Mac’s own hard drive before the account expires.

Other Backup Methods

Backing up your digital keepsakes (pictures, videos, financial documents, and
so on) is vital. I hope I've impressed that upon you by now. (If I haven’t, what
will it take? A drum roll? Sworn affidavit?) If you take nothing else from this
book, know that you must back up your important data and do so regularly.

Lecture over.

iDisk is a terrific vehicle for backing up bits and bytes, but it doesn’t afford
you enough storage if you have, say, a sizable multimedia collection. So
today’s backup arsenal typically consists of recordable CDs and DVDs, exter-
nal hard drives, and networks.

As a .Mac subscriber, you can approach this backup business strategically,
whether you plan to copy stuff onto iDisk or some other destination. That’s
thanks to the Backup programs included with a .Mac membership. If you
have OS X version 10.3.9 or later, download a program called Backup 3. If you
have an earlier version of OS X, download Backup 2.

It’s up to you, of course, not only to determine which files and data to back
up but when exactly to schedule the backups.

Backup 3 can help. To open the program, click the umbrella icon in your
Applications folder. The first time you open the program, you're greeted with
the window shown in Figure 12-2.

You're presented with several ready-to-use backup plans, or templates:
Personal Data & Settings (to back up your Address Book contacts, for
instance), a plan to back up the music and videos you’ve purchased from the
iTunes Music Store (see the next chapter), a plan to backup iLife data, and a
plan to back up your Home folder. But you can also back up individual files
and folders as you see fit.

® Apple recommends backing up onto iDisk daily any relatively small files that
change often. For larger files that don’t change as much, you might choose
weekly or monthly backups onto DVDs or external harder drives that can
accommodate sizable data storage requirements.
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Welcome to Backup
Backup provides an easy and powerful way te back up important information on your
computer such as the files you create and the settings you use for your applications.

To get started, you create Backup plans — lists of the items you want to back up, where to
back them up, and when. If you don't select any of the preset plans below, you can create
your own after clicking Continue. You can later modify any of the plans to suit your needs.

Choose Your Backup Plans

Transfer previous Backup settings
— @ Transfer the same files, destination and schedule information
- that you used in previous versions of Backup. You will not be
J able to transfer Backup settings later.

- Home Folder
" ﬁ\ Back up your home folder to your hard disk daily and to CD or
i B

DVD monthly.

Personal Data & Settings
Back up your Address Book contacts, Stickies notes, iCal
calendars, Safari settings, and Keychain settings to your iDisk

daily.
- iLife
— ‘- Back up the iLife data in your home folder to CD or DVD
I = _@a weekly.
Figure 12-2:
Purchased Music and Video
YOU always — Back up the files in your home folder that you purchased from
need a = the iTunes Music Store to CD or DVD monthly.
backup
plan. | @) (Restore ) ( Continue )
I
<MBER
< If you already created settings in previous versions of Backup, you are given

the option to transfer those settings to Backup 3.

Say you click Personal Data & Settings. The window that appears, shown in
Figure 12-3, is divided into two panes. The top shows the backup items
you've chosen and the size requirements for those backups. The bottom
pane lists the destination and schedule for those backups.

After double-clicking one of these plans in the upper window, choose the Add
(+) or Remove (-) buttons to add or delete plans.

If you click the + button, you can choose items to back up in one of three ways:

v QuickPicks: These are shortcuts to backup plans involving certain types
of files: all your mail messages, your iPhoto library, or Microsoft Excel
documents, for example, as shown in Figure 12-4.

v~ Files & Folders: Lets you specify what you want to back up.
v Spotlight: Runs a quick search to figure out the files to copy.

Click Done to return to the main Backup window.
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Personal Data & Settings

Personal Data & Settings
Next backup scheduled for May 7, 2006 at 4:00 PM

Back Up History | Restore

Backup Items

Item Size
3 ical 84 KB
¥ Keychain 68 KB
¥ safari settings 1.2 MB
¥ Stickies 8 KB
—— [+] Total Size: 1.4 MB
Figure 12-3: Destination and Schedule
What @ Daily to "iDisk" at 4:00 PM ;
i Next backup scheduled for May 7, 2006 at 4:00 PM

exactly are

you backing

up? And | [+[-] , .
When? ( Back Up Now

Choose Items to Back Up

- QuickPicks  Files & Folders = Spotlight -

Items
¥ Address Book
el Backs up your Mac 0S X Address Book database and preferences.

— % AppleWorks documents
Backs up files located in your home folder created with AppleWorks

— & Application preferences
=r Backs up application preferences stored in your Preferences folder.

¥ FileMaker documents
Backs up files located in your home folder created with FileMaker.

(0]

: GarageBand projects
v
E— & Backs up GarageBand projects located in your home folder.
— & ical
Figure 12_4. - Backs up your iCal calendar files and preferences.
. . & IDVD projects
QuickPicks @™ sacks up 1ovD prjecs ocate i yur home fotder
~ & IMovie projects
lets you & ™ tacks up iMovie projects and movies located in your Movies folder.
back up all — % Internet Explorer settings
. - Backs up your favorites, history, scrapbook, and page holder settings.
files of a
& iPhoto library y
Specific = Backs up IPhoto albums, slideshows, books, and pictures stored in your iPhoto Library folder. 3
type. -
( Cancel ) ( Done )
|

After you’'ve determined all your backup items, click Back Up Now to begin
backing up right away or close the window to begin the backup according to
the schedule you've set.
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If possible, keep backup discs in a different location than your Mac; that way
you may be able to keep your data safe from a fire or other calamity:.

The first time you copy a designated set of files, you're doing a full backup.
Subsequent files are incremental; only the files altered since your last backup
are copied.

Mac Mail

I'd like to tell you there’s something extra special about having a .Mac e-mail
account. But it’s like any other Web-based e-mail account. You can check
.Mac mail from any browser, and it integrates with the Mac’s Mail application.
The amount of storage you have is directly tied to the amount of storage you
use in iDisk. The basic .Mac membership lets you divvy up 1GB between iDisk
and .Mac Mail. .Mac storage isn’t as generous as other Web-based e-mail
accounts such as Google’s Gmail, which is free.

Mac Sync

A\

If you're lucky enough to own two or more Macs, perhaps one for home and
another for the office, you can take advantage of .Mac Sync to keep all your
computers at least figuratively on the same page. With .Mac Sync, you can
synchronize Safari bookmarks, calendars, Address Book contacts, keychains
(passwords), and mail preferences. You need OS X version 10.4 or later to
exploit all these features.

.Mac Sync is different than iSync, Tiger’s own synchronization application
that helps you manage contact and calendar info on connected devices such
as a wireless Bluetooth cell phone, a Palm handheld, or an iPod. Use iSync to
synchronize files if you have a version of OS X earlier than 10.4.

To use .Mac Sync:

1. Open System Preferences and click .Mac.
2. Click the Sync tab.

3. Select the Synchronize with .Mac option, and make a selection from
the pop-up menu.

Your choices are Automatically, Every Hour, Every Day, Every Week, or
Manually.

4. Select the items you want to synchronize, as shown in Figure 12-5.
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5. Enter the same synchronization settings on all the Macs you want syn-
chronized.

6. If you want, select the Show Status in Menu Bar option.

A little spinning circle will appear in the menu bar while the Macs are
synchronizing.
7. Click the Sync Now button.
8. Visit www.mac.com.
9. On the .Mac tab, click Address Book and then click Preferences.
10. Select the Turn on .Mac Address Book Synchronization option.

This keeps your desktop Address Book in sync with your .Mac Address
Book. If you have a lot of entries in your Address Book, your first syn-
chronization may take awhile.

Sharing Your Digital Masterpieces

The iWeb software introduced with iLife '06 lets you build striking Web pages
and create online journals, or blogs, by laying your own content on top of
placeholder text and images found on predesigned Apple templates. After
you're satisfied with your new creation, you can foist it on a waiting public by
publishing through your .Mac account.
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Click the iWeb icon in the dock or open the program in the Applications
folder. Then, in iWeb, choose Filec>Publish to .Mac to make your page visible
to others.

Incidentally, iWeb, which is part of the iLife suite, differs from HomePage,
which consists of sites included with .Mac membership stored on Apple’s
servers. You can’t edit HomePage sites in iWeb, though you can link between
HomePage and iWeb sites.

Consider adding a password to lock out strangers from viewing your site. Do
you really want to share your thoughts with everyone? In iWeb’s site orga-
nizer, select the site (or a specific page), click Inspector, and select the Make
My Published Site Private option. Then enter a user name and password that
visitors must enter to access your site.

Oh, and don’t use your .Mac password for this purpose.



Chapter 13
Mounting a Defense Strategy

In This Chapter
Coming to grips with Internet security
Spying on spyware
Going phishing

Firing up the firewall
Opening the FileVault
Keying in on passwords
Securely logging out

Fis figured to be a short chapter. After all, OS X has been immune from
the swarm of viruses that have plagued Windows computers through the
years. Folks traditionally have needed to call a security specialist for their
Macs about as often as you summon the Maytag repair man.

But times change. Heck, Whirlpool bought Maytag. So when it comes to com-
puters nowadays, you can’t take anything for granted — even if you own a Mac.

The Truth about Internet Security

There are suggestions that OS X isn’t as bulletproof as was once believed. In
May 2006, the McAfee Avert Labs security threat research firm issued a
report claiming that the Mac is just as vulnerable to targeted malware, or
malicious software attacks, as other operating systems. According to McAfee,
between 2003 and 2005, the “annual rate of vulnerability” on Apple’s platform
increased by 228 percent, compared to 73 percent on the Microsoft side of
the ledger. Although the volume of threats is low, no invisible cloak is protect-
ing Apple’s products.
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Moreover, the security firm expects malicious hackers to increasingly place
the Mac OS (as well as the iPod) in the crosshairs, given Apple’s recent tran-
sition to Intel chips and especially as Apple’s products gain popularity.

The implication is that the bad guys haven’t spent much time targeting Apple
because the Mac has had such a miniscule market share. Although that argu-
ment may have some merit, Tiger and Macs in general have been engineered
with your protection in mind. Your operating system is as secure as they
come. Of course, now that a Mac can double as a Windows computer (see
Chapter 19), all bets are off.

What then are we to make of the McAfee report? Should Mac owners never
turn their computers on? Methinks not. But Mac loyalists shouldn’t get com-
placent either. For starters, you should install the security updates that show
up on your Mac when you click System Preferences under Software Updates.
And you should only load software on your computer from companies and
Web sites you trust.

Most of all, security requires a little common sense.

Spies in our mist

Viruses are menacing programs created for the sole purpose of wreaking
havoc on a computer or network. They spread when you download suspect
software, visit shady Web sites, or pass around infected discs.

Computer viruses take many forms. Windows users are all too familiar with
spyware, the type of code that surreptitiously shows up on your computer to
track your behavior and secretly report it to third parties.

Spyware typically differs from traditional computer viruses, which may try to
shut down your computer (or at least one or two programs on the machine).
Authors of spyware aren’t necessarily out to shut you down. Rather, they qui-
etly attempt to monitor your behavior so that they can benefit at your
expense.

At the lesser extremes, your computer is served pop-up ads that companies
hope will eventually lead to a purchase. This type of spyware is known as
adware.

At its most severe, spyware can place your personal information in the hands
of a not-so-nice person. Under those circumstances, you could get totally
ripped off. Indeed, the most malicious of spyware programs, called keyloggers
or snoopware, can capture every keystroke you enter, whether you’re holding
court in a public chat room or typing a password.
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The good new is that as of this writing, no major reports of OS X-related spy-
ware have surfaced.

But there’s always a first time.

Gone phishing
Dear Citibank Member,

As part of our security measures, we regularly screen activity in the Citibank
system. We recently contacted you after noticing an issue on your account. We
requested information from you for the following reasons:

We have reason to believe that your account was accessed by a third party.
Because protecting the security of your account is our primary concern, we have
limited access to sensitive Citibank account features. We understand that this
may be an inconvenience but please understand that this temporary limitation
is for your protection.

This is a third and final reminder to log in to Citibank as soon as possible.

Once you log in, you will be provided with steps to restore your account access.
We appreciate your understanding as we work to ensure account safety.

Sincerely,
Citibank Account Review Department

The text from the preceding e-mailed letter sounds legitimate enough. But the
only thing real about it is that this is an actual excerpt lifted from a common
Internet fraud known as a phishing attack.

Identity thieves, masquerading as Citibank, eBay, PayPal or other financial or
Internet companies, try to dupe you into clicking phony links to verify per-
sonal or account information. You're asked to surrender home addresses,
passwords, social security numbers, credit cards numbers, banking account
information, and so on.

To lend authenticity to these appeals, the spoof e-mails often are dressed up
with real company logos and addresses, plus a forged company name in the
From line (for example, From: support@ebay.com).

Phishing may take the form of falsified company newsletters, as Figure 13-1
shows. Or there may be bogus requests for you to reconfirm personal data.
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Figure 13-1:
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Your account has been flagged!
PayPal Security Measures.

Dear PayPal Member,

Your account has been randomly flagged in our system as a
part of our routine security measures. This is a must to
ensure that only you have access and use of your Paypal
account and to ensure a safe PayPal experience. We require
all flagged accounts to verify their information on file with
us. Te verify your information at this time, please visit our
secure server webform by clicking the hyperlink below:

PayPal Security

Measures. Get Verified!
It's easy to track your B B
expenses and stay If you choose to ignore our request, you leave us no choice
organized when you use DUt to temporarily suspend your account.
PayPal. All your Thank you for your patience as we work together to protect
incoming and outgoing your account.
payments are tracked on * Your PayPal Account in Action
your Account History Use PayPal to purchase with cash.
page. See sample. When you link your bank account to your
2] PayPal account, you can fund your L
purchases with the money from your bank i
e e account. So get Verified—it's just like v

So how do you know when you’re being hoodwinked? Obvious giveaways
included in some fake e-mails are misspellings, rotten grammar, and repeated
words or sentences.

No company on the level is going to ask you to reconfirm data that has been
lost. And reputable companies usually refer to you by your real first and last
name and business affiliations rather than the more generic Dear Member or
Dear PayPal Customer.

If you have doubts that a communication is legit, you can always open a new
browser window and type the real company name yourself (for example,
www . ebay . com or www . paypal .com.) Your gut instincts concerning phony
mail are probably on the mark.

Bottom line: Never click links embedded in suspicious e-mails. When you hover
the cursor over a link such as www . paypal . com, it actually leads elsewhere.
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Firewalls

Figure 13-2:
Selecting
the
communica-
tions your
firewall will
letin.
|

More than likely, if you're connecting to the Internet through a network router
(see Chapter 18), you're protected by a shield known as a firewall. But Tiger
also has a software firewall, and you can use it to block unwanted Web traffic.

Here’s how to access it:

1. Choose %= System Preferences.
2. In the Internet & Network section, click Sharing.
3. Click the Firewall tab.

This is where you turn on settings to stop incoming Internet traffic to
services and ports, except those you specify, as shown in Figure 13-2.

Sharing
[« » ][ showai | Q

Computer Name: Edward Baig's Computer

Other computers on your local subnet can access

your computer at Edward-Baigs-Computer-3.local  ( Edit... ;:'
! Services = Firewall Internet |
Firewall Off
€ Ctart b Click Start to prevent incoming network communication to all services and
b / ports other than those enabled below.
Allow: On Description (" New... ]
__ Personal File Sharing ) i
Windows Sharing | \ Edit... )

Personal Web Sharing
Remote Login - SSH
FTP Access

Remote Apple Events
Printer Sharing A
Apple Remote Desktop v [ Advanced... )

( Delete )

il
(] 11‘ Click the lock to prevent further changes.
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By clicking the New button, you can specify a port on which you’d like to
receive inbound networking traffic. Out of the box, Apple keeps all communi-
cation ports closed by default.

If you click the Advanced button, you’ll be able to log information about
unauthorized attempts and destinations blocked by the Mac'’s firewall.

You can also operate the computer in Stealth mode (by selecting that option
in the Advanced section) so that any uninvited traffic receives no acknowl-
edgment or response from the Mac. Malicious hackers won’t even know
there’s a machine to attack.

Still another Advanced option is to block UDP (User Datagram Protocol) traf-
fic. UDP is another Internet communications method. While blocking UDP
may help secure your Mac, it may also restrict your Internet connections.

FileUault

If your computer houses truly hush-hush information — your company’s finan-
cial books, say, rather than Aunt Minnie’s secret noodle-pudding recipe — you
can scramble, or encrypt, the data in your Home folder (and only your Home
folder) using a Tiger feature known as FileVault. You know your secrets are
protected should thieves get their grubby paws on your machine.

FileVault automatically applies the level of encryption employed by Uncle
Sam. It’s what nerds refer to as AES-128 (for Advanced Encryption Standard
with 128-bit keys). And let me tell you, it’s really secure. Apple claims it would
take a machine approximately 149 trillion years to crack the code. Even if
they’re off by a couple of billion years, I'm thinking your system is pretty safe.

The FileVault window shown in Figure 13-3 turns up when you choose
Security under System Preferences. As an administrator, you can set up a
safety net master password for your system, which you’ll need to unlock
FileVault. This computer-wide password can be used to bail out authorized
users on your system who forget their password. And it might be a lifesaver if
you run a small business through your Mac and have to let a wayward
employee go. You'll be able to recover any data left behind in that person’s
account.
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B8 E Security
[« »|[ Showal | Q
FileVault
FileVault secures your home folder by encrypting its contents. It automatically
5 @ . encrypts and decrypts your files while you're using them.

WARNING: Your files will be encrypted using your login password. If you forget your
login password and you don't know the master password, your data will be lost.

A master password is not set for this computer.
This is a "safety net” password. It lets you unlock any
FileVault account on this computer.

(_ Set Master Password... .,'

FileVault protection is off for this account.

(" Turn On FileVault... )
Turning on FileVault may take a while. —_—

z Require password to wake this computer from sleep or screen saver

For all accounts on this computer:

[ Disable automatic login

[ ] | Require password to unlock each secure system preference
Figure 13-3: E Log out after 60 ; minutes of inactivity
Keeping | Use secure virtual memory
your | Disable remote control infrared receiver
CompUter This computer will work with any
secure in available remote.
System )
Preferences. I QJ Click the lock to prevent further changes. @
I
SWNG/
& S .
Heed Apple’s warning. If you forget your login password and master pass-

word, your scrambled data may as well be toast.
If FileVault is turned on and you’re not logged in to the machine, other people

you normally share folders with on the computer will not be able to access
those folders.

Password Management: The Key
to Keychains

Have you stopped to think how many passwords are in your computing life?
You probably have so many that you use the same ones over and over,
though security experts think that’s not such a keen practice.
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The pun police will get on me for saying this, but Apple has the key to manag-
ing your passwords, account numbers, and other confidential info: a feature
known as keychain. A keychain can store passwords for programs, e-mail
accounts, Web sites, and more.

You can create different keychains for different purposes (one for online shop-
ping, say) by opening keychain access in the Utilities folder under Applications.
Your keychain password is initially the same as your login password, and for
many users that’s the way it’ll stay.

Logging In and Logging Out

\3

If you work in an office or other environment where anyone can peek at the
monitor to see what you've been up to, log out of your account when you're
finished doing what you’re doing.

But if you'd rather not bother logging out or you don’t think you’ll remember,
go to the Security pane of System Preferences, and select the Require
Password to Wake This Computer from Sleep or Screen Saver option and the
Log Out after x Minutes of Inactivity option (refer to Figure 13-3).

You also may want to select the options to Disable Automatic Login and Use
Secure Virtual Memory. The latter setting ensures that data stored in virtual
memory is encrypted. You'll have to restart the computer for the change to
take effect.

If you're really distrustful, select the Require Password to Unlock Each Secure
System Preference option.

There. I told you this would be a short chapter.



Part IV
Getting an iLife

The 5th Wave By Rich Tennant

RICHTENNANT

“I could tell you more about myself, but T think
the plaglist on my iPod says more about me
than mere words can.”




In this part . . .

C ome meet and greet the Murderers’ Row of
multimedia software: iTunes, iPhoto, iMovie HD,
GarageBand, and iWeb. Music junkies, photography buffs,
auteurs, videographers, aspiring rock stars, podcasters,
and bloggers are all invited. So are you and your family.
Special bonus: a peek at Apple’s remarkably successful
iPod. iLife '06 is included on all new Macs and is a $79
upgrade if you have an older system.




Chapter 14
Living in an iTunes Nation

In This Chapter
Choosing an iPod
Touring the iTunes jukebox
Managing your music collection
Finding music online

Downloading books, podcasts, and videos

Fe demographers may have missed it. But we’re in the midst of a major
population explosion. Everywhere you look, vast colonies of tiny white
earbuds are proliferating. They’re spotted on subways and on the street. On
airplanes, buses, and college and corporate campuses.

Those signature white earbuds, of course, are connected to iPods. And
there’s every chance you’re reading a Macintosh book because of them.
Although iPods are meant to work with iTunes software in Windows
machines as well as on OS X, your first infatuation with the Mac may well
have occurred in an Apple store where you ostensibly went to check out the
darling of all portable music players.

You also may be thinking that if Apple hit such a home run with the iPod, per-
haps Steve Jobs and crew know something about making darn impressive
computers too. (Naturally, you'd be right.)

For its part, the iPod has morphed into such a phenomenon that the acces-
sories business for the devices — cases, speaker systems, car radio adapters,
armbands, even a distance and pace sensor that fits into Nike shoes — sup-
posedly amount to a billion-dollar-plus business. That’s billion with a B.
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So although this is first and foremost a computer book (and I promise we’ll
venture back to the Mac before long), please forgive a minor detour into iPod
territory.  won’t dwell on everything the iPod can do except to quickly men-
tion here that in addition to music and (with some models) video and pic-
tures, iPods can synchronize contacts and calendar information and store
text files.

[ hope you’ll keep reading this chapter even if you don’t have an iPod. You
can still take advantage of iTunes.

Choosing Your iPod

Sprinkled throughout this book is the disclaimer as of this writing because
Apple is known for surprises. In late summer 2005, Apple replaced what had
been the best-selling iPod model to date, iPod Minis, because it came up with
something even more extraordinary, the Lilliputian Nano.

So all bets are off: Notwithstanding a special edition model tied to the rock
band U2, as of this writing, there are essentially three iPod classes, each sold
with different storage capacities.

By the time you read this, Apple may have finally unveiled a long rumored
iPod cell phone combination. (I'm not counting the phones that incorporate
iTunes software but otherwise bear no resemblance to genuine iPods.)

The “white” iPod

The so-called white iPod ($299 on up) represents the fifth generation of the
original iPod. Roughly the size of a deck of cards, the classic iPod, shown in
Figure 14-1, is white on the front with a scratch-prone mirrored finish on the
back. The devices are famous for their touch-sensitive scroll wheel, which
you use to control the gizmo’s operations (menus, skipping tracks,
play/pause, and more).
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Figure 14-1:
The iPod.

the office

Courtesy of Apple

At the time this book was published, the highest capacity iPod could hold up
to 15,000 songs, 25,000 photos, and 150 hours of video, from ancient reruns of
Alfred Hitchcock Presents to highlights from the last Rose Bowl.

The Nano

I can tick off the Nano’s weight (1.5 ounces) and dimensions (just 3.5-by-1.6
by-0.27 inches). But you don’t truly appreciate how tantalizingly small that is
until you place a Nano (see Figure 14-2) next to a grown-up iPod. Of course,
giving in on size means giving up some song capacity. The largest capacity
Nano can hold around 1,000 songs.
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Courtesy of Apple

Still, if you’re looking for an iPod so small you're not even sure whether it’s
still in your pocket, Nano is the choice. Like it’s full-size cousin, Nano sports a
version of the scroll wheel. It can show off pictures too (but not videos).
Nano, which starts at $149, comes in two flavors, black or customary iPod
white.

The iPod Shuffle

Starting at just $69 and smaller than a pack of Trident, Shuffle (see Figure 14-3)
gets its name from the shuffle setting found on larger iPods, compact disc
players, and other musical devices. Songs on the device play in random order.
Moreover, because the Shuffle has no display, the only way to tell what’s play-
ing, assuming you don’t know just by listening, is to connect Shuffle to your
Mac (or Windows machine) through its built-in USB connector. That connec-
tor is revealed when you lift off Shuffle’s white cap. Incidentally, unlike the
hard-drive-based video iPod, Shuffle employs what’s called flash memory; so
the least expensive model is limited to around 120 songs.
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Figure 14-3:
Even
smaller, the
Shuffle.

Courtesy of Apple

iTunes: The Great Mac Jukebox

As stand-alone devices, iPods are wonderful examples of exemplary design
and superb engineering. But though the iPod name signifies star power, it
must share (and truth be told probably relinquish) top billing to the maestro
behind Apple’s musical ensemble, iTunes software.

If the iPod is Lennon, Apple’s multimedia jukebox program is McCartney. Or it
is Mick to Keith? Or Rodgers to Hammerstein? Well you get the drift; the little
player and Apple’s software make terrific music together.

Best of all, as part of the iLife suite, iTunes is one of those melodious programs
that musical enthusiasts (and everyone else) get just for owning a Mac.
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Here’s a quick rundown on what iTunes permits you to do, with further com-
mentary to come later in this chapter:

v Listen to CDs

v Rip, or encode, the songs on a CD into music files that are compressed
(see the “Compassionate compression” sidebar) and stored in your
digital library

v Add music to the library from the Internet

v Create, or burn, your own CDs or DVDs, with the proper CD or DVD
burner, such as Apple’s own Super Drive, which is included in some
Macs

v~ Listen to Internet radio by clicking the Radio icon in the source list to
display a list of streams by category, such as Alt/Modern Rock, Blues,
and Electronica

v Watch videos

v Organize your music by name, artist, time, album, genre, rating, and
play-count

v Segregate your music into customized playlists

v Stream or share the music in your library across a network — within
certain limitations

v Transfer music onto an iPod

To open iTunes, click the Dock icon, which looks like a musical note resting
on top of a CD.

Let’s explore some of the iTunes controls referenced in Figure 14-4:

v Back/Forward: The double-arrow pointing to the left and right respec-
tively are your back and forward buttons. Place the cursor above these
buttons and hold down the mouse to rewind or fast-forward through a
song. If you instead single-click on these arrows, you’ll advance or
retreat to the next or previous track.

v Play/Pause: Click the single arrow pointing to the right to play a song.
When a song is playing, the button changes to two vertical bars. Click
again to stop the music. Alternatively, press the spacebar to play or
pause.
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Figure 14-4:
Ode to
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software.
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Figure 14-5:
The
Equalizer
lets you
fine-tune
your
musical
mood.
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v Volume: Dragging this slider increases or decreases the volume.

v Shuffle: When the symbol in this little button is highlighted (it turns
blue), tracks play in random order. Be prepared for anything. There’s no
telling when Eminem will follow The Wiggles.

1 Repeat: Click once to repeat all the songs in the library or playlist you're
currently listening to. Click twice so that the number 1 appears on the
button. Only the current track will repeat.

v+ Equalizer: If you've ever tweaked the treble and bass controls on a
stereo, you'll appreciate the equalizer. It allows you to adjust sound fre-
quencies to match the genre of a song, the speakers on your system, or
the ambiance of the room in which you are listening. Clicking the equal-
izer button brings up the list shown in Figure 14-5. You can manually
adjust the equalizer by dragging the sliders or choose among more than
20 presets (such as Bass reducer, Flat, Hip-Hop, or Lounge).

v~ Visual Effects: If you were conscious during the '60s, you’ll welcome
these funky psychedelic light animations that dance to the beat of what-
ever’s playing, as shown in Figure 14-6. And if you're the offspring of a
Baby Boomer, you’ll arrive at this amazing realization: Maybe mom and
dad were pretty groovy in their heyday. You can also drum up your
visual serenade by pressing 3+T. For a full-screen effect when the visual-
izer is active, press 8+F; press Esc, or click the mouse button to return
to reality.

A
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Managing Your Music

So how exactly does music make its way into iTunes? And what exactly
comes of the songs after you have ’em? [ thought you’d never ask.

Ripping audio CDs

A remarkable thing happens moments after you insert the vast majority of
music CDs into your Mac. The contents of the disc — song titles, artist name,
length, album name, and genre — are automatically recognized and copied
into iTunes. The software actually fetches this licensed information from a
massive online database run by a company called Gracenote.

Now here’s another remarkable feat: Next time, you won’t have to keep
inserting said CD into the computer to hear its music. That’s because you can
rip, or copy, the contents onto the Mac’s hard drive, and then stash the disc
somewhere else.
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Figure 14-7:
Ripping

a CD.

To rip a CD, click the Import CD button in the upper-right corner of the
window. Because all songs with a check mark next to their name will be
copied, be sure to click to uncheck any songs you have no interest in before
proceeding.

As iTunes goes about its business, a tiny orange circle spins next to the song
being ripped; the circle turns green and gains a check mark after it’s been
copied. You can monitor the progress of your imports also by peeking at the
top display shown in Figure 14-7. It shows you how much time remains before
a particular track is captured and the speed at which the CD is being ripped.

Incidentally, you can listen to the CD (or do other work) while ripping a disc.
After iTunes has completed its mission, remove the CD by clicking Eject (the
rightmost icon at the bottom of the screen). Copied songs are stored in the
iTunes library.
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Importing other ditties

Songs previously downloaded from the Internet can be imported into iTunes
by dragging them into your iTunes library. The assumption here is that you
obtained those music files legally. If you did not, placing them inside iTunes
will blow up your computer. (That’s not really the case, but I urge you to play
by the rules just the same. People’s livelihoods depend on it.)

To import audio files from other applications or your desktop, choose
Files>Add to Library and then select the file. Or drag the music into the
Library, or the iTunes Dock icon.

Creating playlists

You listen to music under a variety of circumstances, such as entertaining at
a dinner party, soothing a crying baby, setting a romantic mood, or drowning
in your sorrows after a painful breakup. In the last situation, the last thing
you’d want to hear is Barbra Streisand belting out “Happy Days Are Here
Again,” even if the song is otherwise a staple in your iTunes library. With a
playlist, you can organize material around a particular theme or mood.

The simplest way to create a new playlist is to click the + button in the
bottom-left corner of the iTunes window. You can also choose Files>New
Playlist or press the keyboard tandem 38+N.

A new playlist with the inelegant name “Untitled playlist” appears in the
source list. Type over that with the name of the playlist you have in mind
(Jazz Crooners, Dance Mix, Corny Songs, or whatever). Then merely drag the
songs from the library into the folder representing the new playlist.

If you're adding multiple songs into the playlist, hold down the 88 or Shift key
to select a bunch of tracks. You can drag the whole batch over in one swoop.

To delete a song from a playlist, highlight it and press Delete. Don’t worry,
the original track remains in your library. Songs in playlists never really leave
the library; the playlist merely functions as a pointer to those files. For the
same reason, a particular song can show up in as many playlists as you want.
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When playlists get smart

Putting together a playlist can be fun. But it can also take considerable time
and effort. Using smart playlists, you can have iTunes do the heavy lifting on
your behalf, based on specific conditions you establish upfront: how fast a
song is (based on BPM, or beats per minute), the type of music, a song’s
rating, and so on. You can also limit the playlist to a specific length.

Choose FilewNew Smart Playlist. In the dialog box that appears, click Add (+)
to choose the parameters you're basing the smart playlist on from pop up
menus. Click the — button to remove a condition.

Take a look at the Smart Playlist Figure 14-8. It has iTunes looking for all
songs with Love in the title that you haven’t heard in a couple of months or
heard more than 14 times. The song must have been encoded with a bit rate
between 128 and 160 Kbps (see the “Compassionate compression” sidebar).
The overall length of the playlist cannot exceed 2 hours. If you want iTunes to
alter the smart playlist as songs are added or removed, select the Live
Updating option.

Smart Playlist
\f_’ Match all ¥ of the following rules
Name : | contains * Love =) (+
Last Played + is notin the last v 2 months ¢ -3 (+
Bit Rate ¢ isinthe range + 128 to 160 kbps (—) +
Play Count +  is less than ] 15 - (+
v Limitto 2 hours + | selected by random
Match only checked songs
}{" Live updating
Cancel oK

Loading tunes onto the iPod

Transferring your songs, playlists, and — as you’ll also see — videos, audio-
books, and podcasts to an iPod is as simple as connecting the device to your
Mac through USB or FireWire, depending on the iPod model. Each time you
connect, the iPod automatically mirrors any changes to your songs and
playlists in iTunes, unless you select Manually Manage Songs and Playlists
under the iPod section of iTunes Preferences, found in the iTunes menu.



Compassionate compression

iTunes can sing to a variety of audio file formats.
Most digital tracks imported into the iTunes
database are compressed, or shrunken, so the
music doesn‘'t hog an inordinate amount of
space on your hard drive. But there's generally
a tradeoff between file size and sound quality.
As you mightimagine, larger files offer the finest
sonic fidelity. At least in theory.

The best known of these compression schemes
is MP3, a method in which files are squeezed to
a reasonable size, even though the sound is per-
fectly acceptable to all but the most serious
audiophiles.

Apple prefers an alternate compression
method. On Macs with QuickTime 6.2 or later,
Apple uses a default encoding scheme known
as MPEG-4 AAC (Advanced Audio Coding), a
compression format that rivals the sound qual-
ity of an audio CD, and one that Apple claims is
equal if not superior to MP3s encoded at the
same or a higher bit rate. (If you have an earlier
version of QuickTime, MP3 is the default.)

The songs you purchase at the iTunes Music
Store are also in the AAC format. According to
Apple, the High Quality AAC setting produces
files that take up less than 1 megabyte for each
minute of music. But iTunes also recognizes
other file formats: Apple Lossless, AIFF, and
WAV. These last two flavors are uncompressed,
so the music is of exceptional quality, but the
files gobble up disk space. Apple Lossless is an
audiophile format that matches AIFF and WAV
in sound quality but takes up half the space. You
can burn CDs in the Lossless or AIFF formats.

If you're inclined to mess with these file formats,
visit iTunes Preferences, click the Advanced
tab, and make your choice in the Importing sec-
tion. You can set up the encoder to import using
AAC, AIFF, Apple Lossless, MP3, or WAV, and
also choose the stereo bit rate. In techie terms,
128 kbps is the default.

A connected iPod shows up in the iTunes source list. Click the little Eject icon

next to the name of your iPod in the source list before removing the device
from a USB or FireWire cable. (Connecting a photo-capable iPod also trans-
fers pictures from iPhoto, the star of the next chapter.)
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Burning audio CDs

Knowing how to create a playlist is a handy precursor to burning or creating
your own CD that can be played in virtually any standard compact disc player.

To burn a CD:

1. From the iTunes menu, click Preferences, and then click the
Advanced tab.

2. Click Burning.
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. For the Disc Format, select Audio CD.
4. Choose the gap between songs (from 0 to 5 seconds).

5. If you want all the songs on the CD to play at the same volume, click
Sound Check.

6. With those preliminaries out the way, choose the playlist with the
songs you want to burn and make sure all the tunes you want have
check marks next to their names.

Be mindful of the length of those tracks; regular CDs have room for
about 74 to 80 minutes of music, or approximately 20 songs.

7. When you’re ready, click the Burn Disc button in the upper-right
corner.

8. When instructed insert a blank disc.

Use a CD-R disc if you want to play the CD in almost any player.
Although this type of disc can’t be erased after you've recorded on it, it
works in many more players than rewriteable CD-RW type discs, the kind
that can be re-recorded.

9. Click Burn Disc again.

Your CD burner chugs away. The entire procedure may take several
minutes.

In this example, we burned an audio CD. Apple also gives you the option to
burn an MP3 CD. The advantage is that you can store a lot more music (more
than 12 hours, or 150 songs) on a typical CD-R disc. The rub: Fewer CD play-
ers can handle this type of disc.

Tuning into Internet radio

Listening to your own CDs and digital tracks is terrific. Presumably a lot of
thought went into amassing your collection.

But at times, nothing beats the serendipity of radio: Not knowing what’s
coming next, hearing a nugget you haven’t heard in decades, hearing a new
jewel for the first time.

You don’t have to leave your Mac to revel in this type of experience. In fact,
when you click Radio in the source list, you’ll have access to a heck of a lot
more radio stations than you’ll find on AM, FM, or even subscription-based
satellite radio. These are streaming Internet radio stations, and you can
choose from hundreds of them. Apple categorizes these by genre, as shown
in Figure 14-9. Click the triangle next to a category name to see all the station
options in that genre. Double-click to tune into a particular station. It starts
playing in a few seconds, mercifully minus the static of regular radio.
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) Pay attention to the bit rate. The higher the bit rate number, the better a sta-

tion will sound, though you’re at the mercy of your Internet connection. Dial-
up users may want to stick with stations streaming at less than 48 kbps.

You can include Internet radio stations in a playlist. Of course, you must still
be connected to the Internet to hear them. Recording Internet radio streams

requires a third-party application such as RadioLover from Bitcartel Software.
Download an evaluation version at www.bitcartel.com/download.html.

Finding Music Online

iTunes serves as a gateway to a delightful emporium for music lovers. It’s the
iTunes Music Store where hunting for songs is a pleasure for all but the most
tone-deaf users. Don’t believe me? How else to explain more than a billion
downloads since Apple opened up the place? To enter the store, click Music
Store in the iTunes source list.

Sadly, you won’t find every song on your wish list in the iTunes Music Store
because some performers or the music labels that control these artists’
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catalogues foolheartedly remain digital holdouts. They have yet to put their
records up for sale in cyberspace. No Beatles songs are listed, and Madonna
was a latecomer until she started appearing in Apple ads.

If you ask me, it smacks of greed. But then don’t get me started.

Now that I have that rant off my chest, let’s put a positive spin on buying
music online compared to doing so in the physical world. For one thing, good
as it is, your neighborhood record store isn’t going to carry the more than 2
million tracks found in the iTunes Music Store. Moreover, every tune in the
iTunes joint is always “in stock.”

Shopping online for music affords you other privileges. Most notably, you
have the opportunity to cherry-pick favorite tracks from an album, without
having to buy the entire compilation. Note, however, that some record labels
require that some tracks be purchased only as part of a full-blown album.

What’s more, you can sample all the tracks for 30 seconds, without any oblig-
ation to buy. Most of the songs that you do choose to buy cost 99¢ a pop.

Then there’s the matter of instant gratification. You can start listening to the
music you buy inside iTunes mere seconds after making a purchase, as you’ll
see later in the chapter.

Seeking online music recommendations

In a real-life music store, you might find an adolescent clerk willing to recom-
mend an album or artist. (Although why is it you have a sneaking suspicion
this kid doesn’t speak the same language you do, much less enjoy the same
repertoire?) If you get really lucky, you may come across a Julliard graduate
moonlighting between gigs. But more often than not you’re browsing the
shelves on your own, not that that’s a bad thing; I love spending time in
record stores.

But face it, we all need a little counsel now and then. You'll find plenty of it in
the iTunes Music Store from Apple as well as from people like you who
happen to adore music.

In some respects, the front page of the Music Store is like the window outside
Tower Records. You'll see colorful album covers, promotions for particular
artists, and more.
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The page is laid out with new or recent releases, staff favorites, a list of top
songs and top albums, a few exclusives, and other recommendations — pre-
sented in the main genre you select by clicking the drop-down menu under
Inside the Music Store (on the left side of the screen).

Figure 14-10 shows the front page of the store when you’ve selected
Children’s Music as your genre.

Now suppose you click the banner where Julie Andrews is choosing her
favorite Disney ditties. You're transported to a page like the one shown in
Figure 14-11. In the bottom half of the screen is the list of songs in her compi-
lation. Click any of these to hear 30-second samples. Now look above the
song list. You'll find customer reviews and ratings.

Feel free to contribute your own reviews. In iTunes, everybody can be critic.

iTunes

B 60's Music

[# 60's Music

2 Classical 7

% tove , < Selects Her Favorite
& My Top Rated | A Disney Songs

|8 Recently Played

%6 Top 25 Most Played Inside the Music Store | Recent Releases #0000 See All Today's Top Songs

% videos - — = 1. The Hampster Dan...
hildren's Music 3
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[ Edward Baig's iPod ... Browse Q 2 camoﬁn.:ong Song
(¥ Edward Baig's iPod Power Search SpongeBab Squarep...
= i ad Day - Eingls 3. Electric Boogie (Si...
[# Edward Baig's iPod Podcasts Hampion and The H... Marlo Thomas & Fria Beainoven's Wig Kidz Bop Kios. oyl
|41 Edward Baig's iPod Audiobooks 4 TheRainhow Connt.
|| Edward Baig's iPod Mz Sarah McLachlan
(¥ Front Row Playlist Billhosrd Ghart 5. Chicken Dance
IR ITrip Stations Radio Charts DJ's Choice
= = i 6.1 Like to Move It
ML fo Sioney Moe T,';"m My First Party Album
B vETheco Mi>Ie iens 7. The HampsterDanc...
[ On-The-Go 2 Short Films Hampton the Hamp.
7§ On-The-Go 3 L TV shows €ED | Nursery Rhymes & Fairy Tales ®000 seeAll | 3 MahnaMahna
= ————— - e Cak
L Prince - The Basics et - L
o= X %E o~ 9. SpongeBob Square...
T TET— p— o -y L ©  Spongesob Squarep.
Gift Certificat i I AT A 10. Return to Pooh Cor...
e Mot So Grimm Fairy... Baby Genius: Favor... Diddle Diddie Doodl... 5o Early in the Mor... Kenny Loggins
iTunes Music Cards Dave Rudoll Baby Genius  Brian Melvile & Caro.. The Clancy Brahers s
Redeem T oR 100 Sing e O]
Support EFA M= v
# | Betthaven's Wig 3 Today's Top Albums

)
o |
| 1. Spongebob Square...
SpongeBob Squarep. ..

Family Films | @

Chicken Little (Soundtrack...

2. The Backyardigans
The Adventures of Shark ... The Backyardigans "
Ice Princess 3.Free to Be.. Youan..
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Figure 14-11:
Choosing
songs with
help from
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[# Purchased

B 60's Music
[# 50's Music
[# Classical

1 love

& My Top Rated

ren's Music > Julie Andrew

Selects Her Favorite Disnes

Julie Andrews Selects Her
Favorite Disney Songs
(Compilation)

Gift This Music @ (T
Tell afriend  ©

Release Date: May 10, 2005

Julie Andrews & Various Artists

Top wiloads
1. Axel F (from Beverly Hills Cop)
2. America, F**k Yeah
3. Always True to You (In My F...
4. Too Darn Hot
5. Once Upon a Time
6. Everyone Has AIDS
7. James Bond Theme
8. Brush Up Your Shakespeare
9. Another Op'nin', Another Show

Tsteners also bought 2

Contribute to this feature by
purchasing music by this artist.

Top Rated iMixes
1. HiPs DoNt LiE 11l
2. Disney Classics!
3. Disney
4. Briana’s Songs from Movies a...
5. Family Films

10. Main Theme from Dick Tracy

) Recenty layed | Con: Crvirats e e | G
% Top 25 Most Played 2005 Walt Disney Records 8. Paiges #1 Disney Sangs iMix
% Videos _ 9. The Best Of Disney
J Edward Baig's Playlist $9.99 (_BUY ALBUM ) 10. Disney Songs!!
|| Edward Baig's iPod seeAll ©
& Edward Baig's iPod .. .
[ Edward Baig's iFod Customer Reviews & See All 11 Reviews @
[ Edward Baig's iPod .. Average Rating: ¥ ik Write a Review @
| Edward Baig's iPod -
3 Front Row Playlist Beautiful selection of songs i Great mix of great Disney tunes *xkx*x r]
b by Anonymous by dgcasey -
|# Music for Sydney 4| Nam Time | Artist Albur Pr
4 On-The-Go 1 1 Beauty and the Beast (Beautyand . 2:46 Angela Lansbury @ Julie Andrews Selec . 50.93
4| On-The-Go 2 2 Chim Chim Cher-ee (Mary Poppins) 2:47 Dick Van Dyke, J. Julie Andrews Selec. . $0.99
|4 On-The-Go 3 “J 3 Part of Your Warld (The Little Mer. 3:14 Jodi Benson © Julie Andrews Selec...  $0.99 ((BU¥SONG )
£ Prince - The Basics 4 Some Day My Prince Will Come (S 1:54 Adriana Caselotti Julie Andrews Selec.. 5099 (_BUYSONG
= 5 CanYou Feel the Love Tonight (T... 2558 Ernie Sabella, Jo.. € Julie Andrews Selec..  $0.99 ((Ei¥soNG_
E AEHRERGH 6  TheBare ies (The Jungle ... 4:30 Bruce Reitherma. Julie Andrews Selec. . $0.99 (BUXSONG._
7 He's a Tramp (Lady and the Tramp) 2:02 Peqggy Lee © Julie Andrews Selec...  $0.99 (_BUXSONG _
8  AWwhole New World (Aladdin) 2:41 BradKane & Lea.. © Julie Andrews Selec..  $0.99 ((BUYSONG
9 ADream Is a Wish Your Heart Ma. 4:36 llene Woods & M... € Julie Andrews Selec...  $0.99 (B G
10 Bella Notte (Lady and the Tramp) 2:40 Disney Studio C... € Julie Andrews Selec.  §0.99
11 Baby Mine (Dumbo) 2:07 Betty Noyes © Julie Andrews Selec...  $0.99 (BUXSONG.
12 You'll Be In My Heart (Tarzan) 1:38 Glenn Close & P. © Julie Andrews Selec. $0.99 (_BUXSONG
13 The Second Star to the Right (Pet. 2:20 Jud Conlon's Chair € Julie Andrews Selec...  50.99 ((BUXSONG )
14 Feed the Birds (Tuppence a Bag) 3551 Julie Andrews Julie Andrews Selec.. 50,99 (BUYSONG.
15 When You Wish Upon a Star (Pino...  3:14 _ Cliff Edwards © Julie Andrews Selec. . $0.99 ((BU¥SoNG_
15 s e

iMixes

In the last section, I mentioned that you can write your own reviews. In fact,
you can go a lot further than being a critic. You can compile a list of songs for
people with similar tastes. Throughout the Music Store, you’ll come across
top-rated iMixes, playlists created by ordinary music fans like you.

To contribute your own iMix for all the world to see in the iTunes Music
Store, follow these steps:

J—

playlist.

. In the source list, click the little arrow to the right of a selected

If no arrow appears, select the Show Links to Music Store option, which
is on the General tab in iTunes Preferences.

W N

. Click Create iMix.

. Enter a title and a description.

You might use a title such as “Ed’s Sappy Love Songs” and a description
such as “Great sentimental music to share with a bottle of a wine and a
special friend.” Apple won’t let you use profanity.

4.

Click Tell a Friend to spread the word.



Chapter 14: Living in an iTunes Nation

Although your playlist can include tracks you've ripped from a CD, only tunes
sold in the iTunes Music Store will appear in your iMix. Apple makes the iMix
available for one year from its publish date.

You can rate other people’s iMixes on a scale of 1 to 5 stars. Accordingly, they
get to rate your compilation. If enough of them grade you favorably, your iMix
may also be featured on the album pages of featured artists. By my way of
thinking, that gives you as much credibility as any American Idol judge.

The search for great music continues

Check out the following list for other ways to stumble upon terrific music.
Make sure you have time on your hands. The quest can be deeply addictive:

v~ Search: A great starting point in your exploration is to search for artists
or song titles by entering the name in the Search Music Store box near
the upper-right corner of the screen. You can put more weight behind
your search by clicking Power Search from the Inside the Music Store
list. It lets you search by several parameters simultaneously (song,
artist, album, genre, and composer).

v Browse: If you're not starting out with a particular artist in mind, click
Browse from the Inside the Music Store list. You see a window such as
the one shown in Figure 14-12. Choose a genre in the column to the left,
a subgenre in the column to its right, an artist in the next column, and so
on, until you've narrowed the list down to tunes you want to own.

v Top Artist Downloads: If you happen upon an album page but aren’t
familiar with the performer’s music, consult the Top Artists Downloads
list and click to hear your 30-second sample.

v~ Listeners also bought: If you're impressed by what you hear from a
given artist, you may also be attracted to other music purchased by fans
of the artist’s work.

1 Charts: Consult Billboard’s Top Charts for a list of the Billboard Hot 100,
Top Country, or Top R&B by year. The Billboard Top 100 dates back to
1946, when in reality it was the Top 41. Perry Como anyone?

You can also click Radio Charts to get lists of songs playing on radios
station in cities ranging from Appleton-Oshkosh to Augusta, as you can
see in Figure 14-13.

229
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|
Figure 14-12:
Browsing

for music is
nirvana.
|

|
Figure 14-13:
What's
playing in
Oshkosh?

iTunes
@
< B[ > Browse ), Account: [ baigbwaaol.com |
- I I [ —
¥ Podasts i BT e Y
e Charts All Kicking Giant. Al
Radio Charts College Rock King Buzzo Bleach
& pany shuffie Goth Rock L7 From the Muddy Banks of the Wis...
Radio Music Videos ) " Love Bartery In Utero
TV shows Indie Rock. Magnapop Lithium - single

2] purchased New Wave Melvins MTV Unplugged in New York: Nir..
B 60's Music | Punk Mother Love Bone i
[# 60's Music Mudhoney []
Classical Audiobooks a Sliver - The Best of the Bax
love Blues PAW With the Lights Out (Box Set)
[ My Top Rated Children's Music pearl Jam
Recently Played Classical Pond |
Top 25 Most Played Camedy = Pray for the Soul of Betty =
Videos Cauntry b4 The Presidents of the United Star 7
[ Edward Baig's Playlist | Name: | Time | Artist Album A | Genre Price
@ Edward Baig's iPod ... You Know You're Right [5] 3:37 Nirvana & Nirvana € Alternative 50.99
| Edward Baig's iPod About a Girl © 246 Nirvana © Nirvana © Alternative  $0.99 ((BUXSONG)
¥ Edward Baig's iPod Been a Son (EP Version) © 220 Nirvana © Nirvana © Alternative  $0.99 ((BUXSONG )
Eﬂ Edward Baig's iPod ... b Stlver.f ng!e VEK _n) (-] O‘ Nlrva{\i ,° Altfrr\a!ivi 50.99 (_BUYSONE )
[J Edward Baig's iPod .. ol o -] ve | $0.99 (CBUTsONG )
3 Front Row Playlst Come As You Are © 339 Nirvana ) © Alternative  $0.99 (CBUXSONG)
3 Trip Stations || uthium © 415 Nivana © Nirvana & Alternative 50.99
m Music for Sydney i In Bloom [+] 4:13  Nirvana & Nirvana € Alternative 50.99
= v Heart-Shaped Box (-] 4:39 Nirvana @ Nirvana & Alternative $0.99

Pennyroyal Tea (Single M)~ € 3:35 Nirvana © Nirvana © Alternative  $0.99 ((BUXSONG)

Rape Me © 249 Nirvana & Nirvana & Aternative $0.99 ((BUXSONG )

Dumb [+] 2:29 Nirvana € Nirvana € Alternative $0.99

All Apologies (Live) © 345 Nivana © Nirvana ©  Alternative

The Man Who Sald the Werld (. © 3:47 Nirvana © Nirvana ©  Alternative $0.99 ((BUXSONG)

Account: [ baigbwaaol.com |
. 1 I
) Fodcr '~ 95.9 WKSZ-FM (KISS FM) |
[ videos e
E Pareyshuffe Asheville, NC 1003 WNCY-FM (Y100)
Radio Music Videas Aspen, CO 101.1 WIXX-FM
TV Shows | Adanta, Ga
12 Purchased | Atlantic City-Cape May, NJ
B 60's Music Alternative Augusta, GA
% 60's Music Austin, TX
Classical Bakersfield, CA
love Blues Baltimore, MD
% My Top Rated Children's Music Baton Rouge, LA
Recently Played Classical | Beaumont-rort Arthur, TX |
Top 25 Mast Played Camedy I Beckley, WV B
g videos Country Riloi- Gl . M5 154
|4 Edward Baig's Playlist 4 Name | Time | Artist Album Genre
@ Edward Baig's iPod ... 1  Stand Up [~) 3:59 Trapt € Stand Up - Single & Rock 5
[¥ Edward Baig's iPod 2 Doesn't Remind Me € 415 Audioslave € Out of Exile ©  Alternative
& Edward Baig's iPod ... 3 Brother © 352 DarkNewDay @ Brother - EP © Rock
5] Edward Baig's iPod . jo] 4 Colors © 318 Crossfade © Crossfade © | Rock
[ Edward Baig's iPod ... 5 Save Me © 331 shinedown © save Me -sSingle © Rock
@ Front Row Playlist 6  Wake Me Up When Sep.. © 445 Green Day © American Idiot © Alternative
R i7ip stations L 7  Calling (Single Version) (-] 3:51 Taproot © Calling - Single € Rock 50.99
i Misehor ey 12 &  GetStoned © 339 Hinder ©  Cet Stoned - Sin... © Rock $0.99 -
= v| 9 Bvos © 417 SystemofaDewn € BY.0.B. (Bonus .. & Rock
10 Hello Lonely © 422 TheoryofaDea.. © Gasoline © Rock
11 Live for Today (-] 3:47 3 Doors Down © Seventeen Days ... © Rock
12 We Are All On Drugs -] 3:34 Weezer € Make Believe © Alternative
13 Question! © 320 SystemofaDown © Mezmerize © Rock
14 DOA © 412 FooFighters @ In Your Honor (B... ©  Alternative
15 BatCountry W] € 5:11 Avenged Sevenf... € City of Evil © Rock
16 Forget to Remember [+] 3:35 Mudvayne © Lostand Found & Rock
17 Cold [+] 3:14 Crossfade € Crossfade © Rock
18 American Idiot © 2553 Green Day ©  American Idiot ... € Alternative
Copyright 2004 Radio & Records. Powered by Mediabase
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+ Hobnob with the stars: Well not exactly hobnob. But an eclectic cast of
the rich and famous — Liv Tyler, Ramsey Lewis, Blondie, Jay-Z, Kiefer
Sutherland, Sharon Stone, Eurythmics, William Shatner, Bill Maher, Billy
Bob Thornton, Carole King, B.B. King, Nicole Kidman, Russell Crowe,
Heidi Klum, Sarah McLachlan, Jennifer Garner, Taye Diggs, Jackie Chan,
Smokey Robinson, RuPaul, Andrew Lloyd Webber, Kanye West, Sting, Al
Franken, Lance Armstrong, the Reverend Al Green, and many more —
have put together lists of their favorite works. The artists usually pro-
vide brief descriptions of why they chose certain songs, as shown in
Figure 14-14. Regrettably, purchasing songs from these celebrity playlists
is not an automatic ticket to stardom.

v~ Just For You: Apple is testing a service called Just For You, which has
personalized recommendations based on your past musical purchasing
habits. It’ll serve up suggestions such as “You own Groovin’. We recom-
mend: Herman’s Hermit’s Retrospective.” Or “You bought Guero. We rec-
ommend Stand Up, Dave Matthews Band.” Under each suggestion you
can click “Already Own It” or “Don’t Like It.” The idea is that as Apple
learns more about what tickles your fancy, it will provide sharper recom-
mendations over time. The company can also steer you to certain songs
through its iTunes MiniStore, as the “MiniStore, minicontroversy” side-
bar explains.

[alala) ines
N | Perfect Day .
C)l\f > \Q o m—) i) | O Lou Reed @ diamond
ww . 0:00 € ] -0:30 Search Music $to ;
U [« 5] [ & > Celebrity Playlists 3 LivTyler's P ] Account: [ baighw@ao
- Radio =
= al
o
[# Purchased Liv Tyler's Picks
B 60's Music f
|8 60's Music Go behind the scenes of Liv Tyler's cover shoot for JANE.
|89 Classical
8 love “Gloria" (Track 1): *I just love it, | don't know why. I've always loved the song and loved singing it at
I the top of my lungs and Horses is really such a great record.”
|8 My Top Rated P 'y ung Y 9
8 Recently Played "1969 (Remastered)" (Track 2): “Iggy Pop is the ultimate rock star to me. | think he's absolutely a
|% Top 25 Most Played genius. I've been a big fan of his forever. My mom used to tell me that when | was in diapers, she
s videos would play his records and | would dance around to them all the time. There was a song called 'Fun
S ard Bl Plapise Time' and my mom did a cover of it as well, so | used to hear both versions and love them. | just love
[ Edward Baig’s iPod .. Liv Tyler's Playlist Iggy.
i’ Release Date: Apr 25, 2006 = A " E o - 5
[ rward Baig's fPod S ‘Crazy On You" (Track 3): “It has this amazing guitar bit in the beginning, an acoustic guitar bit
: Total: 22 songs s 2 3
|&] Edward Baig's iPod .. S that Nancy plays, which is amazing. | think she's such a great guitar player, and Ann Wilson is the
& Edward Baig's iPod ... $21.78: (RuCALLSONES) best singer in the world. I've always loved Heart." "
Edward Baig's iPod ..
g i "Crimson and Clover' (Track 41"l alsn wantad o pick Inan latt's 'Crimson and Clovar ' The Inan b
[ Front Row Playlist
[ rip stations Name Time | Artist bum | Price
 Music for Sydney 1 TryMe ) 2:34 James Brown & .. 20th Century M... €&  50.99 ((Buxson ) A
B o 2 INever Loved a Man {The Way ... 2:51 Aretha Franklin 30 Greatest Hits 50.99 ((BUYSONG )
Boo 3 Cryin' [ExpuT] € 5:10 Aerosmith © AlLittle South of . € $0.99 (JBUXSONG )
H QN Theto 4 You Really Got Me (Live) 3:40 The Kinks Come Dancing 50.99 (CBUTSONG
Ll Df"T""G“ 2 Y| 5 crimson and Clover 5:32 Tommy James & .. € Crimson & Clover & Bl =
1] Prince - The Basics 121 ¢ Mamba Sun 341 T.Rex Electric Warrior (...
o " . 7 Out On the Weekend € 4:35 Neil Young Harvest D 50.99 ((EUYSONG. |
EEE— &  Crazy On You 4:51 Heart Heart: Greatest $0.99 (EUXSONG |
9 Holy Roller Novocaine o 4:02 Kings of Leon Holy Roller Novo... € $0.99 (JBUYSONG |
F- 14 14_ 10 Gloria 5:54  Patti Smith Horses 50.99 ((BUY.SONG ‘
lglll'e = . 114 Perfect Day (-] 3:43 Lou Reed © LouReed - NYC .. € $0.99 (_BUYSONG ) L
L- . h 12 Pl Never Stand in Yaur Way (A.. 2:01 Elvis Presley Platinum - A Lif. 50.99 (_EUYSONG
Isten wit 13 Inthe Meantime 4:58 Spacehag D Resident Alien ) 50.99 ([BUYSONG.
L- th 14 Starside 3:49 Spacehog Resident Alien $0.99 (_BUY SONG
IV Or other 15 In the Flesh ¢ 2:32 Blondie Singles Box D 50.99 (_BUYSONG
| b 16  Good Vibrations 3:39 The Beach Boys The Beach Boys ... 50.99 (_BUY SONG 2
celebs. 12 wisiclon : 03 Cary Hosy 2D The Best f Cane £3 S0 69 (CASONGL i
S+ l=c e S 22 songs i L& | L=
|
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MiniStore, m

Apple initially took some grief when it rolled out
the iTunes MiniStore as part of an iTunes soft-
ware release in January 2006. The feature is
meant to help you discover new music when
you click items in your own library. As you do so,
the MiniStore shows songs that relate to the
material you're listening to, as shown in the

inicontroversy

figure. Citing possible privacy breaches, how-
ever, some critics went after Apple for failing to
disclose what it was doing. In short order, Apple
alleviated the concerns by turning the MiniStore
off by default. Now you must opt-in by clicking
the Show/Hide MiniStore button (labeled in
Figure 14-4).

[alala) Tunes
-~ { Somewhere Else |
ﬁj[ Yor ) i © Kathleen Edwards o |
w e 0:24 [IIT& ] -3:23 | et
4 | e
| Holiday All (1036 Artists) ) All (800 Albums) |
¥ Podcasts Inspirational Podcasts 4/ 15t Magic |
@ videos azz 1. Adagio - Allegro 3 Days Till Next Year
- (
& Party shuffle Latin 1. Molto Allegro 8 Mile
= Radio Movies 2. Andante 12 Songs
1B Music Store Movies & Television 4 2. Andante con moto 1 1459 %
[ Purchased New Age v 3. Menuetto. Allegretto v 16 Most Requested Songs: Mel Tormé %
B 60's Music Name Time | Artist a | Album Genre My Rating Play Count | Last Played
Echyard Hatg's NI  0ld Time Sake 4559 Kathleen Edwards © BacktoMe O Folk 4 4/22/06
% 60's Music # Summerlong 4:06 Kathleen Edwards Back to Me Folk 3 4/23/06 €
[# Classical @ What Are You Waiting For? 4:43 Kathleen Edwards 3 Back to Me D Folk 2 4/22/06 ]
8 Frank sinatra & Away 3:33 Kathleen Edwards Back to Me Folk 2 5/2/062
|8 1ove i ¥ Somewhere Else @ 347 Kathleen Edwards © | Back to Me O Folk
% My Top Rated # Copied Keys 5.07 Kathleen Edwards Back to Me Folk 3 4/24/06 1
% Recently Played # Good Things 5:51 Kathleen Edwards Back to M ) Folk 2 4/23/06 7
|# Top 25 Most Played ® Where've You Been 355 Kathy Mattea The Best Of Mou... &  Falk 1 11/23/05]
% Videos # Face Down 4:03 Katie Todd Band D Make Some Tim... © Pop 2 12131405
§ Edward Baig's Playlist # Lazy Afternoon 3:35 Kaye Ballard, vocal American Music Soundirack
j Edward Baig's iPod _._ & America the Beautiful 3:37 Keb' Mo’ 2 Freedom - A His... Soundtrack 1 11/24/05
§ Edward Baig's iPod & France 2551 Keb' Mo’ Keep it simple Blues 3 12405 ¢
e # Let Your Light Shine 407 Keb' Mo 3 Keep it simple Blues 2 721057
= i | @ One Friend 3.04 Keb' Mo’ Keep it simple Blues 2 1/19/06 13
£ Edward Baig's iPod ... (4|  ° ’ i a
= i & Shave Yo' Legs 414 Keb' Mo Keep it simple ) Blues 2 1/15/06 Iy
4§ Edward Baig's iPod ...
0 : - yair
Inside the Music Store €  More from Kathleen Edwards € Listeners Also Bought o
Back to Me F Failer 1. Back to Me My Better Self
Kathlesn Edwards Kathleen Edwards 2. In State ?B’W""";‘:
Released 2005 Rsleased 2003 3. Six O'Clock News E“S':l;f,:'f;m .
Kh Kk KR KKK 4. Summerlong Live at the Fillmore
Reviews (5] 5. What Are You Waiting For? Lucinda Williams.
Gift This Music @ 6. Old Time Sake raf;:n"grﬁ:l"m
Tell afriend  © f suentitinie ik Mercy Now (Banus Track)
8. Hockey Skates Mary Gauthier
4567 items, 13.6 days, 19.45 GB

L]

When you're ready to buy

So now that you have all these recommendations, you're ready to spend

some money. First, though, you

have to set up an account with Apple (assum-

ing you haven’t already done so) or use an existing AOL account. Here’s how:

1.
2.
3.
4.

In the Source List, click Music Store.
In the sign-in window, click Create New Account.
Fill in the requested credit card and other info.

The rest is easy. Find a song you want to buy and click Buy Song.
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To make sure you really mean it, Apple serves up the warning shown in
Figure 14-15.

5. Click Buy to complete the transaction.

In a matter of seconds (usually) the song is downloaded to the aptly
named Purchased playlist.

|
Figure 14-15: ;\':2\“/21‘;;:;rfogil‘ln\l-:'?n; to buy and download the Song
We're happy =
to take your
money
bUt e Cance E
|
P Once a week, you can download a free single handpicked by Apple (or some-
times even more than one). The freebies are typically from artists you've
never heard of, though the music is usually quite good. The downloading
experience is identical to buying any track except you're clicking Get Song
instead of Buy Song.
Apple’s generosity has a hidden cost. The company is taking the Lay’s Potato
Chip “bet you can’t eat just one” approach. The expectation is that you’ll
stick around the Music Store for awhile and part with your hard-earned
money at some point. Heck, less than a buck a track doesn’t sound like much
for those songs you just gotta have. But take it from first-hand experience,
those 99¢ tunes add up quickly. To find out just how much you’re spending,
click the Account window, enter your password, and choose View Account.
You can click Purchase History to check out your latest transactions.
P If you click Manage Artist Alerts on the Account Information page, Apple will

send you e-mail letting you know when artists whose music you’'ve bought in
the past have added new music to the Music Store. To do so, select the Send
Me Artist Alerts for All Artists in My Purchase History option. Just another
way to get you to part with your money.

Allowances and gifts

If you've bought one too many lame sweaters or neckties over the years as an
11th-hour birthday gift, iTunes may be your salvation. Click Gift Certificates
to buy something truly valuable. iTunes Gift Certificates can be issued in
amounts from $10 to $200. You can e-mail the certificate, print it, or have it go
out through the U.S. Mail. The whole shebang takes a minute or so.
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Digital rights police

When you buy a regular compact disc, you can
pretty much do with it whatever you like. Pop
the disc into as many CD players as you have
access to. Copy the songs (via iTunes) onto your
Mac. Fling the thing like a Frisbee for all anyone
cares.

So what exactly do you own when you purchase
a song electronically from iTunes? The rights to
listen to that song on just five “authorized” com-
puters. If you try to share music on a sixth
machine, you're told you need to deauthorize one

of the previous five. To do so, make sure the com-
puter is connected to the Net. Then under the
Advanced menu in iTunes, click Deauthorize
Computer. The five-machine limit applies to
Macs as well as Windows machines. You can
also deauthorize all five machines at once by
choosing Deauthorize All on the Account
Information page. Quick takeaway: If you're get-
ting rid of an old machine, remember to deau-
thorize it.

A\

In the list on the left side of the Music Store under Account, click Gift
Certificates for the particulars. To redeem a certificate you've received, start

out at the same place.

If you click Allowance instead, you can set up a regular monthly allowance (in

the same $10 to $200 amounts) that gets automatically topped off on the first
of the each month. If all goes well, Junior will learn a thing or two about fiscal
responsibility. Unused balances are saved until your kid makes another pur-
chase. Of course, should your son or daughter abuse any privileges, you can
pull the plug on his or her iTunes allowance at any time by heading over to

the Account Information page.

You can drag songs into a playlist and give them as gifts, even if you don’t
own the songs. You hear the 30-second previews; your recipients get the full
treatment. Click the arrow next to the playlist and click Give Playlist.

You can also give an entire album inside the iTunes Music store by selecting
Gift This Music on the Album page.

Sharing music with other computers

If your Mac is part of a local computer network (see Chapter 18), you can
share the music in your library with other machines running iTunes version
4.5 or later. Go to iTunes Preferences, click Sharing, and select the Share My
Music option. You can share the entire library or selected playlists. For
added security, you can require users of other computers to enter a pass-
word. iTunes must remain open for other computers to access your music.
Limits apply, as indicated in the “Digital rights police” sidebar.
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iTunes: More Than Just Music
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I’'m wondering how long the iTunes Music Store will be known as, well, the
iTunes Music Store? iTunes Media Store seems a more accurate descriptor
because, as you know by now, you can purchase a lot more than just music,
and share it on an iPod.

Listening to audiobooks

From Ernest Hemingway to James Patterson, you can fetch the iTunes equiva-
lent of books on tape. You can sample 90-second previews, three times as long
as music selections. Of course, audio books can go on for hours, compared to
three or four minutes for your average song. Prices vary too. A 22-minute audio
of Stephen Colbert’s remarks at the White House Correspondents’ Dinner costs
$1.95; an 8%-hour audio version of “Papa” Hemingway’s A Farewell to Arms goes
for $25.95. Choose Audiobooks from the Inside the Music Store list and start
prowling the virtual bookshelves for interesting titles.

Capturing podcasts

Podcasts are another form of Internet radio but very different from the radio I
described earlier in this chapter. For one thing, some podcasts go beyond
radio and show video. Moreover, instead of listening to live streams via the
Net, podcasts are downloadable files you can listen to whenever you get
around to it.

As you'll see after choosing the Podcasts genre inside iTunes, podcasts cover
a broad range of topics (business, politics, sports, TV and film, technology,
and so on) and are served up by experienced broadcasters, mainstream
media outlets (National Public Broadcasting, Newsweek, USA TODAY, Wall
Street Journal), as well as ordinary Joe’s and Josephine’s.

Podcasts are free to download and (typically) commercial free. You can fetch
individual episodes by clicking Get Episode or subscribe to podcasts that
arrive on a regular basis. As with audiobooks, you can click to hear a 90-
second sample.

You can find the podcasts you've downloaded by clicking Podcasts in the
Source list.

Choose the Podcasts tab under iTunes Preferences to manage your podcasts.
Among other choices, you can instruct iTunes on how often to check for new
episodes (such as daily or weekly) and how long to keep episodes you've
downloaded (all unplayed, most recent, last two, last five, and more). You can
also dictate which podcasts should be transferred over to an iPod.
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You can submit your own podcast directly to Apple by clicking the Submit a
Podcast link on the main iTunes page. You'll have to provide the podcast’s
RSS feed. Apple reserves the right to review podcasts before posting them.
You can create a podcast through GarageBand software, as I elaborate on in
Chapter 17.

Catching up on Lost and
Desperate Housewives

Quick story. I had never seen the hit series Lost before downloading the pilot
episode onto iTunes (and then an iPod). | was instantly hooked. | immedi-
ately understood the power of iTunes/iPod video.

Lost and Desperate Housewives were among the first handful of TV shows that
Apple made available on iTunes. The number of programs quickly mush-
roomed to incorporate everything from The Daily Show with Jon Stewart to
NASCAR highlights. Music videos and short films are also available.

Videos inside iTunes cost $1.99 apiece; as with audio tracks you can sample
30-second previews.

You can drag movie or video files you create yourself or obtain from other
sources into iTunes.

Before you can transfer some videos to an iPod, you may have to convert
them to a format iPod recognizes. Select the video, and choose
Advanced=>Convert Selection for iPod.

As video becomes even more prevalent, you'll see a lot of those earbud
people gazing intently at their iPod displays.
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Taking an iPhoto Close-Up

In This Chapter
Getting pictures into your Mac
Locating and organizing your pictures
Touching up photos
Sharing your pictures
Photocasting albums
Introducing iPhoto to iWeb
Preserving your digital pictures

Disruptiue technology is a concept that has been floating around for nearly
a decade. Loosely defined, it describes how a once dominant technol-
ogy gets elbowed aside and eventually displaced by something new. The idea
was coined by Harvard B-School professor Clayton M. Christensen, and those
Ivy educators are pretty darn smart.

Disruptive technology is just what seems to be happening in the world of
photography, where digital cameras have dramatically overtaken the film
side of the picture-taking biz. Ever cheaper and more capable cameras are
becoming so pervasive that they’re even built into numerous mass-market
cell phones.

For consumers, digital cameras afford lots of advantages over their film coun-
terparts. Most notably, you can preview shots before you ever snap an image.
(Try that one with your old man’s Instamatic.) What’s more, if you aren’t
pleased with the results after taking the picture — for goodness sakes, one kid
is looking sideways and the other has her eyes shut — you can erase it on the
spot with no harm done and without having to pay to get the shot developed.
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With iPhoto, Apple brings its own special smarts to digital photography. The
program is part digital shoebox, part processing lab, part touch-up artist, and
more. Through this wondrous member of the iLife suite, you can import,
organize, view, edit, and ultimately share your masterpieces with an adoring
public (or, at the very least, family and friends).

Getting Pictures into the Computer

Taking pictures with most digital cameras is a snap. Taking good digital pictures
is another matter entirely and beyond the — pun alert — focus of this book.

When you press your digital camera’s shutter button, images are typically
captured onto small (and removable) memory cards. Even as the price of
memory declines, the capacity on these cards rises. You can now capture
many hundreds of pictures on relatively inexpensive cards.

In the past, it was a challenge to get digital images onto your computer,
where the real fun begins. iPhoto drastically simplifies the process. Take a
gaze at Figure 15-1 to familiarize yourself with some of the program’s main
elements. There’s a lot here, which we’ll delve into throughout this chapter.

Connecting a digital camera

In most cases, you run a direct connection from the digital camera to the Mac
by connecting the USB cable supplied with the camera. Turn the camera off
and then plug one end of the cable into the camera and the other end into the
Mac. Turn the camera back on.

iPhoto opens, assuming you clicked Yes when the program asked you
whether you want to use iPhoto to download photos when a camera is con-
nected. (This questions pops up the first time you launch the program.) The
way iPhoto takes charge, you won’t even have to install the software that
came with your camera. Given how cumbersome some of these programs can
be, that, my friends, is a blessing.
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Figure 15-2:
Getting
ready to
import your
pictures.
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If everything went down as it should and iPhoto was called into action, skip
ahead to the next section. If you ran into a problem, you can try the following:

v Check to make sure your camera is turned on and you have a fresh set of
batteries.

1 Because every camera is different, consult the instructions that came
with your model to make sure it’s in the proper setting for importing pic-
tures (usually Play mode). Don’t you just hate when that happens? You
want an answer now, and here | am directing you to some manual that
was likely translated into English from another language. Translated
poorly, [ might add.

v As alast resort, make sure your camera is compatible with OS X by visit-
ing www.apple.com/macosx/upgrade/cameras.html.

Importing images from the camera

When you connect a camera and iPhoto comes to life, the main screen will
indicate that it’s ready to import images, as you can see in Figure 15-2.
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To transfer images, follow these steps:

1. Type a Roll Name and Description for your photos in the appropriate
fields.

2. Determine whether you want to erase the pictures from the camera
after they have been copied onto iPhoto.

To do so, select the Delete Items from Camera After Importing option. If
you’re not sure, you can always delete images directly from the camera
later.

3. Click Import.

Your pictures are on their way to their new home inside iPhoto’s digital
shoebox; the process may take several minutes depending on how many
pictures you're moving over. The time depends on a variety of factors,
including the number and quality of the images being imported. You’ll
see the images whiz by as they’re being copied.

4. When the program has finished importing, click the eject button or
drag the camera’s name from the source list to iPhoto trash, at the
bottom of the source list.

5. Turn off and disconnect the camera.

Seeing double? If iPhoto detects a duplicate photo it will ask whether you're
sure you want to copy it over again. Click Import to proceed or Don’t Import
to skip this particular image. To avoid getting this question for each duplicate
image, select the Apply to All Duplicates option.

iPhoto will also copy over movie clips from your digital camera, provided
they’re compatible with QuickTime. These videos are automatically trans-
ferred in the same way as still images.

Importing images from other sources

Not all the pictures in your iPhoto library arrive by direct transfer from your
digital camera. Some reach the Mac by the Web, e-mail, CDs or DVDs, flash
drives, or memory card readers. Other pictures may already reside some
place else on your hard drive.

To get these pictures into iPhoto, simply drag them into the iPhoto viewing
area or onto the iPhoto dock icon. You can drag individual pictures or an
entire folder or disk.
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If you prefer, choose File=>Import to Library and browse for the files you want
to bring over. Then click Import.

iPhoto is compatible with JPEG and TIFF, the most common image file for-
mats, as well as a photo enthusiast format (available on some digital cam-
eras) known as RAW.

If you haven’t bought a digital camera yet and are shooting 35mm film, you
can still play in iPhoto’s sandbox. Have your neighborhood film processor
transfer images onto a CD or post them on the Web. Given where the film pro-
cessing industry is heading, it’ll be thrilled to have your business.

Finding and Organizing Images

CMBER
S

Right from the outset, iPhoto helps you organize pics so you can more easily
find the ones you want to view later. All the imported pictures are stuffed in
the iPhoto library, which you can easily access by clicking Library in the
source list on the upper-left side of the screen.

Your entire image collection shows up in a grid of thumbnails, or mini pic-
tures, in the main viewing area on the right. If you're having trouble making
out those thumbnails, drag the slider at the bottom-right corner and watch
how those thumbnails grow. Cool, huh? Now drag the slider to the left to
make the pictures shrink. You can peek at many more pictures in the viewing
area that way.

Double-click a photo to make it larger. Click Done to return to the thumbnail
view.

Movie thumbnails appear with a little camera icon and the duration of the
clip. Clicking a movie thumbnail opens the QuickTime Player.

Oh, and don’t worry about your photo library growing too large, no matter
how prolific a photographer you may be. Version 6 of iPhoto can accommo-
date up to 250,000 pictures. To convince you that that’s a very big number,
Apple’s marketers point out that you can take 1,000 snapshots a month for 20
years and still not bump up against the limit.

Of course, if all Apple did was drop all those pictures into one large digital
dumping ground, you’d have a heck of a time finding that oh-so-precious shot
of your proud kid getting her elementary school diploma. So how do you
uncover the very images you want to admire over and over? Let us count

the ways.
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For starters, iPhoto organizes pictures into virtual film rolls. Remember when
you imported pictures and were asked to fill in a Roll Name? You’d be wise to
fill in something descriptive (such as Paris Vacation) because months from
now collections called “Roll 07” or “Roll 359” won'’t be very revealing.

Apple automatically creates some rolls on your behalf. For instance, to help
you locate the batch of pictures you just imported, iPhoto conveniently
places them into a folder named Last Roll. If you click Last Roll in the source
list, those are the only photographs you'll see.

If you're looking for the pictures you took during, say, the past year instead,
click the Last 12 Months roll.

Go to Preferences under the iPhoto menu and click the General tab if you
want to change what’s shown in the source list from Last 12 Months to an
album containing photos in the Last 1 to 19 months.

In the same section, you change the source list display from Last Roll to Last
2, 3, 4, all the way up to 25 rolls.

Navigating with the iPhoto calendar

Now suppose you want to display just the pictures you took around the time
your little angel was born. Click the calendar icon at the bottom-left corner of
the screen and scroll to the month and date in which you want to display pic-
tures, as shown in Figure 15-3.
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iPhoto captures more than just photos when picture files are transferred
over. Through captured metadata, the program knows the make and model of
the camera used to take the image; the date and time the picture was taken
and imported; the size in pixels, or picture elements; the aperture setting of
the camera; whether a flash was used; and more. Such data is factored into
Spotlight searches.
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|
Figure 15-4:
The key to
keywords.
|
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Navigating with the Scroll Guide

You can scan for pictures in your library taken during a specific period by
dragging the scroll bar on the right edge of the iPhoto screen. As you do so, a
floating translucent panel called Scroll Guide appears in the middle of the
window showing you the date and (depending on preferences) title of each
film roll.

Assigning keywords

Keywords may be the key to finding pictures in the future. These are labels, or
tags, applied to a set of photos. Apple provides some keywords right off the
bat: Favorite, Family, Kids, Vacation, and Birthday. You create your own key-
words by selecting the Keywords tab under iPhoto Preferences (see Figure
15-4) and clicking the + (Add) button.

allal Keywords
AT Sanl = fam 4 Sk
A B e @ 4
General Appearance Sharing Photocasts Keywords Advanced
Match = All +] keywords when filtering.
Keyword
]
Favorite
Family
Kids
Vacation
Birthday
+ Rename
Reordering the keywords will change the positians of the
keyward buttons in the main window.

Above the list of keywords is a check mark. Its purpose is to flag all the
photos you may want to pull together for a specific project. The check mark
shows up in the bottom-right corner of a thumbnail on selected images.

To actually assign keywords (or the check mark) to specific photos:

1. Select the specific picture.
2. Choose Photos=>Get Info.
3. Make sure the Keywords Tab option under Get Info is highlighted.
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4. Place a check mark next to the keyword (or keywords) you want to
use for the image.

As an alternative to Steps 2 to 4, open the keywords pane on the bottom-
left corner of the screen by clicking the button that looks like, well, a
key. Drag the photo onto the appropriate keyword.

Now that the underlying keywords are in place, how the heck do you put
them into action? Open the keywords pane and click one or more of the key-
word buttons. The clicked buttons turn blue, and the iPhoto viewer displays
only those pictures that match the highlighted keywords.

Now suppose that you want to display pictures that match one keyword or
another (Family or Vacation, for example). This time, click the keywords in
question while also holding down the Shift key. The keys turn purple. Again,
the viewer will show only the appropriate collection of pictures.

If you want to hide pictures with certain keywords — [ won’t ask, so don’t tell —
press Option on the keyboard while clicking the keyword or keywords you want
to hide. The keyword buttons turn red, and pictures represented by those key-
words are not shown.

Assigning ratings

You can also assign ratings to pictures on a scale between zero and five stars.
There are several ways to do this with selected images:

v Choose Photos=>My Rating and click the number of stars you have in
mind.

v Open the Information pane by clicking the little circled i button near the
bottom-left corner of the screen, and then click the representative dot
next to Rating.

v While holding down the 3 key, press the 1, 2, 3, 4, or 5 key (representing
the n